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Use the handle on the cartridge to avoid touching this area. Maintenance44 Page 45 Replace the toner cartridge when a toner cartridge reached the end of life, the machine stops printing. Maintenance45 Page 46 Clearing The quality of the Machineif printing problems occur or if you use the machine in a dusty environment, you need to regularly
clean the machine to keep it in the best print condition and use the machine for a long time. "Cleaning the machine cabinet The cleaning materials containing large quantities of alcohol, solvents or other strong substances can disclose or distort the cabin. A ¢ avelop if the toner cartridge is removed from the printer, follow the following instructions To
correctly keep the toner cartridge. a € retains the cartridge inside the protection bag from the original package. A A ¢ Store lying (not standing at the eighty) side facing upwards as if it were installed in the machine. A ¢ avelop not to archive the consumer materials in any of the following conditions: - of the greater than 40 & ° C (104 a ° F). Humidité
interval of less than 20 % and greater than 80 % .- An environment With extreme changes in humidity or temperature. direct the sunlight or the light of the room. Susti places.-A car for a long period of time. An environment in which there are corrosive gases. An environment with salted air. 3. Maintenance41 Page 42, estimating the approx Rtuccia
del Toner13 Management instructions - Do not touch the surface of the photo -dut with the cartridge. A avelop not expose the cartridge to unnecessary vibrations or shocks. & € 4 € Never revolves the drum manually, especially in the direction of Reverse; There that has no internal damage and toner leaks. Malivata cartridge cartridge cartridge. This
was useful I want to print something full page, but whatever I do, you always remain a white edge. Try to reprint the work. A ABB CA ABB CA ABB CA ABB CHE A establish the humidity of the paper is irregular or the paper has humid points on its surface. It is possible to identify the Mac address of the machine by printing a network configuration
ratio (see "Print" anetwork configuration relationship "on page 90). A avelop to check the wireless environment. Load paper in the tray ("Loading the paper in the tray" Onpage 26). A ¢ The car stopped due to a serious mistake. A paper jam has occurred. Orange4. If the computer computer on DHCP, you need to contact the network administrator to
obtain the ecstatic IP address. For example: if the information on the computer network is shown as follows: -ip address: 169.254.133.42 -Subnet Mask: 255.255.0.0. , Information on the machine network should be as shown as shown: -ip address: 169.254.133.43-Subnet Mask: 255.255.0.0 (use the sottorete of the computer sottorete) -Gateway:
169.254.13.133.1Wi-Fi direct option: & ¢ 4,— & ¢ The direct Wi-Fi option is displayed on the screen only if your printer supports this function. A 4,— & ¢ Start building Wi-Fi directly using Samsung Easy Printer Manager (see "Wi-Fi Direct setting" on page 131) .2. /Install the D "to uninstall the entire package. To check the removal results, perform the".
Remove the wirednetwork cable from the machine. For information on the access point (or wireless router), consult your own guide of your access point (or wireless router) or machine may not be bet on a DHCP network environment with the wireless reception around the machine. Try the different card. Against the paper stack.CURL or
WAVEHEAUE Alusive ensure that the card is charged correctly. A ¢ avelop the type of paper and quality. The greater the DPI, the greater the resolution. GLOSSARY205 PAGE 206GLOSSARYSMBTCP/IPSERVER BLOCK (SMB) is a network protocol applied mainly to share files, printers, serial doors and various communications between nodes on
anetwork. This is the window of the Addpritter Guided procedure. They are exceptional commands that can be raised exclusively. The searched machines will be displayed on the screen. Introduction16 Page 17machine panoramicllrear viewa ¢ avelop this illustration can differ from the machine depending on its model. Avelop some functionalities
and optional goods may not be available depending on the model or country (see "Functionires for models" on page 6) .121usb Port2PowerwerwoWer Bottolcolol. IntroductionKey Benefit4dfeatuures of Models6usful to Know8about of this user security guide. SeftylOmachine panoramicl5Control Panoramic panell8 turn on the machine for machines
for the Locally21reinstalling the driver222 driver. For example, 00: 15: 99: 29: 51: A8 Become0015992951A8.Corn the machine on the net with a network cable. On the car on the car. , so click ok. This device must be used more than 20 cm (8 inches) from the body when wireless devices are active and transmitting. If the system has been equipped
with an incorporated internal wirelessdevice, do not manage the wireless device unless all covers and stables are completely assembled. The tools without tools are not useful. This devicecnot must be placed with another transmitter and transmit the antenna. This transmitter must not be placed or functioning in combination with any other antenna or
transmitter. The operation of this device is subject to the following two (1) This value may not cause harmful interference and (2) This device must accept accepting Received, including interference that can cause an unwanted operator of the device.13 Russia only wireless devices are not useful. In case of difficulty, consult the help on the screen
available through the menu of your system or from the Windows applications of the Driver package, such as Unifieddriver Configurator or Image Manager. 2 When the administrator's access window is displayed, type a ¢ dvelop "root" in the Thelogin field and enter the system password. Install the smartlmake panel for sure that the machine is
connected to the computer and is powered on .2 When the administrator access window appears, type in the root in the Theologin field and enter the system password. You have to access as super user (root) to install the machine software. It consists of a heat roller and a pressure roller. It produces industrial and commercial standards all over the
world. The International Telecomunication Union is an international organization founded to standardize and regulate the radio and international telecommunications. Toner is a dust used in laser and photocopiers printers, which forms the text And the images on the printed paper. If you are not a super user, ask your system administrator. You have
to access as super user (root) to install the SO machine ftware. Clean the interior of the car (see "Cleaning the machine" on page 46). Solid color or black pages - the toner cartridge may not be installed correctly. Verified SD stands for Secure Digital. The status of the Samsung printer is automatically installed when installing the machine software. It
is also possible to manually start the status of the Samsung printer. Contact a service representative (see "machine cleaning" on page 46). If the faded areas, generally rounded, occur randomly on the page: a ¢ avelop A single sheet of paper can be defective. Why? Turn on the print as an image from the Acrobat printing options. Print print quality It is
not good. The images are not clear. The resolution of the photo is very low. It takes more time to print when they print a pdf file as an image. Reduce the size of the photo. Click Next. Select the network printer and click the search button. The IP address of the printer and the model name are displayed in the list field .9 Set the machine and click Next.
Unixinput the printer description and subsequent. After adding the car, click Finish. Outs, make sure that the machine supports the 4 € 4 € 4 € <UNIX operating system before installing the UNIX printer driver (see" functions for models "on page 6) When the installation is performed, click on the end. Avelop the commands are marked with "" When
you type the commands, Nottype "". 2. The filigrane modification window appears. Select the watermark you want to delete from the list of currents and click Elimina. Exhaust ok or print until you leave the print window. 3. Special features145 Page 146 Use the advanced printing features Eddescripzione The option is available only when using the
PCL/SPL printer driver (see "software" on page 6). Overlayaan Overlay is text and/or images stored in the computer hard disk units (HDD) as a special file format that can be printed on any document. Overlay are often used to take the place of the full card. If you are not a super user, ask your system administrator. 3 Click the icon at the bottom of the
desktop. It could be that the size of the selected card does not correspond to the royal card. The information will be worth Vario on the selected machine. If these steps do not correct the problem, contact a service representative. The upper met of the It is more light compared to the rest of the card, the toner could not adhere correctly to this type of
paper. "Change the printer option and try again. In the Pagged Sheet drop down list, select the number of pages you want to print a sheet of paper. Click. Click. The machine prints the selected number of pages to be printed on a sheet of paper. 3. Special features151 Page 152macintosh Printing11 if they print more than 2 copies, the first copy and
the second copy could impress on the same sheet of paper. Use of a network network driver connected to the network network. Connect the machine to the computer using the USB cable. A ¢ The machine does not support wireless networking. Flaps and extra stripes cause wrinkles, folds or jams and can even damage the spindle. & € for the best
print quality, the locations of position are not more close than 15 mm from the seafood marinas. - Avoid printing on the area where the envelope seams are encountered. If you select the envelope from the print preferences window, but the printed images are easily deleted, select a thick envelope and try the print again. However, it could cause some
noise during printing. A ¢ avelop, consider the following factors: -Pese: it should not exceed 90 g/m2 otherwise; Marmellate can occur. Construction: should lie down less than 6 mm of curls and not dedicate air. A acceptable one -sided: it should not be wrinkled, nickeled or damaged. Temperature: it should resist the heat and pressure of the machine.
dvelop only use well -built envelopes with acute and well -believed folds. 2. Learning the use of base30 page 31media and traylabelsto avoids damaging the machine, using only labels designed for use in Laserprinter. No adhesive material exposed between the labels. The exposed areas can detach labels during printing, which can cause jams. This
accumulation can cause print quality problems, such as Toner Specksor spearing. The printing on the seams can cause problems, or select often From the print preferences window (see "opening of printing preferences" on page 35). If the background run covers the entire surface area of a printed page, regulates the printing resolution through the
application of the software in printing preferences (see "opening printing preferences" on page 35). Click Next.wep (Privacy equivalent wired) is a security protocol that prevents authorized access to your wireless network. Now you can easily print your shielded or modified screens. 4. Useful management tools160 Page 161using Syncthrua ¢ & € 74 ¢
Web12 a,— a ¢ Internet Explorer 6.0 or higher is the minimum requirement of ForsyNCTHRUrua ¢ a€ ZaAAAAAAA&AE€. Log in the upper right of the Web Service website. Type in the ID and Password, then click on Login. A ¢ avelop: amins avelop password: SEC00000 avelop only network model. Internet Explorer, from Windows.enter the IP
address of the printer machine () in the address field and press the ENTER button or click Click or Click or Click Click Send or click Click Send or Click Enter Go.2 Cards may not appear depending on your model. Your incorporated website of the machine opens. The emulation focuses on the exacerproduction of external behavior, which is in contrast
with the simulation, which disputes an abstract model of the system during the simulation phase, often considering its internal state. However, there is Noguarantee that interference does not occur in a particular installation. Samsung Easy Printer Manager provides two different user interfaces for the user to choose from: the basic user interface
and the advance The Easy Printer Manager interface is made up of various bases as described in the following table: the screenshot can differ according to the operating system you are using. User interface. So, if the paper or the original has complicated images or a lot of text on it, the coverage will be the highest and at the same time, a use of the
toner will be as much as the coverage. Work. It produces industrial and commercial standards all over the world. Glossary202 Page 203GLossaryldepmh The Lightweight Directory Professor Protocol (LDAP) is a networking protocol for the reduction and modification of the directory services on TCP/IP. It must be transmitted between the fax machines
to transfer the recommended image from ITU-T T.4. MH is a scheme of run-lungafection length based on optimized code-books to efficiently compress the white space. Sometimes the Theterm refers only to the most visible service, the interior internet (IP) interior address is an internal internal number that the devices use to identify and communicate
together on a network using the internetprotocol.glossary201 standard standard Page 202Glossarioitu-The The pictures per minute (IPM) are a way to measure the speed of a printer. Szukasz Instrukcji? Problems resolution 56 Page 57 Convenienting the LED4toner LED/ WPS Ledstatus (LED toner) (LED WPS B (LED of LED) state Potenza)



Description Blinghingsmals The quantity of toner is left in the cartridge. If static shows, click on change TCP/IP to change the method of analysis in DHCP. connection of the network cable that is confirmed, disconnect the network cable and click Next.16 The setting of the wireless network is completed. Example of forest: if it is selected more thick
paper, but the paper normal actually used, can occur an overload by causing this of quality of copy.a ¢ &, & ¢ & € ¢ Toner cartridge, redistribute the toner first (see "Redistribute the toner" on page 43). The tonalitous particles are around bold or photo toner may not adhere correctly to this type of paper. A ¢ changes the printer option and try again.
8.52 or above. It was included in the original Macintosh (1984) and is now deprecated by the favor of Applein of TCP/IP Networking.emulationfdiemulation is a technique of a machine that obtains the same results as another. Interface of the Foreigner device (FDI) is a card installed inside the machine to allow a device for Athird parties such as a coin
device or a card reader. The "allocated" state could be activated when some problems occur in the press. A 4,— A A A A 4 ce the application has special printing options such as "ORAW". Problem resolution52 Page 53 Clearing Paper Jams2Inide The Machine & A A It is an API of the acquisition of the image for the operating systems of Microsoft
Windows and Applemacintosh. A filigree is an image or a recognizable paper model that appears slightly when it is displayed by the transmitted light. WEP provides the security encryption data on the radio so that they are protected as they are transmitted from one point to another. Wiawindows (Wia) imaging architecture is an imaginative
architecture originally introduced in Windows Me and Windows XP. When the presets are saved, all the current settings of the Areco driver print the ecological function cuts the consumption of toner and the use of the paper. Somemachine do not have this function. A DHCP server provides specific configuration parameters for the DHCPCLient host
that requires, in general, information required by the top -round host client on an IP network. Follow the instructions in Thewindow. By setting IPV612345Press the button (menu) on the panel Press the network> TCP/IP (IPV6)> Active IPV6. Select and press OK. Turn The Machine Off and turn it on. Driver.click Add to a In the left pane of the printers
and windows Windows.Click Add a local printer in the printer Add window. 2. Using a machine connected to Rete101 Page 102ipv6 configurations of IPV6111 addresses from the synchro & € Za ¢ The web service machine supports the following IPV6 addresses for network printing and management. Self -configuration of the IPV6 address (address
begins with FE80) .4 € 4 A & ¢ State address without a state: IPV6 address automatically configured by a NetworkRouter. A ¢ 4velop manual address: IPV6 address manually configured by a user. ¢ Web service first using the IPV4 address and follow the procedure below to use IPV6.1 Access a web browser, such as Internet Explorer, from Windows.
He defines the wiring and reporting for the physical layer and frameformats and protocols for the level of control of multimedia access (Mac)/data connection level of the Theosi model. Regulates the printing resolution and deactivates the toner rescue mode. Foresemlem, the 5% coverage means that an A4 facade card has about 5% image or texton.
Check if the machine is Energy Starcertified. Appendice69 page 70 regulatory information. Only disposal of correction of the United States of America of this product (electrical and electronic equipment of waste) (applicable in the European Union and in other countries with separate collection systems) this product marking, accessories or literature
indicate that the And its electronic accessories (e.g. charger, earphones, USB cable) should not be disposed of with other domestic waste at the end of their working life. To use a saved setting, select it from the Preset drop -down list. The car connects to the Theaccess point (or wireless wireless The machine is correctly connected to the wireless
network, the WPS LED light remains on. 2. Using a machine connected to Network109 Page 110 Wireless Setupre-concession to a network network from a network when the wireless function is deactivated, the machine automatically tries to reconnect the access point (or wireless routers) with used wireless connection settings previously. Disconnect
the wireless network connection, press the control panel for more of two seconds. (WPS) button on dvelop when the Wi-Fi network is in an inactive mode: the machine is immediately deactivated by the wireless network and the WPS LED turns off. avelop a ¢ & ¢ avelop the machine is deactivated and resounds. When the Wi-Fi network is used: while
the machine awaits until the end of the current work, the light flashes quickly on the WPS LED. Click on options, you can set the default device options. A dvelop works: shows the list of printing works. If possible, connect the cable and the car to another computer you know and try a print job. The number of pages is influenced by the operational
environment, by the printing, graphics, media type and media size. In this case, it is not applicable to the machine. Avelop the help or click on 36) .itemmultyple Pages for side from the window or F1 window on the keyboard and click on any option you want to know (see "Use of help" on PagegescriptionSlects the number of pages to be printed on a
single sheet of paper. Appendice64 Page 65 Internet Explorer 6.0 or higher specifications is the minimum requirement for all Windows operating systems. A ¢ For Windows 2000, the 4 or higher service package is required. MB for a Mac based on PowerPC (512 MB) HDD Spacel GB & ¢ avelop For a Mac based on Intel (1 GB) & ¢ avelop Intela ¢ a®
Processers512 MB (1 GB) 1 GBMAC OS X 10.5 avelop avelop Intelda ¢ A® Process1 GB (2 GB) 1 Gbmac OS X 10.7a ¢ avelop Intela ¢ a® Prodors2 GB4 GB5. Theadhesive support is designed for a single single passage through the machine. Avelop do not use labels that separate from the support sheet or are wrinkled, gurgled or otherwise damaged.
When by selecting the labels, consider the following factors: -desive: they should be stable at the melting temperature of the machine. Since the unified Linux driver blocks the portolest print, the sharp conclusion of the driver maintains the door blocked and not available for subsequent printing works. Turn off the car and return again. The toner
cartridge is defective or outside the toner. Redistribute the toner, if necessary. If necessary, replace the toner cartridge. See "Redistributing Toner" on page 43. & mbers "replacement of the toner cartridge" on page 44. The file can have empty pages. Check the file to make sure it does not contain empty pages. Some parts, such as the controller or the
card, can be defective. Contact a service representative. The machine does not correctly print the pdf files. Some parts of graphics, text or illustrations are aremissing. Incompatibilitat has between the PDF file and the Theacrobat.print products of the PDF file as an image can enable the file printing. See the Printer driver guide screen (see "use of the
aid" Onpage 36). A print job is extremely slow. The setting of the orientation of the page can be incorrect. Change the orientation of the page in the application (see "Opening of the press preferences" Onpage 35). Ethernet is for the most standardized as IEEE 802.3. The LAN Most -Widespread technology was become used in the 90s in present.
Protocol (FTP) is a protocol commonly used for the exchange of any files which supports the TCP/IP protocol (such as Internet or anintranet). Unit Fuser the part of a laser printer that merges the toner on the printing support. Initially he used cooperative multitasking to perform various services on a PC and network protocols were based on the XNS
XNS archetypal stack. WEP encrypses the datupation of each package exchanged on a wireless network using a 128 -bit 128 -bit WEP encryption key. intervals. Use of a machine connected to Network105 Page 106wireless Network Setup Up Method Connecting Methodaccess Point via USB (recommended) (from computer) ad hoc cable (other
Windows configuration methods, see "access point via USB cable" Page 111. & ¢ avelop Macintosh User, consult "access point via USB cable" on page 120.) Access point via the WPS button (without a USB cablonnection) (description and reference) is a a. ¢ Windows User, see "Access point via WPS button (without a USB cable connection)" on page
115.4 ¢ avelop Macintosh User, see "Setting the access point using the WPS button" on page 124. "Windows user, see" ad hoc via USB cable "on page 117. & ¢ 4,— a ¢ Macintosh user, see" ad hoc via USB cable "on page 126. Use a network cable" See "use of a cable network "on page 128. Wi-Fi Direct" setting "on page 131.If problems occur dur ante
the installation of set up or wireless drivers, consult the chapter on the resolution of problems (see "problems resolution" on page 133). 2. The term "1284-B" refers to a type of specific connector to the extremmit of the parallel cable that connects to the peripheral (for example a printer). Click Continuation .1. Installation of the software83 page 84
reinstallation for macintospiif The printer driver does not work properly, uninstall the driver e Sure the machine is connected to the computer computer ON.23456Ert the software cd supplied in your CD-ROM Drive.Double-Click the CD-ROM icon that appears on your Macintosh desktop. Double-Click The Mac_installer folder> Uninstaller OS X icon.
The password and click OK. When the uninstallation is performed, click OK. and fax.1. Installation of the Software84 Page 85Instillation for Linuxyou Declachina Software Linux Packages from the Samsung Web For Toinstall the printer software ( > Find your product> Support or download) .1 The installation program added the Driver Configurator
Driver Desktop iconand the unified driver group in the system menu for comfort. It automatically detects and corrects errors in the fax transmission process which are sometimes caused by the noise of the telephone line. A suite of protocols developed by Apple Computer for computer networking. Draw the password function and try the printing.
Cooking the machine settings for your needs. Primation before. This product and its electronic accessories should not be mixed with other ForticiSal. 5 commercial waste. Appendice70 Page 71 Regulatory information This equipment was tested and found to comply with the limits of a classb digital device, pursuant to part 15 of the FCC rules.
Appendice75 Page 76 Regulatory information such as a general guideline, a separation of 20 cm (8 inches) between wirelessdevice and body, for the use of a wireless device near the body (this does not include the extremities) is typical. A imaging unit containing a drum slowly wears the surface of the drum from its use in the printer, and should be
replaced appropriately with the contact with the brush for the development of the the cleaning and paper mechanism. The first example of something original, such as a document, a photograph or a text, etc., which is copied, reproduced or translated to produce others, but which is not itself itself or derived from something else. Interconnection of
systems (OSI) is a model developed by the international organization for standardization (ISO) for communications. Contact a service representative. 5. Resolution of the problems187 Page 188 Propting Problemsconditioncitationcurlgested Solutions if the printed paper is curled or the paper does not feed in the machine: a ¢ avelop the pile of paper
into the tray. Click Next. If the PC modification setting window is displayed, follow the steps in Thewindow. If the computer is set to DHCP and you want to use the Static WirelessNetwork setting, you need to contact the network administrator to obtain the Ecstatic IP address. ASSIGNMENT OF THE IP address is DHCP, check if DHCP is shown in the
wireless network setting window confirmation. If there is a noinstald onyour machine driver system, then this option has been applied because the operating system will set the driver installed as a default machine driver. I use existing machinedliver files to create the printer request if it is installed. Installation driver files installed without installation
of an additional framework. REMOVESS only specifies the Driver file. This command provides away to remove only the application for Printer specified by your SSystem without making printer driver. The machine is automatically stamped the configuration ratio of TheWetwork. This was useful (40) What does DPI mean? PDF documents can also be
encrypted, so only authorized users can open them. Instrukcja Obsa ¥ both do drukarkki samsung ml-2165w hot instrukcja obsa ¥ lend do drukarkki laserowej samsung ml-2165w worsja: iat ml-2165-165wa ¢ 26-12-265-165-165-1265w. 12-12-12-265Wa ¢ 26-16-12-265Wa ¢ 2017-03-02a 'Price' a 'added by the editorial office' a a 'changed by' Maciej
Open the configuration of the printers and select the machine from the printers list. For the network administrator, in particular, it is possible to manage the severe machines on the network. Before using the programs below, set first the IP.4 ¢ a establish some functionalities and optional goods may not be available depending on ONMODEL or
COUNT ¢ 4€ Z & ¢ Web Admin Service Service Based Machine Management Solution for Network Administrators. Access to Internet.d ¢ avelop this program from http: //solution.samsungprinter.com.13NCTHRURUA By & € Za ¢ Web server web incorporated on your network computer allows you to do the assets below 103 ): A ¢ avelop the
information and the status of the supplies. The machine is connecting to the Theaccess point (or wireless router). The network configuration report, including PIN, must be printed (see "Print a network configuration relationship" on page 90). (WPS) (Cancel or Stop/Delete): Press Thebutton Formore of ten seconds on the control panel. You can find
the machine PIN.2 Press and hold the (WPS) control of the Panel Control Check for more than 4 seconds until the State LED remains. The machine begins to connect to the access point (or wireless router) .3 It is necessary The eight -digit PIN within two minutes from the selector connected to the access point (or wireless router). The LED flashes
slowly for a maximum of two minutes until you enter the Ottadri pivot. He crashes the eyelids quickly on the WPS LED. - which is performed in an interpreter to generate an image. An agreement or standard that controls or enables the connection, communication and transfer of data between two calculation endpoints. The media media the media
such as paper, envelopes, labels and transparencies that can be used in a printer, a scanner, a fax or a copying. Telephone networks that, in industrial premises, have is Isusly to the switchboard. Radiuppmpages per minute (PPM) is a measurement method to determine how much the fairy printer works, which means that the number of pages that a
printer can produce in an authentication dial on the matter. (Radius) It is & € ce & € <A protocol for the authentication and accountability of the remote control. The most faxesconsist for the most of the white space, cié minimizes the transmission time of more faxes. Led the emission of light (LED) is a semiconductor device indicating the status of a
machine. Control Access Control (Mac) is a unique identifier associated with Anetwork adapter. Ask your network administrator of this information before you are in the lead with the installation of the machine. Office). From the Start menu, select Programs or Allprograms> Samsung printers> Printer Name Driver> Wirelesssetting.items program a
Point & ¢ CD Software connected to the network connected to the network supplied with the machine 4 A A 4 A 4 A € installed with a wireless network interface Aias & ¢ USB cablecreating the infrastructure network12345check if the USB cable is connected to the machine. 6 The software Search for the wireless network. .Turn on your computer,
access and machine point. Insert the software CD provided in the CD-ROM unit. Select the wireless setting and installation option. Read the license contract and select I accept the terms of the Thelicense agreement. From the list and click charge. Verified no, this is a special feature that some printers have. Make sure to read and understand all these
instructions before using the machine. Click OK.4560pen The File menu and click Print.open the File menu and click the Set page (Setting the document in SomeAppications). Print more pages on a sheetueu can print more than one page on a single sheet of paper. It is made up of a heat roller and a pressure roller. A network protocol used by a
network client to automatically get your iPaddress. Radius allows the centralized management of authentication data such as user and password names that use an AAA concept (authentication, authorization and accounting) to manage NetworkAccess.Prn Fileresolution Interface for a device driver, Cié allows software to interact with DeviceDriver
using calls standard input/output system, which simplifies many tasks. The sharpness of an image, measured in points per inch (DPI). To Bardzo Proste: Po Prostu Wpisz Nazwa & A A & A A MARKI I RODZA]J Produktu W Pasku Wyszukiwania, A OD RAZU Ba A A A A 4 Dziesz ma £ 43ga ¥ 4 € Sprzejrzed 4 € Instrukcja % ¢ Online za darmo.
Introduction17 Page 18 Control Panoramic Panel This control panel can differ from the machine according to its model. There are various of control panels. 3 Configuration of the wireless network connection easily without acomputer (see "Setting the wireless network" on page 104). Button for about 10 seconds until the Green LED flashes slowly and
release. A ¢ 4,— & mbers Supply information Report / error Report12 (WPS)- Press and hold this button for about 15 seconds until it was brought and released. - Press this button every time you load a sheet of paper in Thetray if you have selected the manual power supply for the origin in the print driver see "status LEDs" on page 56). (STATOLED) 1.
SPECIALE featuressamsung AnyWeb Print158asy Eco Driverl1 59Anderstanding Easy Capture Manager160using SyncthruA¢ a4A¢ Servizio Web161using Samsung Easy Stamper Managerl 64using Samsung Start167using Smart Panel169 Usando il Linux Unified Driver Configurator 1715. NecessitA di un manuale per samsung ml-2165? The
Blinksslowly LED for a maximum of two minutes until you press the PBC button on the Theaccess point (or wireless router) .2 Press the WPS button (PBC) on the access point (or wireless router). The light flashes quickly on the WPS LED. Radius allows the centralized management of authentication data such as user and password names that use an
AAA concept (authentication, authorization and accounting) to manage access to the network. Resolution the sharpness of an image, measured in points per inch (PPE). The highly colored areas consist of a large number of points, while the most clear areas consist of a lower number of points. The HDDHARD (HDD) unit, commonly indicated as a hard
drive or hard disk, is a non -volatile storage device that digitally stores -the data codified on quick rotation with magnetic surfaces.ieethe Institute of Electrical and Electronics Engineers (IEEE) is an international non -profit organization, for the progress of technology relating to electricity .iee 1284 the 1284 standards of parallel has been developed of
electric and electronic engineers (IEEE). Samsung Easy Print Manager Manager Settings, © Printing environments, settings/shares and dilation. Before printing, decide how you want to orientate your document. Double-sided print (manual) a-Puoi use this function with letter, legal, A4, US or ophic-a-sizes your machine does not have a duplex unity, it
is necessary to manually complete the printing work. Install a new toner cartridge (see "Replacement of Thetoner cartridge" on page 44). A ¢ The document may not satisfy paper specifications; For example, the card can be too humid or rough. A ¢ If the entire page is light, the printing of printing resolution is too low or the toner rescue mode is
active. Check if the softwarepprication expected that an installation or postscript header file was sent to the machine. The optional tray is not selected in the driver. The printer driver has not been configured to take the optional tray. Open the postscript driver properties, select the device, select the device, select the Options tab device and set the
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889www.samsung. COMCONTACT Samsung Worldwide196 Page 197GlossaryAdf Il seguente glossario ti aiuta a familiarizzare con il prodotto che ha inventato le terminologie comunemente utilizzate con la stampa e la comunicazione di WLAN (WLAN), una serie per la rete di area locale Developed by the Committee for IEEE LAN/MAN/MAN
standards It can share the same hardware and use the 2.4 GHz band. The GUI LPR window is displayed. The following five cards are displayed at the top of the window: to print any document file: 1 Open The Unified Driver configurator. They may not be available according to the models or options. The product was designed in Agaction and is fully
compliant with all the relevant consultancy notes contained in this document. Mar 9 This should be in controlled temperature conditions and humidity. Page 83instillation for Macintosh12345678910make certain that the machine is connected to your computer and addressed to. Your CD -rom Drive Drive .Double-Click The CD-ROM icon that appears
on your Macintosh Desktop.1516Click predefined browser and finds the USB connection. avelop for Mac OS X 10.5-10.7, click on the default and find the USB connection. Read the license contract and click Agreement and click Agreement and click Agreement and click Continuous License. Accept to accept the license agreement. Add to the list of
printers.a ¢ avelop for Mac OS x 10.5 -10.7, click on the icon of the folder & ¢ dvelop "+a ¢ avelop; An Willpop Up.Double-Click display window The Mac_installer folder> Install OS X icon.Click Continue. Operate the Applications Folder> Utility> Print installation utility.17 For Mac OS X 10.4, if Auto Select does not work properly, select Samsungin
Print using Samsungin Use and the name The machine driver and the software are automatically installed on your computer. Do not allow children to touch. Burks can occur. Do not allow pets to chew the power supply cable, telephone or pcinterface. When it removes the jammed paper, do not use sharp tweezers or metal. This could cause electric
shocks or fires and/ or injuries to your pet. It can damage the car. Introduction 11 page 12 security information do not allow too many documents to stack in the paper exit tray. Cauciuionit can damage the car. Do not block or push objects in opening ventilation. This could lead to high temperatures of the components that do not move. The car, turn
off and disconnect all the signs. IPX and SPX both provide connection services similar to TCP/IP, with the IPX protocol with similarities with IP and SPX with similarities with TCP. So you can always use the iPaddress set with the Mac address. Click Next. Select the network printer and click the search button. The IP address and the name of the
machine model are displayed in the list field. Double-Click the unified driver configurator. Add printer Add. Added the printer's wizard window. Introduction18 Page 19 Panoramic control 3 & € print the screen: press this button and the green LED starts flashing. Install the toner cartridge (see "replacement of the toner cartridge" on page 44). Outs,
make sure that the protection coverage and the sheets are removed from the toner cartridge (see "replacement of the toner cartridge" on page 44). If a system error occurs, contact the service representative. The connection cable between the computer and the machine is not correctly connected. Disconnect the & € <a €< cable of the and reconnect it
(see "rear view" on page 17). The connection cable between the computer and the machine is defective. You can also try using a different machine cable. The setting of the door is Windows printer settings to make sure the printing work is sent to the correct. Problem resolution178 Page 179 PROPLY PROBLEMS WITH MACHINE CHILLS, But the text
is wrong, confused or incomplete. WPA-PSK generates a univocal stop for each session between a wireless client and the WAP associated with MoreadVance security. Wi-Fi Protected Setup (WPS) is a standard to establish a wireless homnetwork. It is possible to delete a tail job before printing or promoting a job to print first. A avelop file policy: you
can choose file policy for generation of the file name before proceeding with work via optional memory. The wirelesscomputer and the wireless machine communicate directly. 2. Using a machine connected to Network104 Page 105 Wireless Network Setupl3introducing wireless Set-up Methodsyou can set wireless settings from the machine or
computer. When the terminal screens set, type the following. [Root@Localhost Root] #cd/opt/samsung/mfp/noninstall/[root@localhost noninstall] #./Noninstall.sh456clickinstall.click next.click fine.1. Installation of the software87 Page 882. It is still possible to use Syncthru 4 € Za ¢ Web service without accessing buttyu you will not have access to the
Settings tab and the safety card. The information sheet provides general information on your computer. These repairs are not covered by Swarranty or Samsung service agreements. Outs, make sure you do not use the ink jet photographic paper with this machine. This was useful (58) Each printer can print on photographic paper? Edit OverLay
Window appears. CIn the Edit OverLay window, click Crea.din the save window as a window, type a name up to eight characters in the file name box. Select owners or preferences and configure the print mode. 7 from of control that the machine has an optional memory or an optional, optional hard drive, It can use the functionalities of the work
management menu. A ¢ Active work: all printing works waiting to be printed are listed in the Activejob tail in the order in which you sent them to the printer. DHCP also provides a mechanism for OFIP allocation addresses to host clients. Dot per inch (DPI) is a measurement of the resolution used for scan and printing. Yes3 votes our support team
looking for useful information on the product and answers to frequent questions. Type the predefined ID and password below. If you have a DHCPV6 server on the network, you can set one of the following options for configuration of the predefined dynamic host. A ¢ avelop: amins A A A A A A 4 A A: SEC00000123Press the button (Menu) on the button
(menu) on the button (menu) button (menu) on the (menu) button on the Menu) button on the Menu) button Control Panel.Press Network> TCP/IP (IPV6)> DHCPV6 Config.3 When you open the SYNCTHRULE WINDOW WINDOW & € Za ¢ Web service, move the mouseculero over the settings of the menu bar at the top and therefore click on
NetworkkSettings.456Click TCP/IPV6 of the website. Press OK to select the required value desired. A ¢ avelop dhcpv6 off: never use dhcpv6 regardless of the request of the router. Check the IPV6 protocol control box to activate IPV6. Check the manual address manual control box. Using a machine connected to Rete132 Page 133Wireless Network
Setup-Access Syncthru Web Service, Select Settings> Network Settings> Wireless> Wi-Fi Direct. 21troubleshooting-ENTABLE or Disable Wi-Fi Direct. Up mobile devices not found is avelop From the printer, refer to the user's user manual that you are using to set up its direct wi-fi. If none of everything there solves the problem, contact the
manufacturer. It is a networking protocol used by Novell Netware operating systems. Tiffimages uses tags, keywords that define the characteristics of the image of the image included in the file. It is possible to directly open the problem resolution section in the Sugide Panel overview. 38SMART of the user, you can control the error from the
intelligent panel. You can also start Smart Panel. ) In the notification area. Various machine settings can be configured in the printer settings window. Then, click Next.a ¢ avelop encryption: select encryption (none, WEP64, WEP128). 4 € a € Network key: enter the value of the encryption network key.a € confirms the network key: confirms the value
of the encryption network key. The software was unable to search in the network, check if the USB cable is correctly connected between the computer and the machine and follow the instructions in the window. 7 avelop WEP key index: If we use WEP encryption, select the appropriate key index. The network safety window appears when the safety of
ad hoc network enabled. After the search for wireless networks, a list of wireless networks that the machine has searched appears. It is a security protocol that prevents authorized access to your wireless network. Clean the interior of the car (see "cleaning the machine" on page46). Tlog-in is necessary as an administrator to view this tab. S by setting
this option. Otherwise, new tonnartridges or other supplies will be incompatible with the machine due to different configurations of toner cartridges and other supplies based on specific country conditions. Samsung does not recommend using the non -genuine samsung toner cartridge like the toner republished or regenerated. Problem resolution51
Page 52 Clearing Paper Jamsto avoids tearing the Pull the paper jammed slowly and gently.1 in Vay4. If this box is checked, a message window appears every time you send a document for the printing, asking to confirm the printing of an overlay on the document. If this box is not controlled and an overlap has been selected, the overlap automatically
prints with your document. Eclick ok or print until you leave the print window. Ail the print preferences window, click the advanced tab. Bebde Edit in the text drop -down list. Select the overlap that you want to delete from the Overlay list box. The message window is displayed, click on it. Fall ok or print until you leave the print window. If the
message is displayed in ReadyMode or after printing, check the connection and/or if an error has occurred. Report to the guide of the Microsoft Windows 2000/XP/2003/Vista user who was provided with your computer for more information on Windows.5 error messages. Problem resolution189 Page 190 The problems of the operator system 2common
macintosh problem the machine does not print pdf correctly. A A © Copyright 2022 Instrukcjaobslugipdf.pl. The 1 -bit color is commonly created as monochromatic or black and white. Access point of access point of access or wireless access point (AP or WAP) is a device that connects communicationwireless devices together on networks of wireless
local areas (WLAN) and acts as a central transmitter and central receiver of WLAN radio signals. Bpa graphic format Bitmmappato used internally by the subsystem of Microsoft Windowsgraphics (GDI) and commonly used as a simple graphic file format that platform.glossary197 Page 198GLossarybootpcovegootstrap. When in the setting, you are not
sure the sanction to use Wireless, ask the Autority applicable for authorization before using or turning the devicewireless. Each country has different restrictions on the use of wireless devices. Since the system is equipped with a wireless device, when when Countries with your system, check with the local radioactive authorities before any move or
journey for any restrictions on the use of a wireless device in the country of destination.19israel only5. The filigrane modification window appears. Select the watermark you want to edit from the list of current filigree and edit the message and filigree options. Update update to save the changes. Eclick ok or print until the print window is released.
Change the printing settings from software application, Access Printing Preferences.Blick the advanced tab, select Edit from the watermark drop -down list. For example, you use it when you want to have large gray letters of "draft" or "confidential" printed diagonally through the first page or all the pages of a document. Change the printing settings
from the application of the software, access print preferences. Blick the advanced tab, select Edit from the watermark drop list. It is necessary to install a unified Linux driver to use unified Driverconfigurator (see "Installation for Linux" on page 85). After installing the driver on your Linux system, the unified configuratoron driver automatically
created on the desktop. Click the Unified Driver Configurator on the Desktop.1 Printer Configction2 Configuration Configuration you can also click on the Start menu icon and select Samsung Unifiedriver> Unified Driver configurator. 172 Using the Unified Linux Configurator Printrors TabView driver The configuration of the current system printer
by clicking on the iconbutton of the machine on the left side of the unified driver Windows A ¢ avelop test: allows you to print a test page to make sure that the machine is during the Workingproperly phase. A ¢ 4,— & mbers: allows you to view and modify the owners of the printer. Table class The classe tab shows a list of available machines classes.
and Uri of the machine. 2 The printer control buttons are, as follows: & ¢ avelop update: renew the list of available machines. A ¢ avelop printer: allows you to add a new machine. A ¢ avelop the printer: remove the selected machine .4. Useful management tools172 Page 173 using the unified Linux Configuratorl driver shows all classes of machines.
to the door and the state.d ¢ avelop: renew the list of lessons. A ¢ avelop: renew the list of available doors. Renaissant classy class: remove the selected machine class. 4 € Release door: release the selected door. 12 Ports Configuration in this window, you can view the list of available doors, check the status of each port and release a door that is
blocked in a busy state when the Its owner has peeled the work for any reason. 2134. If the configuration is right, click Apply. 2. Using a machine connected to Rete130 Page 131 Wireless Network Setupisconnect the network cable (standard or network). Remove the card and turn it. AHORIZONTALI STRIPES - The paper may not satisfy the paper
specifications. If black streaks or horizontally aligned stripes appear: & ¢ avelop the toner cartridge can be installed improperly. The wireless device system in your system is qualified only for use in countries from the radioapproval signs on the system evaluation label. Use a one Machine94 Page 95 Installing Driver on Networkcommand- Riga/A & €
Dest path> & ¢ avelop/AHE ¢ a,— a definition Description specifies the installation of destination for installation.The destination path should be cleverly qualified ./ 4,— a ¢ 4,— or/i & ¢ &4,— & ¢ avelop the personalized script file for the file of script. Themachine visualize a list of available networks from which Tochoose. The Wirelessdevice (or devices)
power output, which can be incorporated into the printer, is well below the Therf exposure limits as set by the FCCC.FCC education for the use of wireless LAN: during the Installation and operation of this combination of transmitters and radio frequency antenna The limit of 1 m w/cm2 can be exceeded the atheists near the installed antenna. The first
part of the address indicates which protocol to use, the second part specifies the IP address or domain name in which the resource is located. Usb Universal serial bus (USB) is a standard developed by the USB Exerters Forum, Inc. to connect computers and peripherals. In this case, perform the following Twocommands on the Root terminal: & ¢ 4,— &
"Accept & ¢ daste the administrative guide of your UNIX operating system for details. > A ¢ 4, — UNPACK The UNIX printer driver package. Example, on IBM Aix, use the following commands. TAR XF -4,— 5GO to the unprotected directory. 2. Using a machine connected to Rete99 Page 100installing Driver on Networkuninstalling The driver of the
Packagethe Utility printer should be used to eliminate the printer installed in the system. One execution is avelop "uninstallprinter 4, — command from the terminal. Open the uninstall printer wizard. The installed printers are listed in the drop -down list.B Select the To be deleted. C Click Delete to delete the printer from the system. Page 138 Altond
the quality of the press is influenced by atmospheric pressure, which is determined by the height of the machine on the sea level. In the same way, if the computer's network configuration is set on static, the setting of the Netwireless should also be static. 910 avelop for the static method if the method of assigning the IP address is static, Check if
static is shown in the confirmation window of the wireless network network. The saved folder can be based on the operating system or the application you are using. Special features141 Page 142 Use of advanced printing characteristics2andersanding special Printer Features You can use advanced printing functionality when using the machine. To
take advantage of the printer functionalities provided by the printer driver, click on ownership or preferences in the application window to change the printing. If you use a vacuum cleaner, the toner blows in the air and could be harmful to you. Avelop during the printing process, paper, toner and dust particles can accumulate inside the machine.
Therefore, the wireless network connection is automatically disconnected and the WPSHEAULS avelop the access point (or wireless router) is deactivated and on. Let goes out. In the following cases, the machine automatically reconnects to the unparalleled network: 15 cancellation of the processing of the Driving menu processing cancels the
wireless network connection when the machine connects to the wireless network, press and release the button (cancel or stop/cancel) or (Power) on the control panel. A ink jet printer places extremely small ink drops on paper. Manual- user-guide.com is not responsible Impactness, omissions or any other error in information. Check the USBCABLE
power and the power supply of your machine. Wrong connection - connected wired network - Gateway: 169,254.133.1 Other problems, they occur during the use of the machine on a a a Check the following: the machine is connected with a wired network cable. Otherwise, connect the machine with a standard network cable. With direct Wi-Fi, you can
connect the printer to a direct Wi-Fi network while connecting to an access point, you can also use a wired network and a direct Wi-Fi network simultaneously so that more users can Access and print both from direct Wi-Fi and from a wired network. 2 Start a web browser such as Internet Explorer, Safari or Firefox and the new Entery Machine IP
address in the browser window. For example, it's not possible to connect to the Internet via the printer Wi-Fi Direct. A ¢ The list of supported protocols can differ from your model, Wi-Fi DirectoNetworks does not support IPV6, network filter, IPSEC, victories and SIPServices.34Click access to the top right of the web service website Syncthrua ¢ 4 €
74 ¢. Type in the ID and Password, then click on Login. Wi-Fi Direct & ¢ Id: Admin& ¢ & establish password: SEC00000 characteristic of one of the following methods. 2. Using a machine connected to Rete131 Page 132 Wireless Network Setup-Propriors of the group: activate this option to assign the owner of the Wi-Fidioct group to the printer. If you
show DHCP, click Change TCP/IP to enter the iPaddress configuration values and others for the machine. Before entering the IP address for the machine, you need to know the information on the configuration of the ThecomPuter network. A complete declaration, which defines the relevant referential directives and standards can be obtained by
Samsung Electronics Co., Ltd.representative. 5. Appendice74 Page 75 Regulatory information information on European radio (for products with radio devices approved by the EU) no limitation in this timel8low power, devices of type of wireless communication at 2.4 (RF)), which work in the 2.4 GHz/5 GHz band, can be present (incorporated) in the
printer system intended for the use of home or in the office. office. The chapter provides information on the general structure of the menu and on the basic setupoptions.a ¢ avelop a demo page24 avelop media and tray25 a AL basic printing34 page 24 printing a page of the demo page a demo page To make sure the machine works correctly (only
Windows). To print a demo page: a ¢ dvelop the print preferences (see "opening of printing preferences" on page 35)> Samsung card> demo page. If this crew causes harmful interference to radio or television reception, which can be determined by deactivating and on, the user is able to try to correct the interference of one or more of the following
phases: & ¢ a establish .A ¢ avelop the separation between the equipment and the receiver. Connect the equipment into an outlet on a different circuit from what the receiver is connected. & € Consult the retailer or the expert radio technician for help. Changes not expressly approved by the manufacturer Responsible for compliance could cancel the
user's authority to manage Teequipment. The rules of Canadian radio interference that this digital system do not exceed the limits of class B for radio noise emissions from the digital system established in the expiry interference standard entitled a ¢ avelop "apparatus home to a €, 003 of the sector and science Canada.cet appears Numa © Rique
respectful Les Limits De Bru The RadioEconiquesAppricables Aux belonging Numa © Riques de Class BConds Dans The Sur Lemata © RIEL BROUILILEUR: a ¢ avelop "Appareils Nummon. of intentional emitter of the Communications Commission of Americafederal (FCC) for FCC part 15low power, devices of a radio communication type of radio
(RF)), which operate in the 2.4 GHz/5 GHz band, can be present ( incorporated) in the printer system. Refer to the Labelto system check the presence of wireless The devices that can be in the system are only qualified for use in the European Union or Associatesese if an EC brand with a notified body registration number and the notice symbol is on
the system label. The printer is well below the RF exposure limits established by the European Commission through the R&Tte directive. European states qualified on the basis of wireless approvals: EU European states with restrictions on use: EUIN France transmission of power as wireless communication devices (RF) Wireless communication
devices (RF) radio type devices (RF), which operate In the 2.4 GHz/5 GHz band, they can be present (incorporated) in the printing system. It is the format used for the storage and transmission of photographs on the World Wide Web. Laser Printers.Pdfortable Document format (PDF) is a proprietary file format developed by Adobe Systems to
represent two -dimensional documents in an independent independent format and resolution of devices. Printers, serial doors and various communications between nodes on a network. The warranty does not cover the replacement of any maintenance parts once it has reached its average yield. "The maintenance parts are replaced at specific intervals
to avoid the quality of the printing and the paper supply problems resulting from worn parts, see the Table below. This equipment generates, uses and can radiate radiofrequency and, if not installed and used in accordance with the instructions, can be harmful to radio communications. It will be influenced by the operating system used, to the
calculation performance, application software, connection method, media type, size of the supports and comedances. Maintenance40 Page 41 Strong the cartridoner toner cartridges contain components sensitive to light, temperature and humidity. This scriptfile can be created orthodified by providing Text Editor's customization Uthradilers. The
scriptfileme should be completely qualified unanotic: this personalized scriptfilema. It is first that the setting defultinstaller in SetuppackageAge but not a priority line parameters. a,— or/na ¢ a,— a ¢ avelop the name of the printer. The printer request must be drunk as the name of the specified printer. With this parameter, printer instances such as
Yourwishs.command- lines/nd or/nd/x or/x/uprua is possible Utility> Splex Installation Utility .&4 ¢ avelop for Mac OS X 10.5-10.7, Open the Applications Folder> Systempreference and Click Print & Fax.15 aiation for Mac OS X 10.5-10.7, if Auto Select does not work properly, select the printer software and the name of your printing machine using.
8linuxyo you need to download Linux software packages from the Samsung web website for printer software (www.samsung.com> Find your product> Support download). To install other software: a ¢ avelop Installation of the intelligent panel "on Page 85. When printing a Mento document containing many pages, PERFORMERMAY PRINTING IS
IMPROVE SHOWING CHOPPLER THE PRINTER TYPE OPTION.18" See "Installation of the user of the printer settings "on page 86. Ensure the IP address of the machine in the address input of the address. 2. Using a machine connected to Rete97 Page 98 Installing Driver on Networkinstall the Linux driver and add the printer A safe network
printermake that the machine is connected to the network and Poweredon. Contact a service representative. Character Voidscharacter's voids are white areas Parts of characters who should be black solids: a ¢ avelop you could print on the wrong surface of the paper. There are also frequent questions, a product evaluation and users' feedback to
allow you to optimally use your product. The name is displayed in the OverLay.FClick list OK or print until you leave the printing window. The file is not printed. Click Next. Next if you are finished with the computer wireless network settings. If you set the computer wireless network on DHCP, it will take several minutes to receive the IP address.
111213Click forward when the printer confirmation connection window appears. 4 After the installation it is finished, a window that asks you to Print a PageApparers test. Ledbllinks slowly for a maximum of two minutes until the PBCButton is pressed on the access point (or wireless router). The light quickly flashes on the WPS LED while connecting
to the Theaccess point (or wireless router). After installation it is over, a window that asks you to print a Pageasars test. The toner can be merged by a combination of heat/pressure from the Fusol or domestic users. Check the specifications of the machine to view the melting temperature (about 170 & ° C (338 A ° F) .- disposal: use only labels without
any support exposed to each other. Lebels can detach the sheets that have spaces between the labels, causal jams. -Curl: must lie down with no 13 mm of curls in any direction. Learn the base use31 Page 32Media and Traycard sedan/ paper paper of customized paper when the loading of the pre -stopped card, the side printed should be turned
upwards with the edge anuncurred in the front. By default, it is the self -election. a € orientation: select the direction in which the information Print on a page. Duplex: print on both sides of the card to save the paper. Options from the window as the selection of the page. Select how many copies are needed in number of copies. To exploit the
functionalities of the printer provided by the printer driver, press Propsate (see "Edit of the printer settings" on page 151) .3. If you do not know the environment of your wireless, ask the person who has set up your network. 2. Using a machine connected to Rete110 Page 111 Wireless Network Settupaccess Point via USB Cableafter by completing the
wireless network connection, you need to install the Amachine driver for printing from an application (see "installation of the driver on TheWetwork" on page 93). 123 Press the (Menu) button in the Control Panel.Press Network> Wireless> WLAN Settings.Press the OK to select the desired configuration method. Installation is automatic. This section
is applicable only if the managers are present. The greater the DPI, the greater the resolution. The state of an Macactedia control (Mac) address of Machine.Mac is a unique identifier associated with a network adapter. The emulation focuses on the exact reproduction of the external behavior, which is in contrast with the simulation, which concerns
an abstract model of the system that is simulated, often considering its internal state. Ethernettnettnet is a network technology for frame -based computer for local areas (LAN). The PDF format also supports metadata, such as the title of the document, the author, the object and the keywords. (Nobody, WEP64, WEP128, TKIP, AES, TKIP, AES) 4 ¢ a,—
a e Network key: to enter the value of the encryption network key. A 4, & A A & the network key: confirms the value of the encryption network key. Index WEP key: If you are using WEP encryption, select the appropriate key index. The wireless network The window appears when the Access Point safety window is enabled. The wireless network safety
router) has a safety configuration (password). Refer to the user's driving for the software to deactivate it and the search for the machine again. When they use The ad hoc modalities, in operating systems such as Windows such as Windows Vista, may be necessary to set the wireless connection setting whenever you use the wireless machine. a avelop
wireless network. If the IP address of the machine is correctly assigned. This flexible format independent of the platform can be used for the images that have been made by various images processing applications. Bottilla D or container used in a car like a printer that contains toner. IPX/SPX has been designed in a prevalent way for the local area
networks (LAN) and is a very efficient protocol for this purpose (generally its performance exceeds that of TCP/IP on a LAN). Two -level image experts (JBIG) group experts is a compression of the image The standard without loss of accuracy or quality, designed for the compression of binary images, in particular for faxes, but it can also be used on
other images. Isojpegjoint Photographic Experts Group (JPEG) is a more commonly used standard of compression loss for photographic images. A device that has an adequate Keycan Wep access to Network.Wpa Personal or WPA2 Personal: select this option to authenticate fingerprint server based on a WPA pre-controlled key. He couldn't damage
the car. A ¢ Use of flammable flammable print media cause a fire. The use of flammable supports or foreign materials left in the Maylead printer to overheating unity and, in rare cases, can cause a fire. 1 Guide of Carta 1 width of the patch of the Carta2 width of the Carta2 Trayif does not regulate the guide, can cause the registration of the paper, the
inclination of the image or the paper cap. To change the size, you need to adjust the card guide. 2. Learn the basic use25 Page 26 Memea and Tay32Load Prine in the Vaylpoglio the paper with the side you want to print upwards and open the output tray. Open the tray. Make sure the machine is displayed in the list. See the Printer driver guide screen
(see "Use of the guide" on page 36). The size of the paper and the paper size settings have not occurred. The size of the card in the printer driver settings corresponds to the selection of the card in the settings of the application of the software used (see "Opening of the print preferences" Onpage 35) .5. Just select all the files you want to print and
click Clickopen.n in the GUI LPR window, select the machine from the list and Changethe Stamping Properties.3Click OK to start the print. Driver. This was useful (66) My ink cartridge has dried, what can I do? At the end of the installation, click Delete. After completing the wireless network connection, it is necessary to install the Amachine driver
for the printing from an application (see "Installation for Macintosh" on page 83). Setting the access point using the WPPfor models that have a WPS button, you can set the wireless network using the button (without a USB connection) and an access point (or a router) WPSBTTON.12345678Turn on the computer, the access point and the
machine.9Click the wireless network setting button on the user options of the user options. Software provided in your CD-ROM CD-ROM The CD-ROM icon that appears on your Macintosh desktop. Double-Click The Mac _installer folder> Install OS X icon.Click Continue. Read the license agreement and click Continue. Agrees to accept the license
agreement. When the message warns that it warns that it warns that there it warns all the applications will close on Yourcomputer, click Continue. Page 12 Index210IndexLinux 97Macintosh 96UNIX 98Windows 93installing environment 67introducing network programs 89IPv6 configuration 101SetIP program 90, 91, 92, 129wireless network setup
104N-up printingMacintosh 1510overlay printingcreate 146delete 147print 147Pplacing a machineadjusting the altitude 138PostScript drivertroubleshooting 192printmobile OS 136mobileprint 136print mediacard stock 32envelope 29labels 31output support 61preprinted Paper 32 Special Media 28 Prints Resolution Setlinux 153Printer
PreferenceSlinux 154 Printer Information on the General Status 167, 169printing 34printing Changing The predefined printing settings 139Linux 153maccintosh 151mult pages on a sheet of papermacintosh 151printing documping 34printing of 152pring 152. 151Unix 155Problemspaper Problemi di alimentazione 175 Problemi di potenza 176
ProprietA di stampa 177 ProprietA Problemi di qualitA 181Rrear View 17 regulatiory information 68Ssafetyinformation 10symbols 10service contact numbers 193 Page 13 Index211IndexSetIP program 90, 129special print features 137specifications 59print media 61stop button 19suppliesavailable supplies 39estimated toner cartridge life
42ordering 39Replacing Toner Cartridge 44Syncthru Web Servicegeneral Information 161ttoner Cartridgeestimated Life 42Handling Instructions 42non-Samsung and Refilled 42redistribut Toner 43Replacing the cartridge 44STORING 41trayadjusting The width and length 25 changing the trap the tray 25 Loading of the paper in food
manual/multipurpose tray 28uringshanding the status LED 55unixdriver installation for network connected 98printing 155unixsystem requirements 66usb cableden installation 83, 85driver reinstillation 84, 87using Help 36, 152wwamarked. Connected cable21, 22 requirements of the 64using Setip 90, 129wirelessad mode hoc 104infrastructure mode
104usb cable 111, 115, 124WSDSDISSCONNEG 108pBC mode 108WPS (the machine does not have a display screen) For Macintosh84Instillation for Linux85reinstillation for Linux87using Memory/Hard Drive Features150maccintosh Printing151linux Printing153unix Printing1554. Use only paper that meets the specifics requested by the machine. A
¢ There may be debris inside the machine. SMTP is a relatively simple and text based protocol, in which more recipients of a message are specified, so the text of the message is transmitted. He defines the wiring and reporting for the physical layer and formats and frame protocols for the level of access control (Mac)/Mac)/Mac) of the OSI model. This
accumulation can cause print quality problems, such as coverage or smudging tones. Useful management of the chapter introduces management tools provided to help you fully exploit your machine. A ¢ Samsung Anyweb Print158 & A A AEY ECO DRIVER159 & ¢ avelop of syncthru & € Za ¢ Web Servicel614a ¢ avelop of Samsung Easy Printer164 & \
Panel169a ¢ avelop of Linux Unified Driver Configurator171 Page 158Samsung Anyweb printed only for Windows and Macintosh OS users. This tool helps you capture, preview, waste and printing pages more easily compared to when yes An ordinary program. To open the program: & ¢ avelop for Windows: Select Start> All Programs> Samsung
printers> Samsung Anyweb Print> Download the latest version. For Macintosh: open the Applications folder> Samsung folder> Samsung Anyweb Endeweb print .4. Useful management tools158 Page 159Sy Eco Driver with the Eco -eco driver, it is possible to apply echo functionality to save the paper and print first. The purpose of which it is to keep
the machine in better working conditions. Upload the paper of only one type, size and weight. The paper does not feed in the car. A avelop to remove any obstacles from inside the machine. The card was not loaded correctly. Ina corporate intranet, it may be necessary for this information to be assigned bya Network Manager before proceeding.
34Select applies, then ok and ok again. Still new information from the machine in the configuration window. Then, the text box of the address/prefix is activated. 2. Using a machine connected to Rete102 Page 103ipv6 Configuration7Anter the rest of the address (e.g. 3ffe: 10: 88: 194 :: AAAA. Check the network name (SSID) on your access point and
Tryconnecting Again. It is not on. If the configuration of the computer network is set on DHCP, the wireless network setting should also be read. The cleaning of the interior of the machine is deleted and reduces these problems. Fabric. Appendix72 Page 73 Regulatory Information15Turkey only if yes Cut the printed plug, get rid of it immediately. You
cannot fill the plug and you may receive an electric shock if you do it in an outlet. Important warning: 16 stored at the mounted plug (for the United Kingdom (for the United Kingdom (for the United Kingdom only ) you have to earth this machine. The threads in the network cable have the following color code: & ¢ avelop green and yellow:
earthimportant 4,— ce a ¢ blue: neutral long For this machine it is equipped with a standard (BS 1363) Plugand 13 AMP has a 13 fuse amp. It was included in the original in the original (1984) and are not deprecated by Apple in favor of TCP/IP Networking.bit Deferel Computer Graphics term that describe the number of bits used to represent the color
of a single pixel in a bitmapped image. On IBM Aix with type of jetndirect tail, the name DNS-Numeric IP is not allowed. The type of control shows the connection such as LPD or Jetdirect in the responding summary box. The selected PDF file is sent to the machine. 3. Special features149 Page 150 Use of Memory Memory/Driver Strict Work Timeout
detained: the machine can automatically eliminate a job stored after a certain period of time. Appendice67 Page 68 Regulation information This machine is designed for a normal work environment and regulatory declarations with Severi. When using this product, these basic safety precautions should always be followed to reduce the risk of fire,
people's electric shock: blaser security safety in the United States to conform to the requirements of DHHS 21cfr, chapter 1 subcapitolo J for products Class I (1) laser, and elsewhere have been in accordance with the requirements of IEC 608251: 2007 as a class laser laser products, class laser products are not considered dangerous. Those devices
allow the Pay-For-For-Stample Service on the machine. A duplicate emulator The functions of a system with a different system, only the second system behaves as the first system. You may not be able to connect to Thenetwork in the infrastructure environment in which Auser's information must be typed before connecting to the access point (or
wireless router). A ¢ This machine only supports IEEE 802.11 b/g/n and Wi- fi. Other types of wireless communication (e.g. bluetooth) are not supported. Remove large metal objects between the access point (or wirelessrouter) and the machine. sure The machine and the wireless access point (or wireless router) are not separated from poles, walls or
walls or support columns containing metal or o o The machine is located far from other electronic devices that can be interfere with the wireless signal. Many devices can interfere with the wireless signal, including a microwaveven and some Bluetooth devices. Must perform the setting of the product wireless network again. 2. Using a machine
connected to Rete135 Page 136Samsung MobilePrint2224 What is Samsung MobilePrint? Samsung MobilePrint is a free application that allows users to print photos, documents and web pages directly from your smartphone or tablet. SamsunmobilePrint is not only compatible with Android, Windows and iOS smartphones, but also with your iPod
touch and tablet PC. Production processes can cause the refusal of some areas. He enables the Duplex functionality, adds start -up and endbanners bands and modifies the number of pages for sheet. 13 Printing from Duplex applications of application/manual applications may not be available depending on Onmodelli. Using a machine connected to
Retel27 Page 128wireless Network Setup14 Before that inserts the IP address for the machine, you need to know the information on the configuration of the ThecomPuter network. My ink cartridge is new, but not to print, why? Please leave a comment at the bottom of the page. Are you satisfied with this Samsung product? Remove the excess paper
from the tray. The echo works to save the print resources and bring you to the ecological print. For Eco printing, click: see "Easy Eco Driver" on page 159.2. Learn the basic use36 Page 373. The maximum ability can differ according to the weight of the media, thickness and environmental conditions. Feed a sheet in one time. The smoothness of the
labels used in this machine is 100 to 250 (Sheffield). When set this option, the Machinestatus (deficiency of toner cartridges or error machine) automatically sent to the email of a CertaPerson. Certoperson. To connect various network environments. The Setipthis Utility program allows you to select a network and configuration interface manually the
IP addresses to be used with the TCP/IP protocol. A ¢ avelop "IPV4 configuration using SETIP (Windows)" on page 90.a ¢ avelop "IPV4 configuration using Setip (Macintosh)" on page 91. & ¢ avelop see "IPV4 configuration via STIP (Linux)" on page 92. & ¢ avelop the machine that does not support the network interface, it will not be able to use this
function (see "rear view" on page 17). A ¢ 4,— & ¢ TCP/IPV6 is not supported by this program. Use of a machine connected to Rete89 Page 90 Safe Setupyou must set the network protocols on your computer to use it on Younetwork. "It is possible to use the network after connecting the network cable to a door corresponding to your network
configuration machine, the user can find the macaddresses and the IP address of the machine. For example: for the models they do not have The display screen on the control panel, use TheSyncthrua ¢ a € Za ¢ Web service or Setip program "on page 161.-See" IP setting address "on page 90." for the models that have the screen on the panel control,
configure the setting of TheWetwork by pressing (Menu) button> Network on Controlpanel.4 Stamping A Configuration Report The machine without the button (WPS) (Cancel or Stop/Cancel): Press Thebutton Formore of ten seconds on the panel of control. & ¢ avelop Mac address: 00: 15: 99: 41: A2: 78 4, A A A ¢ IP: 165.254.192.1925 ESTATING IPa
¢ & establish the machine that does not support L network interface, they will not be able to use this function ( Seeing "rear view" on page 17) a ¢ avelop TCP/IPV6 is not supported by this program. It is possible to print the network configuration ratio from the control panel of the show the current machine network settings. The machine and the
number of Tonercartridge shown in the above window can differentiate on the machine in use. The installation of the software This chapter provides provides For the installation of essential and useful software for use in an environment where Themachine is connected via a cable. A highly high color depth of a large amplitude of colors. If you increase
the size of the photo in the application of the software, the thesis will be reduced. 5. Problem resolution179 Page 180 Propting ProblemsconditionPostible causes of solutions before printing, the theme emits steam near the output tray. The use of wet paper can cause steam during printing. This is not a problem. They generally find themselves in front
of the car. The value or setting that is in force when taking a printer from the state, reset or initialized. Glossary198 Page 199 Glossarydhcpdpia Dynamic Host Configuration Protocol (DHCP) is a networkingprotocol. Today Neware supports TCP/IP and IPX/SPX.opcogganic Photo conductor (OPC) is a mechanism that creates a virtual image for
printing using a laser radius emitted by a laser printer and is usually green and rusty shape of the cylinderIf you want to print the fear screen, release the button while you are flashing. (Potenza) is avelop the print screen can only be used in Windows and Maccintosh Operating Systems. ) A avelop it is possible to use this function only if the machine
EasyPrinter Manager program is installed if you are a user of amacintosh OS, it is necessary to enable the prints shielded by Easy Printer Manager to use the function Screen. "Configuration sheet - Press and hold this button for about 10 seconds until the Green LED flashes slowly and the release. Avelop the Report of information on the supplies /
Report of error - press and keep This button is present for about 15 seconds until it was LED acc. Release.ad ¢ avelop manual print- Press this button every time you load a sheet of paper in thetray if you have selected the manual power supply for the origin in the driver of your print. 1. Introduction19 Page 20 turn on the machinelConnect the machine
on the electricity supply before.212 Press (power) on the control panel. If you want to turn off the energy, press (power) on the control panel.l. Introduction20 Page 21 Install the driver The locally linked machine locally is a machine connected directly to the computer that uses the cable. Let us know what you think of the Samsung ML-2165W printer
leaving a product evaluation. Call a certified technician when Themachine needs to repair. Introduction13 Page 14 Security information - Do not remove any coverage or guards that are fixed with screws. Do not burn any of the supplies such as the toner cartridge or the fuseum. "The unit of the steer. A shared, or password key, is configured at the
wireless access point (WAP) and in any wireless laptop or desktop devices. Select the Overlay file you want to use. If the OverLay file was stored that you want to use in an external source, you can also load the file when you access the open window. After selecting the file, click Open. Page 9about of the user of this user provides information for your
understanding of Base of the themes and detailed passages to explain the use of the machine. & A A € The safety information before using the machine. The terms used in this user are explained in the glossary chapter. All illustrations in this user can differ from the machine according to its options or model you have purchased. of this user can differ
from your machineDinging on the version of the machine firmware/driver. machine. Users information to protect the machine from mechanical damage or malfunction. Notes of additional information or detailed specifications of the function and functionality of the machine.1 Content in this guide are used in an interchangeable way, as follows: it is
avelop the document is synonymous with original. Synonym for media support or multimedia. The car refers to the printer or to the MFP.1. Introduction9 Page 10 Safety Information, warnings and precautions are included to prevent injuries to you and thethers and to prevent potential damage to the machine. Problem resolution57 Page 585. Just



keep printing. The machine does not print special size paper, such as the billing card. Pagine size and paper setting do not correspond. Set the size of the correct paper in the custom card in print in print preferences (see "opening printing preferences" on page 35). The curled printed billing card. The type of paper setting does not correspond.
Change the printer option and try again. The Maintenancethis chapter provides information on supplies for purchase, accessories and maintenance parts available for your machine. A ¢ avelop ordination and accessories 38 & € 4 € available surfaces39 & 4,— 4 A A & ¢ Maintenance parts 40 4a & ¢ exterminates the cartridge of toner41 & ¢ avelop "the
cleaning of the Machine46 suggestions a ¢ avelop for the movement and storage of your 38ordining machine of acceptable supplies and accessories can differ from country to country. Refer to the User's Guide of the Access Point (or Wireless router) that is using. A ¢ When using the WPS button to set the wireless network, the modification of the
safety settings. The reflected ray, although invisible, can damage the eyes. The safety of the ozone this of the product emission is less than 0.1 ppm. If you show static, click Change TCP/IP to change the DHCP analysis method. avelop for the static method when the window that tells you that the connection of the network cable appears. net. cable and
click Next. The wireless network setting is completed. Do you want to share your experiences with this product or ask a question? Alternatively, you can use the LPR printing system or other odd print applications alternately. Hatterine Carattie, dual -line attention) a ¢ avelop the margins: set the margins for the document. Click
Continuinstillation.Click Add to the list of printers. With a sticker on the printing head, preventing them from drying inside the package. Click Next. Point access via the WPS button (without a USB cableconnection) for models that have a WPS button, you can set the wireless network Using the Thewps button (without a USB connection) and an access
point (or a router) Wpsbutton.items to prepare1314155click then when the window confirmation of the printer is displayed. The 16 -year installation is finished, a window that a window that He asks to print a PageApprears test. If you have lost the fuse lid, do not use the plug until you have another lid of the fuse. Contact the people you buy the
machine. I used in the United Kingdom and should be suitable. However, some buildings (mainly old ones) do not have normal 13 amp plugsockets. The duration of the estimated toner cartridge is close. The use of a Machinethis chapter connected to the network provides step-by-step instructions for configuring a machine and a software connected to
the network. Useful installations of Network 8 4,— a4 ¢ 4, A AA A 4 ¢ CABLATE NETWORK is &, &4 4 A A 4 ce Driver installation on the Network 93 driver & ¢ avelop IPV6 Configuration101 is 41 & & wireless Network Setup104A ¢ avelop and supported optional functionalities can differ according to your model (see "Functional bymodel" on page 6). Page
5Key functionality and support for applications- using the USB cable or a network cable is possible And set various wireless network settings using a USBCABLE or network cable. A ¢ Using direct Wi-Fi: it is possible to print comfortably from your mobile device using the Wi-Fi or WiFi Direct on page 61). 4, A A A AUSTRARK: you can customize your
documents with words, such as "Confidential" (see "using advanced printing function" on page 141). "Print the posters: the text and images of each page of the document have been processed and printed on more paper sheets and can therefore be bets together to form a poster (see" Use of advanced printing functionalities "Onpage 141)." It is
possible to print in various operators systems (see "system requirements" onpage 64). A ¢ The machine is equipped with a USB interface. Supports various methods of setting the wireless network avelop using the WPS button (Wi-Fi Protected Setupa ¢ & € Za ¢)- You can easily connect to a wireless network that uses the WPS button on Themachine
and the point Access (a wireless router? can you configure yourself a network button or remember the diditework key generated randomly by default.-User user, consult "access point via USB cable" on page 111.-MacCintosh User, see "Access point via USB cable" on page 120. a ¢ avelop after completing the installation of the driver, you can set
Samsung Easy Printing Manager and the changes in direct Wi-Fi. Select Network> Wireless> Wi-Fi directed by the control panel and only Macintosh users Os. Direct on/off: select to enable. Name Device: Enter the name of the printer for the search for your typographic a wireless network. Click the work to cancel the Selectedjob check box and
select the completed work control box to view the precedents in the list of work. A ¢ avelop classes: shows the class in which the machine is located. (NetworkConfiguration)> Sate.a ¢ avelop to have the display screen: press the button (Cancel Orstop/Clear) for more than five seconds on the control panel. Before assigned by a DHCP (Dynamic Host
Configuration Protocol) server located on the Network.IPV4 configuration using Setip (Windows) before using the Setip program, disable the computer firewall from Controlpanel> Safety center> Firewall Windows.2. Using a machine connected to network90 Page 91 wired setuplinstall this program from the CD-ROM supplied by dual application>
Setip> setup.exe.2345follo the instructions in the installation window. 6Click Theicon (third from the left) in the Setip window to open the TCP window /IPConfiguration.7Anter the new information of the machine in the Asfollas configuration window. At the end of the installation, clickquit.Aplo by completing the wireless network connection, you need
to install the Amachine driver for the printing from an application (see "Setting up using Macintosh" Onpage 120) .Ad hoc via USB cable you don't have a point Access (ap; wireless network interface a a ¢ USB cablecreating the ad hoc network in macintosh1234567check if the USB cable is connected to the machine. Turn on your computer and on the
wireless network The software cd supplied in your CD-ROM.Double-Click drive The CD-ROM icon that appears on your Macintosh desktop. Double-seguite-Click The Mac_installer folder> Installation icon OS X.Click continues. Read the license contract and click Continue. 2. Use of a machine connected to Retel126 Page 127 Wireless Network
Setup891011click agrees to accept the license agreement. Authentication: select a type of authentication. Opening system: authentication is not used and encryption can be used, depending on the need of Sicuric key data.shared: authentication is used. Appendice76 Page 77 Regulatory information20CHINA ONLOS5. 30,000 pages alfeed rollerappross.
The OSI offers a standard and modular approach to the design of the network that divides the required set of complex functions into manageable, autonomous and functional layers. Learn the basic use27 page 28Media and trayAAAA&4A a4 A aAa&AaAA It does not make feedper from the manual power supply. All the components necessary for the
machine operations will be installed.19enter the name of the tail in the tail input field. Intraneta Private Network that uses Internet protocols, network connectivity and possibly the public telecommunication system to securely share part of the information or operations of an organization with its employees. The file format, as is used in
Microsoftexcel, has become a de facto standard throughout the sector, even among the nonon-Microsoft.collaredadfccolation platforms is a printing process of a more copies in sets. If it shows DHCP, TCP/IP clickchal to enter the IP address and other configuration values network for the car. For example, if the information on the computer network is
as shown as: -ip address: 169.254.133.42 when the wireless network settings are completed, disconnect the USBCABLE between between computer and machine. Instead of using the headed paper, it is possible to create an overlay -Constation exactly the same information that is currently on your headed paper. This is available upright for Windows
OS users. If you have access to the Internet, you can get help, support application, machinedrivers, manuals and order information from the samsung web website, www.samsung.com> Find your product> Support or download. A ¢ avelop it is possible to print with a resolution up to 1,200 x 1,200 dpi Excade Output. 21 PPM (letter). The printing
machine first each other page of the document. This option is available only when using the PCL / XPS printer driver (see "Features for models" on page 6). None .4 ¢ avelop Short Edge: this option is the conventional layout used in calendars. Reinstall the car driver and change the times to connect to the machine on the net. For example, if you save a
PDF on a Mac, you appear in the same way in Windows, Android and iOS. All information included in this document is subject to changes without notice. Samsung Electronics is not responsible for any direct or indirect damage, deriving from or relating to the use of this user. Co., Ltd.d ¢ avelop Microsoft, Windows, Windows Vista, Windows 7 and
Windows Server 2008 R2 are registered trademarks or Microsoft Corporation trademarks. A ¢ avelop Truetype, Laserwriter and Macintosh are brands of Apple Computer, Inc. & ¢ avelop all other names of brands or products are brands of their respective companies or organizations. Refer to the "Licenza.txt" file in the CD-ROM provided for
information on the open source license.rev. Using a connected network Page 135 Setting the wireless network & A A 4 4 ¢ control if the Firewall software (V3 or Norton) is blocking communication. Avelop if the computer and the machine are connected on the same network and there are ITCannot during research, the firewall software could block
communication. Be careful when you remove the card from the car. a € before opening the upper lid, close the output support first. 4. Problem resolution53 Page 54 Clearing Paper Jamsif you do not see the card in this area, stop and go to the next step: 4. Subsequently, a message is displayed on your computer. The function of empty jump pages does
not work when the duplex option is selected. A ¢ 4,— & ¢ It is recommended not to print on both sides of the special supports, such as labels, envelopes or thick paper. This is the weight of the paper at one square meter. /Install "to reinstall the tracks. By setting the printer Add the printer to the UNIX system, execute" InstallPternter "from the
command line. To find the position more close to the rear background, go to our website: www.samsung.com/recyclingirect or Call, (877) 278 - 079111radio Frequency EmissionsFCC Information to the device in user this complies with part 15 of the FCC rules. Convention Protocola or standard that controls or enables the connection, communication
and transfer of data between two calculation endpoints. , usually it is entrusted through the radiusremote authentication framework in the user service (Radius) is 4 € <a € oe a protocol for the authentication and accounting of the remote user. This information was set when the Access point (or wireless router). Most verified printers are not able to
print without edge, because the printer needs a place to keep paper. All wireless devices in a WLAN use the same SSID for between them. Automatically detects and corrects errors errors The process of transmission of the fax which is sometimes caused by the noise of the telephone line. Emulation is a technique as one machine that gets the same
results as another. A duplicate emulator the functions of a system with a different system, so that the second system behaves as the first system. This makes the ADD printer guided procedure window appear. It can archive incorporated characters so as not to have the appropriate characters installed to correctly view the document. Problem
resolution181 Page 182 Propting Problems Problemsconditoners Speckssugested Solutions - The document may not satisfy the specifications; For example, the card can be too humid or rough. A ¢ The transfer roller could be dirty. To use this application, start Easy Eco Driver before the Printingjob Control box in the printer's owners. Open the upper
lid and remove any debris. It develops inclined or cannot feed correctly. Respect that the paper guides are against both sides of the envelopes. Problem resolution175 Page 176power and connection cable connection Conditions of the machine The machine The machine does not receive power, or the connection cable between the tocomfect and the
machine is not connected correctly. A dvelop Connect the machine first to the electric machine and press the (power supply) button on the control panel. A ¢ avelop disconnect the machine cable and reconnect it. 5. Problem resolution176 Page 177 PROPERTITY PROBLEM CONDITIONS The machine does not print. Causeable solutions for the causes
of the machine does not receive nutrition. Check the power cable connections. The window can differ in its safety modality: WEP or WPA. A ¢ avelop Operational modalities: select the infrastructure. A ¢ Wepselect System Open or shared key authentication and enter the TheWep safety key. Download the latest version of AFPL Ghostscript from and
install it to solve this Open the error file of the device brings avelop when printing a document. Avoid modification of the printing parameters (E.Q., via LPR Gui) while a printing work is underway. If you are printing on special materials, feedarly in the tray. A type of incorrect paper is used. Consult the manufacturer's restoration kit or the technical
support of the accounting manufacturer for more information. This transmitter must not be placed or functioning in combination with any other antenna or transmitter. Some circumstances require restrictions on wireless devices. If it has a password, consult the administrator of the access point (or wirelessrouter). A ¢ 4, - A A A CONSTITE THE
Machine IP address. Go to print preferences, click on the Paper tab and set the type on thin (see "opening of printing preferences" on page 35). Avelop an unknown image machine is probably used at an altitude of 1,000 m (3,281 feet) or higher. It appears so that some altitude can affect the quality of the print, such as melted toner or bright imaging.
OSI offers an Astandard and modular approach to network design that divides the functions of complex required in manageable, autonomous and functional layers. Samsung cannot guarantee the quality of the non -genuinesamsung toner cartridge. IEEE 802.11 (Alsoknown as Wireless Ethernet) and Bluetooth communication devices are flagships of
devices that provide wireless communications. In environments where the risk of interference towards other Orservices devices is harmful or perceived as ardent, the option of using a wireless device can be limited or eliminated. Ask for help and always use the appropriate name of people to leave the device safety. Then lift the machine: 6 installation
/ ware movement - if the It weighs less than 20 kg (44.09 pounds), raises with 1 person. Avelop 20 kg (44.09 pounds) - 40 kg (88.18 pounds), lifting with 2 people. A ¢ avelop if the machine weighs more than 40 kg (88.18 pounds), raises with 4 people. people. injury or damage to the machine. Do not place the machine on an unstable surface. Do not
place the car in an area with dust, humidity or water mix. Cié could cause electric shocks or fires. The machine could fall, causing injuries or damage to the machine. Use only n. 26 AWGA or larger, cable of the telephone line, if necessary. Otherwise, it can cause damage to the machine. Introduction12 Page 13 Security 7 Use the power cable supplied
with the Safeoperation machine. Using a twain compliant scanner with a twain compliant program, a scan can be started within the program. The card could be loaded incorrectly. It is possible to download the Unix printer driverpackage from the Samsung web website (www.samsung.com> Find your product> Support or download) .6 ". To install or
uninstall Package Driver.usa & ¢ avelop "Chmod 755 Install to give authorization to the Theinstaller script. Installation of the UNIX Packagethe printer installation The installation procedure is common for all the variants of the system Operational Unix mentioned. Package to your computer. 2 Acquire Root Privateges.a ¢ &,— & "on -3copia the archive
of the appropriate driver to the UNIX target.Run computer the installation script . You can download Smartpanel from the Samsung web website (see "Installation of the Smart Panel" on page 85) .toner Levelyou you can view the remaining level of toner in each tonercartridge. It was developed by Adobe 1992 and has since become one of the formats
more used for s Alvare and exchange documents. Change the setting of the altitude for the machine (Sesheets "Altitude adjustment" on page 138). A,— 4 A A A ¢ Low printing or contaminationcurs5 toner. The actual performance of the printing varies according to the printing of the pages on which to print, operate in Virriano, percentage of image
area, printing interval, type of medium and size/smell. If it is so, so, It is not applicable to the machine. 6 from the installation of optional memory, it is possible to use advanced printing functionalities, such as proof of a job and the specification of the printing of a private job in the printing that installs the hard drive, it is also You can print the
predefined documents from the module menu.Window. They could scratch the cartridge drum. If the toner puts on clothes, clean it with a dry cloth and wash the clothing in cold water. The normal operation of the machines should be restored. Ethernet is for the most standardized as IEEE 802.3. The most widespread LAN technology in use in the 90s
to today was become. Suite of Ethertalkka protocols developed by Apple Computer for computer networking. The LPR Cup utility allows you to do it, but the driver package replaces the standard LPR tool with a much more intuitive gui lpr program.1 if necessary, move on to the configuration of the printers.23 ¢ avelop connection: allows you to view
or select another port. Itmeans that the functionalities are not supported. You can use advanced printing functionality when using the machine. 8 Printing a document when printing with a macintosh, you need to check the printer driver settings in each application used. In this case, it is not applicable to the machine before starting, you will have to
know the name of the network (SSID) of your wireless network and the network key if it is encrypted. This relationship can be set to how to print after each job or only after the transmissions unable. The image file format (TIFF) is a format of bit images mapped to variable resolution. SSID ISCASE Sensitive. Start a web browser such as Internet
Explorer, Safari or Firefox and Entery Machine New IP address in the browser window. For example, 34selection a network name (SSID) in the list. A dvelop modalities The operational modality refers to the type of wirelessConnections (see "Name of the wireless network and network key" on page 104). Click on the upper right access of the Del Web
Service Website website: allows wireless devices to communicate directly with the other in a peer-to-peer.type environment in the ID and on the password, then click on Login.A ¢ avelop: amins avelop password: SEC000005 When you open the SYNCTHRU web service window A € Z4 ¢, click Networkksettings.6Click Wireless> Wizard.If the
operational mode of yours Network is an infrastructure, select the Theaccess Point SSID. If you want to print a test page, click a trial page. If you want to record the machine with the Samusng website and useful information, click on the online registration. If you are not a super user, ask your system administrator. 1. Installation of the Software86
Page 87 Reinstallation for Linuxif The printer driver does not work properly, uninstall the driver and reinstall it. Administrator, the type & ¢ 4,— & “root A— in the field and enter the system password. You have to access as super user (root) to uninstall the printer driver. A ¢ 4,— & "to the exexadecimal from 0 to 9, from to f) .89Coose the DHCPV6
configuration. Use Syncthrua ¢ & € 74 73 ¢ Service Web1Start a web browser, such as Internet Explorer, which supports IPV6Address as URL.2Select one of the IPV6 addresses (link-lock address, Statelessaddress, Stateful address, manual) from the NEWECONFIGIRATION relationship (see "Print" A network configuration report "Onpage 90) .3Anter
the IPV6 addresses (e.g.,: http: // [fe80 :: 215: 99ff: fe66: 7701]). The address must be enclosed in brackets' []". Use of a machine connected to Network103 Page 104Wireless Network Setup "Make sure yours Supports wireless networking. 1.15. If you want to print a test page, click Print a Test page. Select the components to be installed. Go to
PrintingPreferences, click on the Basic State button> Printer. These icons are displayed in the Windows activity bar: the Toner Levelyou can view the level of toner remaining in the cartridge of eachtoner. The message is displayed in the preview window. (Creation of a filigree) filigree (modification of a filigree) filigree (elimination of a filigree) ATO
modify the printing settings from the software application, access preferences. -Down list. If the defects occur on the back of the page, the problem is probably correct after a few pages. A ¢ The melting assembly could be damaged. Click Next. Otherwise, click Next and go to the passage 16.-IP Address: 169.254.133.43-Subnet Mask: 255.255.0.0 (use
the sottorete of the computer sottorete.)-Gateway: 169.254.133.115 the prints of the test page of the correct test print prints, click on it. If not, click NO to reprint it. 2. Using a machine connected to Retel119 Page 120Wireless Network Setup16 if you want to record the machine with the Samusng website and useful information, click online. It is
possible to delete the overlaps of the page that you don't use more. Special features147 Page 148 Use of advanced printing features Emedescripion & A 4 A 4 A € is available only if the optional memory or mass storage device (HDD) has been installed. Some menus may not appear on the display depending on the options or models. Any guarantees
about this information are decleased. Page 51Tips to avoid paper jamsby by selecting the correct types of media, it is possible to avoid the largest of paper jams. This flexible and independent format from the platform can be used for images made by various images processing application. Mask of Cartutsubnet of tonalitate the sottorete mask is used
in combination with the network address to determine which part of the address is there Address and which part is the homaddress. A type of bottle or container used in a machine like a printer it contains. It is possible to set the time when the car await before being the stored job. "Image overwriter: the overcoat image is a safety measure for
customers who are worried about unauthorized access and the duplication of the orprivated document classified. Some menus may not appear on the display depending on the display depending on the display a Second of the display depending on the display depending on the display depending on the display depending on the display depending on
the display depending on the display depending on the display depending on the Ormodelli options. A laser printer applies the toner (black or colorful powder) on the Card. This address is generally coded in a network interface form (NIC) by its manufacturer and used as a help for routers that try to identify large nets on large networks. MFPMulti
peripheral function (MFP) is a machine For office that includes the following functionality in a physical body, in order to have a printer, a photocopier, a fax, a scanner, etc. modified Mhuffm An (MH) is a compression method to reduce the quantity of data that must be transmitted between the machines for the transfer of the image recommended by
ITU-T T.4. MH is a running coding scheme based on optimized booklets to efficiently compress the white space. A certain quantity of toner can remain in the cartridge even when the red LED is on and the printing of printers. Only wireless model (see "characteristics for models" on page 6) .4. It is possible to print on the machine from any application
of this.123 & ¢ avelop text: specifies the page margins and set the text options, this asspass or columns. Used when printing files, Color options, image size or location of the image. Select the print directly using LPR. Advanced: Set the printing resolution, the paper origin and the destination. In the GUI LPR window, select the name of the model of the
machine from the printing list and click on the own owners. Click OK in the GUI LPR window to start starting The print window appears, which allows you to monitor the status of your work. To stop current work, click Cancel. 3. Special features153 Page 154Linux Printing14 Printing FileSyou can print many different types of files on the machine
using Standardcups, directly from the control line interface. This uses a shared secret key (generally called passing phrase of the predivisated key), which is manually configured on the access point and each of its customers. Cryptography: select encryption (none, WEP64, WEP128, TKIP, AES, TKIP AES). A ¢ avelop key key: enter the value of the
encryption network key. A ¢ Wpaenter the WPA shared key and click Next.Wpa authorizes and identifies users based on a secret key that changes regularly at regular intervals. A device appears that has an adequate Keycan Wep access to the network. When the message is warned that all applications will close on Yourcomputer, click Continue. Click
the wireless network setting button on the user options box. &,— & mbers key key: enter the value of the encryption network key. Software searches for wireless network devices. Confirm the network key: confirms the value of the encryption network key. avelop WEP key index: if you are using WEP encryption, select the appropriateowep key index. If
the search has not succeeded, check if the USB cable is correctly connected between the tocomputer and the machine and follow the instructions in the window. 12 The wireless network safety window is displayed when ad hoc safety appears. Setting. Select the open system or a shared key for And click Next. After the search for wireless networks, a
list of wireless networks that the machine has searched appears. Rotocol by preventing authorized access to your wireless network. To print from a direct Wi-Fi mobile device, set the Wi-Fi Direct option (see "WiFi Direct setting" on page 131). If the IP address IP The method is static, check if it is shown static in the window. The name of the car,
which appears in the window ownership of the printer, can differ according to the theme in use. If you cannot find a solution to your problem in this chapter, consult the chapter of resolution of the CEO in the driving of the advanced user (see "Problem resolution" on page 174). If you cannot find a solution in the user's guide or the problem, call for
the service. If you change the door of the USB machine to parallel or vice versa while it is in use, Timust reconfigures the car door in this card. When you digit only LPR and press send, the selected files are displayed first on Printwindow. If its state contains interrupted, press the Start button. /Install the Canda Canda Canda. To reinstall it, use the
command ". It is very popular, as it is a computer or a network that allows access to another computer or network. The Institute of Electrical and Electronics Engineers (IEEE) is an organization Professional of Internationalnon, for the progress of technology related to the electricity. Graiscalee 1284a fussies of gray representing portions of light and
darkness of an image when the dyes are converted into gray scale; the colors are represented by various tonalities of Gray. The standard of parallel door 1284 was developed by the Institute of Electrical and Electronics Engineers (IEEE). It is an API of the acquisition of images for operating systems Microsoft Windows and Apple Macintosh. The bootp
servers assign the IP address from A pool of addresses to each client. Introduction22 Page 232. SSIDs are sensitive to chance and have a maximum length of 32 characters. Transmission confirmation ratio (TCR) provides the details of Each transmission as a state of work, result of the transmission and number of pages sent. turn on your computer and
themechine. Printingapplication (for example: Samsung mobile printer) to be printed from Yoursmartphone. Delete the paper jam (see "Cancellation of the paper" on page 52). "The card is not loaded. For example, it could be in a state of low toner, which can lead to the empty state of the toner. The error machine has at least one error. Windows. A€
The Samsung printer status window and its content shown in this user dvelop can differ depending on the machine or operating system in use. A & establish the compatible operating systems With the car (see "System requirements" on page 64) .Descrition7samsung printer status of a error view during the error while an error occurs while an error
occurs while an error occurs while an error occurs while an error is Check operating, it is possible to check the error from the Samsungprinter state. The name of the option can differ according to the access point (or wireless router) that is using. Using the (WPS) button on the control panel. The method P BC configuration of the (PBC) button allows
you to connect your machine to a wireless network by pressing both button (WPS) on the machine control panel and the WPS button (PBC) on a Wi-Fi Protectedsetupa ¢ & € Z4a ¢ Access point enabled for WPS (or wireless routers) respectively. The personal identification number method (PIN) a wireless network by entering the PIN information
provided on a protected WiFi configuration & € Za ¢ access point enabled for WPS (or wireless router). The default value in the machine is PBC, which is recommended for the atypical wireless network environment. Modalities in the control panel (wireless> ok> WPS setting). (Menu)> Network> Elements to prepare & € check if Access point (or
wireless router) Supports Wi-Fi ProtectecTectsetupa ¢ 4 € Z 4 A A (WPS). A avelop your machine supports the protected configuration Wi-Fea ¢ & € Za ¢ (WPS). A ¢ 4,—~ & mbers Only on the Net (Pin modality) 2. Page 89 Network Programs used there are several programs available to easily set the network settings in Anetwork Anetwork The following
information will guide you how to set the machine for the best print quality. Before setting the value of the altitude, determine the altitude in which you are 4,000 m (13.123 feet) 13,000 m (9,842 feet) 22,000 m (6,561 feet) 31,000 m (3,280 feet) 401234High 3high 2han 1normald ¢ avelop ¢ For Windows and Macintosh users, see "device settings" on
page 165.a ¢ avelop for Linux users, see "Use of Smart Panel" on page 169. & ¢ avelop connected To the network, you can set the altitude of Viasyncthrua ¢ a4 € & € Za ¢ Web service. Special features138 Page 139Changing The predefined print settings12Click The Windows Start menu. For Windows Server 2000, select Settings> Printers. If you want
to change the settings for each printing work, change it in PrintingPreferencies Control Panel> Hardware and Sound> Printers. dvelop for Windows 7, select Control Panel> Devices and printers. avelop for Windows Server 2008 R2, select Panel Control Control> Hardware> Devices and printers. 34 Clicking on the machine. For Windows XP/Server
2003/Server 2008/Vista, select PrintingPreferences.per Windows 7 or Windows Server 2008 R2, from the context menu, Selectprint Preferences. selected. 56 changes the settings on each tab. Special features139 Page 140 mark the machine as a default machinel2click The Windows start menu. For Windows Server 2000, select Settings> Printers.
avelop for Windows XP/Server 2003, select the printer and fax. avelop for Windows Server 2008/Vista, Control panel> hardware and sound> printers. avelop for Windows Server 2008 R2, select Control Panel> Hardware> Devices and printers. 34 Set the machine your car and select Set as like Printer. For Windows 7 or Windows Server 2008 R2, if
set as a default printer does it have a? You can select other printer drivers connected to the selected printer. 3. Special features140 Page 141 Use of advanced printing characteristics Driver Print Printer: used to print the XPS file format. "On page 6.4 ¢ avelop XPS printer the driver can only be installed on Windows Vista OS Orhigher. A ¢ Install
optional memory when an xps work does not print because the print is out of memory. O for the models that provide XPS drivers from the samsung web, www.samsung.com> find your product or download or download. As a file.type in the destination path and the file name, then click OK. For example, C: \ Temp \ File Name.se is digitted only in the
file name, the file is automatically saved in MyDocuments, documents and settings or users. Only cartridges with witness can be decreased. g., 00-00-0c-34-11-4e). The modification to a wireless device cancels the authorization for use. This section also includes connections to Advancesettings applications. Advanced settings The panoramic user
interface The advanced user interface is intended to be used by the person responsible for the management of the network and machines. qualified. It is possible to configure various machine settings as a machine configuration, paper, layout, emulation, network and printing information. Useful management tools165 Page 166 Using Samsung Easy
Stamping Manager Settings (Windows only) This menu includes settings related to error error. A avelop printer notice: provides settings relating to when they come the notices. avelop email alert: povess options relating to reception warnings via e -mail. A ¢ avelop chronology notice: provides a chronology of notices related to the device and toner.job
toner.job QUESTION OF INFORMATION ON THE SPECIAL ACCOUNTING User's shares. This quota can be created and applied to devices by means of software business accounting such as syncthrua ¢ & € Za ¢ or countthua ¢ 4 € Z & mbers of administration software. 4. Useful management tools166 Page 167 using the state of the Samsung printer
The state of the Samsung printer is a program that monitors and informs you about the status of theme. Remove the toner cartridge and install a new one (see "Replace the toner cartridge" on page 44). If the white vertical page appear on the page: a ¢ avelop the surface of the LSU part inside the machine can be dirty. Below you can view and
download the PDF manual for free. By default, the name of the device is the modeling address If the optional memoryalandy has the same name when a new file name has been inserted, it can be overwritten or overwritten. Special features150 Page 151macintosh Printing9 Printer settings that work so that functionality may not be available according
to the models or options. SSIDs are sensitive to chance and have a maximum length of 32 characters. Subnet mask The sottorete mask is used together with the network address to determine which part of the address is the network address and what part is the host. TCP/IPTHE Transmission Control Protocol (TCP) and Internet Protocol is (IP); The set
of communication protocols that implement the stack of the protocol on which they perform the Internet and most of the commercial networks. Report of confirmation of TCRTRANSMISSION (TCR) provides the details of each transmission such as the state of the work, the result of the transmission and the number of pages sent. Try a print job that
you have already successfully marked. information is all saved in a standard format, so the document seems the same, regardless of the device or o It is used to open it. Some machines do not have this function. 422, it connects the machine to a Networt, the icon of the web service of Theesyncthrua ¢ 4 € Za ¢ is enabled. 3414. Samsung suggests users
to follow these tips to ensure optimal performance, maximum quality and long life from the new Samsung toner cartridge. Store of this cartridge in the same environment where the printer will be used. Enter the IP address of the machine () in the address field and press the Enter button or click Go.2S an administrator. Use only paper that meets the
specifics requested by the machine. The paper continues to incepose. A ¢ There is too much paper in the tray. Using a machine connected to Rete98 Page 99 Installing Driver on Network to use the UNIX printer driver, you must first install the UNIX printer driverpackage, then set the printer. Itmeans that the functionalities are not supported. a €
General: Change the size of the paper, the type of paper and the orientation of documents. It can cause a paper jam or damage the car. avelop predefinita of the printer: if you select this option, this function is determined by the selected settings on the topic control panel. This option can be used more frequently by an administrator of the machine.1 A
web browser, such as Internet Explorer, from Windows.Anter the IP address of the machine () in the address and prizes field Sending TAST or click Go.Network Security: Settings for HTTPS, IPSEC, IPV4/IPV6 filtering and 802.1x.23 Your incorporated website of the machine opens. Settings tab, select Machine Settings> E-mail notification. 4.
Management tools Page 163using Syncthrua ¢ 4 € Za ¢ Service Web if you have not configured the environment of the outgoing server, go to Settings> Network settings> Exit email To configure Avironment Network before setting the e-mail notification. Add button Add to add the e-mail notification user. Set the recipient's name and e-mail addresses
with the notification you want to receive a notice for.6click Apply.1start a web browser, such as Internet Explorer, from Windows.enter the IP address of the machine (http: // XXX. XXX.XXX.XXX) in the address field and press the ENTER button or click Go Go. .234 Your incorporated website of the machine opens. 5 click on Apply. From the security
card, select Safety System> System administrator system The name of the administrator, telephone number, position and emailddress. If the firewall is activated, the e-mail may not be e-mail to be successfully sent. Appendice77 Page 78Copyright long 2011 Samsung Electronics Co., Ltd. The levels are, from top to bottom, application, presentation,
session, transport, network, data connection and physical. Pabx an exchange of private automatic branches a € & € & € «(Pabx) system within a private age language Enterprise.pclprint (PCL) is a language description of the page (PDL) developed by HP as printer protocol And it became a standard in the sector. After the toner has been transferred to
the paper, the spinning unit applies heat and pressure to ensure that the toner remains on paper permanently, which is why the card is hot when it comes out of a laser printer. It is a way to measure the speed of a printer. Contact the manufacturer for service. Use only drivers approved for the country where the device will be used. When you are
challenging the settings of the wireless network, go to passage 11.-Conse a USB cable: connect the USB cable and click Next, then go to Tosp 7. Using the WPS button: see "access point via the button (without Ausb Connection cable) "On page 115.8 after searching, the window shows wireless network devices. Continue waiting to the machine press.
Follow the following steps to print from a macintosh: open an application and select printing from the file menu. 30,000 pickup rollerappross pickups. Turn on the access point. 2. Using a machine connected to Rete133 Page 134 Wireless Network SetupConnecting Ercoment - Unconidal security mask: 255,255.0.0.0"' A establish therefore the network
information of the machine should be below: security is not configured correctly. This relationship can be set to how to print after each job or only after the transmissions unable. The format of the image file (TIFF) is a bit image format mapped with variable resolution. All these functionalities provide a gateway to comfortably use your car. The
installation of a new driver or the configuration of the network settings is not necessary - simply installs the Samsung MobilePrint application and detects Wihatomatically compatible Samsung printers. It was included in the original Macintosh (1984) and is now deprecated by Apple in favor of the TCP/IP network. If you are printing only the active
screen, release the button when the green LED stops flashing. To print a letter with the headed paper of your company, it was not necessary to upload pre -headed paper to the machine: just print the paper headed on your document. To use an overlapping page, you need to create a new page page containing your logo or image. The format of a Unc
route is: \\ \ \ Urluniform resources locator (URL) is the global address of documents and resources on the Internet. Page 2basicl. It is a diworking awarding protocol used by Novell Netware operating systems. PDF is File format designed to present documents consistently on more devices and platforms. If the machine is connected to a network, jump
the following phases below and go to install a driver of a machine connected in the network (Seaadvanced guide) .3seletct Install Install License agreement and select I accept the terms of the license. Go to print preferences, click on paper and set the type on thick (see "opening of printing preferences" on page 35) .5. The browser opens the
Setipapplet.html page that shows information on the name and the IP address. Use of a machine connected to Rete91 Page 92 a € <& €« Crewired Network Setup45click Theicon (third from the left) in the Setip window to open the TCP/IP configuration window. Ensure the new information of the machine in the configuration window. Learning the use
of basic24 Page 25media and Traythis Chapter provides information on how to load the printing supports in Yourmachine. avelop the use of print media that does not meet these specifications can cause problems or request repairs. WPA also uses Tkip (temporal of the KeyintegriTy protocol) and AES (advanced encryption standard) for
DataCryption.2. Using a machine connected to Rete122 Page 123Wireless Network Setup14 The window shows wireless network settings and check if the settings are on the right. Both the high temperature and the humidity can cause paper curls a € turn the paper stack in the tray. If the wireless access point supports WPS, you can easily configure
the wireless network connection without a specific electronic document paper, developed by Microsoft. If you cannot report the function, it is not applicable to your car. .A ¢ avelop the intelligent panel window and its content shown in the guide of this Maydiffer user depending on the machine or the operating system in use. which are compatible with
the machine (see "installation of the driver locally" on page 21). This button opens the problem resolution guide when an error occurs. This section is applicable only if these devices are present. Click Next.2. Using a machine connected to Retel17 Page 118 Wireless Network Creating The ad hoc network in Windows12345check if the USB cable is
connected to the machine. If you want to change the ad hoc ad hoc settings, click Advanced Settings.A ¢ avelop the wireless network name: enter the desired SSID name (Ssidis Houses-sensitive) .6 The software is looking for the wireless network. & € Operational modalities: select ad hoc. Introduce the software cd supplied in your CD-ROM Drive.a ¢
avelop channel: select the channel. TIFF images use tags, keywords that define the characteristics of the image included in the file. This uses a shared secretion (generally called predivided key passage phrase) which is manually configured on the access point and each of its customers. Cryptography: select encryption. Useful management tools173
Page 1745. Remove the toner cartridge and install a new one (see "Replacement of the toner cartridge" Onpage 44). If the problem persists, the machine can request repair. Don't change them in any way. The modification to a wireless device cancels the authorization to use it. Contact of the manufacturer for service.14germany Solo5. Examples of
common restrictions are listed below: wireless communication with radio frequency can interfere with the equipment plane. Problem resolution188 Page 189 Operation System Problems1 Commuto Problems of Condition of Conditions of solutions & € 4,— & "Ilfile in use daute the installation appears. Exit all software applications. The file is displayed
Problems Problems of solution solutions during the solution during the ISIMA solutions. A ¢ Make sure to use the correct type of paper. Avelop the paper from the tray and flex or ventilate the paper. A avelop the wet conditions can make a little paper sticks. The types of paper can be stacked in the tray. A device that has an adequate Keycan Wep
access to Network.Wpa Personal or WPA2 Personal: select this option to authenticate the print server based on the pre-condivated WPA key. CONFERENCE TESTATED: installation of the basic machine, A4 paper, Simplex printing. See the evaluation label on the correct voltage machine (V), the frequency (Hertz) and the type of current (a) for the
machine. For the machine that has a power switch.Wireless Model (see "Features for models" on page 6) .5. To enable your Towork machine with your network, you will have to perform some configuration procedures. 2. Using a machine connected to Rete128 Page 129 Wireless Network Setup avelop after completing the wireless network
connection, you need to install the Amachine driver to print from an application (see "Driver installation on The Network" on page 93)A avelop or the person who configured the wirelessnetwork, for information on the configuration of the network. Setting using the Setip (Windows) program this program is used to manually set the network IP address
of your Mac address to communicate with the machine. The alphabet and English numbers are normally displayed on the cover. When they print a document in Macintoshwith Acrobat Reader 6.0 or higher, Colorsprint incorrectly. Make sure that the resolution setting machine driver corresponds to that in acrobat acrobat Driving the Macintosh user
provided with your computer for more information on Macintosh error messages. Problem resolution190 Page 191 Operating System Problems3common Linux Problemacition The machine does not print it. Ungesty solutions a € check if the printer driver is installed in the system. Remove the excess paper from the tray. This is usually performed in
the bootstrap process of computers or operating systems in & € ce 4 € <Execution on them. If you find an impact in our frequently questions, let us know using our contact form. Appendice65 PAGE 66SPecificationslinuxiTemstemsFedora 5 ~ 13 (32/64 Bits) Opensse ¢ A® 10.2, 10.3, 11.0, 11.1, 11.2 (32/64 Bits) Suse 10.1 (32 Bit) Systemubun
Operational 6.06, 6.10, 7.04, 7.10, 8.10, 8.10, 8.04, 8.04., 9.10, 10.04 (32/64 bit) Mandriver 2007, 2008, 2009.1, 2010 (32/64 bit) Debian 4.0, 5.0 (32/64 bit) Redhatad ¢ 4® Enterprise Linux WS 4, 5 (32/64 Bit)) Suse Linux Enterprise Desktop 10, 11 (32/64 bit) Cpuptium IV 2.4GHz (Intel Cored ¢ & € Za ¢ 2) RAM512 MB (1 GB) Free HDD spacel GB (2
GB) 5. If it is not out It is possible to determine the name of the tail for the machine server, try to use the Queuefirst. 20 for Mac OS X 10.4, if the automatic selection does not work properly, select Samsingin Print using and the name of the machine in the model. If you click on customize, you can choose single components to install. 1112Anter the
password and click OK.1314 Check the driving of the machine included in the software CD supplied with the machine and prepare a wireless network machine. Avelop when you found the printer you want to connect from the Yourmobile device, select the printer and LED of the printer will be flashing. Follow the instructions on Thewindow.In the
software cd supplied in the CD-ROM. The software cd should Automatically performed and an installation window is displayed. installation. Select I accept the terms of the license. A scan can be launched by these operating systems using a scanner compliant with Wia.usbwpa Universal Serial Serial Bus (USB) is a standard developed by the
USBIMPLEMPLEMPLEMPLE FORM, Inc., to connect computers and peripherals. A device that has an adequate keycan accesses the network. Read the license and selection agreement I accept the terms of TheLicense agreement. Use cold water. The use of recycled supplies, such as toner, can cause damage to the theme. inhaled or ingested. 1.
Introduction 13 Page 15 Panoramic machines9 AccessoriesPower cordquick installation guidesoftware cdbmisc. The Mac address is the hardware series number of network interface and can be found in the configuration report of Theonwork. See "IP address setting" on page 90.items to prepare the definition of the wireless wireless network network.
avelop software supplied with your machine 4 A A 4 A 4 A € installed with a wireless network interface before starting you will have to know the network name (SSID) of your wireless network and the network key if it is encrypted. 802.11b/g/n devices can occasionally undergo interferences from the buffer ovens, cordon telephones and Bluetooth
devices. A power supply of automatic documents (ADF) is a scan unit that automatically enhances a sheet of original paper so that the machine can scan a certain quantity of captain at the same time.AppletalkAppletalk is a suite owner of protocols developed by Apple, incpo. Networking. Check the safety configured on the point and on your access
machine. a signal from yours Page 80 Advanceding Print featuresl. Look at the description in the selected printer box. MMRMODIFied Modified Read (MMR) is a compression method recommended by itu-t T.6.Modema device that modulates a bearing signal to encode digital and demodula information also this bearing signal to decode the
information transmitted. Mrmodified reading (MR) is a compression method recommended by ITU-T T.4. Mr codes the first scanned line using MH. Imposed by default, these values depend on the cutting edge of the page cut. Select various options in the JCL and General Frame to customize various sets sets. The thickness of the verified card is
indicated by the weight, for example 80 gram paper. Repeat if necessary. Click Next. Avelop software connected to the mesh "which has been provided with your machine 4 A A 4 A 4 A € installed with a wirelessAAAA A a4 A A 4 A 4 A € by selecting the components, you can also change the name of the machine, set the machine to be shared on the
net, set the machine as a Efault machine and change the name of the door of each machine. This mode uses an access point to communicate with the wireless machine. Access. If these steps do not correct the problem, contact a service representative. Black background if the background shadow quantity becomes unacceptable: & ¢ 4,— & ¢ changes in
a slightly light weight. ¢ Check the environmental conditions: very dry conditions or a high level of level the humidity (higher than 80% of RH) can increase the background background quantity. A ¢ avelop the old toner cartridge e in Stall a new one (see "replacement of the toner cartridge" on page 44). A, & A A A oe Redistribute the toner carefully
(see "redistributing toner" on page 43) .oner avelop clean the interior of the machine (see "replacement of the Del Cartridge "on page 44). A ¢ avelop the type of paper and quality 44) .5 Window printing> Page35 paper card). For example, if you want to print on labels, select labels for the type of paper AB BC CA AB BC BC BC BC BC AB BC BC
CDROPOUTS & A ¢ The card path may need cleaning. This device must be used more than 20 cm (8 inches) from the body when wireless devices are active. Furthermore, USB type is available on Sun Solarisos.select copies to set the number of copies. Check the collar option T or you receive copies already ordered. Check the reverse order option to
receive copies on the inverse order. Check the default option to set this printer as a predefined. Click OK to add the printer. Like the name of the printer. Select the appropriate printer model from the models list. Attention any description corresponding to the type of printer in the Thetype field. Disconnect the USB cable if you want to set
wirelessNetwork using the WPS button. Connected: When the machine is correctly connected to the wireless network, the WPS LED light remains on. Avelop the USB cable, consult "access point via USB cable" on page 120.11 The next window asks you to check if the access point (or wirelessrouter) supports or not. If the access point (or wireless
router) has a WPS button, select it and click next. 2. Use of a machine connected to Network125 Page 126wireless Setup-SSID Network After completion completion Wireless network connection process, the SSID AP information is displayed on the display. Status LED flashes quickly. The car starts connecting to the wireless network. Service or repair
requested following the use of the non -genuine Samsung toner cartridges will not be covered under the machine's swarranty. 3. Maintenance39 Page 40 A.STUALABLE MUSTRANCE PARTS PURCHASE PARTS, CONTACT THE ORIGIN In which the machine was purchased. Do not open paper packages until it is necessary so that the card does not
absorb too much humidity. If the background dispersion occurs on an envelope, change the print layout to avoid printing on areas that overlapped Seamson on the back. A type of file format, CSV is used to exchange between disparate applications. Some parts of graphics, text, hillustrations have missed. SUSEGESTED PRINTING SOLUTIONS The
PDF file as an image can allow the file printing. If Not, Clickfinish.da ¢ A€ AAA44€A€A€A€A€A€AE€AEAEAEAEAWireless Network Interfacecreating the Infrastructure Network1234Turn on your computer, Access point and machine. Insert the software CD provided in the CD-ROM unit. Select the wireless setting and installation option.
Read the license contract and select accept the terms of TheLicense agreement. Maintenance43 PAGE 44 Replace the Toner cartridge - Before opening the upper lid, close the output support first. A Aias & mbers do not use sharp objects such as a knife or scissors to open the toner cartridge package. After the toner has been transferred to the paper,
the FUSER unit applies heat and pressure to ensure that the toner remains on the card, which is why the card is hot when it comes out of a laser 201 GLOSSARYGATEWAYEEEA WEAKE PAGE BETWEEN COMPUTER NETS OR BETWEEN A METHY OF COMPUTER AND A TELEPHONE LINE. Since the ink is liquid, the print head can dry over time.
WEP encrypts the data button of each package exchanged on a wireless network using a 64 -bit 128 -bit WEP encryption button. Portthru Andsignal is the autonomous printer. So, click Next. If you want to use other ad hoc settings, select another wireless network from the list. 8 The window showing the setting of the wireless network. In addition, the
IP address of the machine should have been set (see "iPaddress setting” on page 90). If the "new Wizard Hardware of the new Wizard" is displayed during the installation, click Cancel to close the window. 2 The personalized installation allows you to select the machine connection and install individual components. In case of ad-hocmode, you can
simultaneously use a wireless LAN and a wired LAN. The Wi-Fi network on/compensating the direct Wi-Fi for the mobile printing of the machine has a display, it is also possible to activate/deactivate the Wi-Fi from the control panel of The The The TheMachine using the Network menu. Direct Wi-Fi is an easy-headed peer-to-peer connection between
the method for your printer and a mobile device that provides a safe connection and a better reduction in the ad hoc modality. 00 connected to the machine. WirelessNetworking may not be available depending on the model (see "characteristics of characteristics" on page 6). A ¢ If the IPV6 network does not seem to work, set all the network settings
The predefined settings of the factory and try again using the Clear.Wireless network The networks of name and network network require greater safety, therefore when access A network name (SSID) is set for the first time, the type of safety used and a network key are created for the network. Finally, try a new car cable. The wrong printer driver
was selected. Check the Applicatinon printer selection menu to make sure the machine is selected. The software application does not work malfunction. Malfunctioning.exit Windows and restart your computer. We recommend using the predefined local IP address (the predefined local IP address of the printer for Wi-Fi Direct 1S192.168.3.1) from the
computer connected to the network, if the printer uses a network cable or a wireless access point , You can configure Wi-Fi directly from Syncthrud ¢ 4 € Za ¢ Web service. .A ¢ avelop or disable direct Wi-Fi and set up other options. A ¢ avelop for users of the Linux operating system, imprint a configuration relationship of the IP network to verify the
output (see "Print a network configuration ratio" on page 90) .2. Go to print preferences, click on the page card page: a ¢ avelop the paper is too rough and a lot of dirt from the paper falls to the internal components inside the machine, so the transfer roller can be transparent. At the end of the installation, clickquit. After completing the wireless
network connection, it is necessary to install Amachine Driver to print from an application (see "Installation for Macintosh" on page 83) .18 using a network macarachine that do not support the network interface not to be in able to use the function (see "rear view" on page 17). Your car is a machine compatible with network. Problem resolution183
Page 184 Printing Problems ProblemsconditionVs Repetitive Defectssugmesested If the signs of which the brands appear repeatedly. brand names. Printed side of the page at uniform intervals: a ¢ avelop the toner cartridge can be damaged. Codftiness Dodajemy Najnowsze Instrukcje, Abya ¥ a € 2zowsze Znalaza ¥ a € breakt, kta £ a3rego szukasz. To
avoid paper jams, consult the following guidelines: & ¢ avelop to make sure that the adjustable guides are positioned correctly (see "Overview of the tray" on page 25). A avelop not to overload the tray. This address is usually coded in a network interface form (NIC) by its manufacturer and used as a help for routers that try to identify large networks
on large networks. Modified Read (MMR) is a compression method recommended by Itur T.6. The Modema device that modulates a bearing signal to codify digital and alsodemodula information such a bearing signal to decode the information transmitted. MFPMMMULTI Peripheral function (MFP) is an office machine that includes the following
functionality in a physical body, in order to have a printer, copying, fax, ascanner and etc. Modified Read (MR) is a compression method recommended by ITU-T T.4. Mrencodes The first scanned line using MH. Setting the Eco Settings is available from the Windows driver. (‘A € & ¢ Avelop www.samsung.com/printer to download the driver of
uptermachine and install it on your system. Click Next. If you want to change the ad hoc settings, click the Advanced Setting button. & dvelop the wireless network name: enter the SSID name (SSID is casually sensitive). & ,A & ¢ Operational modalities: select ad hoc. A ¢ dvelop channel: select the channel (automatic setting or 2412 MHz at 2467 MHz)
.2. Sometimes the term refers only to the most visible service, the IP address (Internet Protocol (IP) internet interior is a number that the devices use to identify and communicate together on a network using the internet protocol standard. The GlossaryeCmerror (ECM) correction mode is an integrated optional transmission mode in class 1 fax
connected to Nest113 Page 114 Wireless Network Setup9 The window shows wireless network settings and the controls if the times are correct. The next line is compared with the first, the differences determined and therefore the differences are coded and transmitted. Page 6glossary201 Connection Glossarygatewaya between computer networks or
between a computer network and a telephone line. To -t outside of itu-t indicates telecommunication.itu-t n. 1 graphic graphic graphic designer published by Itu-T for the document transmissions of the document. Or the quality, designed for the compression of binary images, in particular for faxes, but can also be used on other images. Jpegjoint
Photographic Experts Group (JPEG) is a standard method more commonly used for compression loss for photographic images. 30.000 Rollerapprosser Pagestransfer. Useful management tools2. If you use a cable that is more than 2 meters long (6 feet) with an 110 V machine, the indicator should be 16 AWG Orlarger. Otherwise, it can cause damage
to the machine and could cause electric shocks or fire. The power cable is connected to an electricoutlet on the ground. Otherwise, there could cause electric shocks or fires. Do not overload walls and prolong machine or place it in an olabo orrata The exit of the wall before cleaning the side of the machine. Connect your MobileDevice to a Samsung
printer connected to the net or to a wireless printer via the Wi-Fi access point. The machine is now set to print based on the selected settings. Remove the toner cartridge and install a new one (see "Replacement of the toner cartridge" Onpage 44). A ¢ The machine may require repair. Alternatively, you can use the LPR printing system or other
applications for printing a draw. Options available in the Boxar printer lists default, simple and thick. Select a printer that was already added. Avelop paper source: select which card is used from. Then, click Next. The program is looking for the car. 2. Using a driver of machines connected to Rete93 Page 94-Installing on the network if the machine is
not found on the network or locally, a messageasagears of error. Select the option you want and click Next 5 command follora is effective and managed when the command is used with /s or /s. If you show static, TCP/IP clickchal to change the assignment method to receive iPaddresses automatically (DHCP). The complete window of the wireless
network setting is displayed. Remove all the software from the start group, then restart Windows. IPX and SSPX both provide connection services similar to TCP/IP, with the protocol protocol similarities with IP and SPX with TCP similarities. It is also possible to connect the Tosamsung website or download drivers by selecting the link menu. Set of set
of set 4 4 A A A 4 ce Firmware Update: update of your computer firmware.a ¢ avelop information: Show contact information. Useful sites where you can download or check -information. card allows you to set the configurations provided by the machine and the network. When you have finished setting the wireless network settings, go to passage 16.
With a USB cable: connectite connecting USB cable and click Next, then go to Tosp 7. Using the WPS button: consult "Access point via the WPS button (without connection of the Ausb cable)" on page 115.13 After search, the window shows wireless network devicesSee the following table to cancel the problem. Condition or faded printing solutions - If
a vertical white strip or a faded area appears on the page, the supply of toner is low. Introduction This chapter provides information that you need to know before using the machine. 4,— & ¢ BENEFIRS4 - Features of Models6 useful for knowing 8 "Information on this user guide. Friendlyconvenience "to save the toner and paper, this machine supports
the Eco function (see" Easyeco Driver "on page 159). 4,— ce & establish easy capture manager allows you to easily modify and print anything you are capturing using the keyboard key on the keyboard (see "understanding of the acquisition manager" on page 160). Avelop to save the card, you can print more pages on a single sheet of paper (see "use of
advanced printing functionalities" on page 141). A ¢ avelop to save the card, you can print on both sides of the paper (double manual print) (see "using advanced printing functionalities" on page 141). "A without electricity, this machine automatically preserves Ves Electricity by reducing energy consumption when it is not in use. Pronzing with
excellent quality and speed - Samsung Easy Presster Manager and Samsung State State (or Smart Panel) are a program that monitors e It informs you of the state of the machine and allows you to customize the machine settings (see "Use of Samsung EasyPrinter Manager" a 164). A ¢ Any web printing helps you to capture, preview, waste and
printing more easily compared to when using the ordinary program (see "Samsunganyweb Print" on page 158). avelop intelligent update allows To check the latest software and install the lowest version during the printer driver installation process. Select what you used and click OK.command- Riga/SRIF The driver searched only one machine, the
confirmation window appears. User Intervention. Clean the inside of the car (see "clean the machine" on page 46). A ¢ The surface of the LSU part inside the machine can be dirty. This functionality provides an economic way to print tiraggio copies.12Pen an application and select printing from the file menu. 34 Select the other options to be used.
Discover the number of copies and indicate which print pages. Click Print. All components necessary for the machine operations will be installed.18Click Add. If you click on customize, you can choose the individual components to be installed.1112Anter the password and click OK.13 Toner's Cartridgesho should remain in its original and not open
package until installation - if the original package is not It is available, cover the upper opening of the cartridge with paper and rest in a dark furniture. Open the packet of cartridges before dramatically use its useful shelf and operational life. Click Continue. The Add printer guided procedure window opens. If you have Samsungmultfunction printer,
scan any document in a JPG, PDF or PNG Forquick format and an easy viewing on your mobile device.23Download Samsung MobilePrintsupportped Mobile OS - OS Android OS 2.1 or Superior overruise avelop Windows 7 or devices greater than 25s supported "iOS 4.0 or higher: iPod touch, iPhone, iPada ¢ avelop Android 2.1 or higher: Galxy S,
Galaxy S2, Galaxy Tab and Android Mobiliedavices A ¢ Windows Phone 7 or higher: Samsung: Samsung: Omnia7 and OMINAW, Andwindows Mobile Devicesto Download Samsung MobilePrint, Go to the Application Shop (Samsungapps, Android Market, App Store, Marketplace) on your mobile device and Justsearch for "Samsung MobilePrint". You
can also visit iTunes iTunes for the Apple devices market for Windows devices on your computer. 2. Using a machine connected to Rete136 Page 1373. 802.11BSUPPORTS Band width up to 11 Mbps, 802.11n supports bandwidth up to 150 Mbps. Useful management tools169 Page 170 Using Smart Panel9CHanging Coft Panel a ¢ avelop settings
settings Direct on the Smart Panel icon and select Smart Panel configure. The machine connects to the access point (or wireless router). When the machine is correctly connected to WirelessNetwork, the WPS LED light remains on the setting of the wireless network is completed. Itmeans that the functionalities are not supported. 5 Press OK to start
the printing work. 17 By changing the machine settings16 Printing the Babafter prints by installing the command print avelop. The UNIX printer driver print the work manager in which the user can select various printing options in the printer's own property. The following keys of choice can also be used is &,— a "to 4 € to be applied and is 4,— 8" ¢
A- for the cancellation. A ¢ avelop “Document1a € paper size paper size, according to your needs. This open the UNIX print manager driver in which Theuser can select various printing options. Type of paper: choose the type of paper. Select the paper size option available in the card for the SEEWHAT card size. If you select a size of the paper not
available, this option can be automatically canceled. For example, if a lot of graphics are printed, the consumption of Thetoner is more high and could The cartridge cartridge must be changed by more Cartridge Usagesamsung Electronics does not recommend or approves the use of non -Samsungbrand toner cartridges in your printer, including
generic brands, shops, refined toner cartridges and manufactured. Tonertridges of the regenerated or non -Samsung brand. 3. Maintenance42 Page 43 Redistribuing Toner When the toner cartridge is located towards the end of its life: & ¢ Avelop white streaks or printing of light and/or variation of density from one side to the other occur. A ¢ The
LED toner flashes orange. If it happens, it is possible to temporarily improve the quality by redistributing the remaining toner in the cartridge. For this reason there is always a white edge. Select the destination path, if necessary (the defaultis c: \ forms). Eclick save. Problem resolution180 Page 181 Proprinting Problems If the interior of the machine
is dirty or the card has been loaded improperly, there may be a reduction in print quality. Don't change them anyway. It is possible to temporarily increase the print quality by redistributing the toner (see "redistributing the toner" on page 43). The Toner of Correte cartridge has almost reached its life with an estimated cartridge. In this case, it is not
applicable to the machine. A,— 4 A & ¢ Print modalities: the predefined print mode is normal, which is for printing without saving the print file in the memory. Modalities- Proof: this mode is useful when printing more than a copy. It is a specification based on XML, based on a new printing path and a document format independent of the vector based
device. Maintenance47 Page 48 Clearing The Machine6 Clearing the sampling roller-use a dry cloth without a flour to clean the car. If the machine has a power switch, turn off the switch of before cleaning the car. 3. Maintenance48 Page 49Tips for the movement and storage of the machine - When moving the car, do not tilt or o He is turned upside
down. The operation is subject to the following two conditions: a ¢ avelop this device cannot cause harmful interference and a € this device must accept any interference received, including the interference that can cause unwanted operations. Activit users must contact their supplier and check the terms and conditions of purchase contract. Note that
the print quality is not guaranteed. A ¢ In the application of the software, set margins of at least 6.4 mm (0.25 inches) away from the edges of the material. "It must be printed with heat -resistant ink that does not melt, vaporizzer, hideous dangerous emissions if subjected to the melting temperature of the machine for 0.1 seconds (about 170 4 ° C
(338 ° F) A ¢ Loads prepared paper, verify that the ink on the paper is dry. During the melting process, the wet ink can eliminate the strain paper, reducing the quality of the print. 5sexing The Of Paper Poper and Ty Ty Ty Ty Tyinding Card in the paper tray, set the size of the card and type. Open print preferences (see "opening of printing
preferences" on page35) and sets the size of the paper e Type in the paper card. If you want to use special sizes such as the billing card, select the custom tab in print preferences tab (see "opening of printing preferences" on page 35) .2. Fucking the tonercartriggio. A ¢ avelop a different printing resolution approach. Where can I buy accessories or
supplies? A,— & informed about a Samsung distributor or your dealer. Visit www.samsung.com/supplies. If the computer computer on DHCP, you need to contact the network administrator to obtain the ecstatic IP address. For example, if the information on of the computer are as shown below, -IP address: 169.254.133.42 -Subnet Mask:
255.255.0.0Then. , Information on the machine network should be the following: -ip address: 169.254.133.43Wi -Fi Direct option: -Subnet Mask: 255.255.0.0 255.255.0.0 The sottorete of the computer sottorete.) Is avelop the direct Wi-Fi option appears on the screen only if your printer supports this function. Gateway: 169.254.133.1 "can start
creating Wi-Fi directly using Samsung Easy Printer Manager (see" Wi-Fi Direct setting "on page 131). 2 Increased the number of bits, the number of possible possibilities becomes impracticable for A color map. It is possible to check the information, such as the Smodel name of the machine, the IP address (or the name of the door) and the
machinestatus.contents area526USER of the guide: this opensrubloshooting button guide guides of Theuser. On the selected machine, the remaining toner level and the paper. It is a client-server protocol, in which the client transmits an e-mail message to the server.ssidService Identifier (SSID) is a name of a wireless local area network network



(WLAN). Also try to rotate the 180 A A ° in the tray. Change the printer paper option and try again. It also provides an authenticated inter-process communication mechanism. The TR control protocol asymission (TCP) and the Internet protocol (IP); The set of communications protocols that implement the stack of the protocol on which Theinternet and
most commercial networks are performed. Otherwise, Clickfinish.17setup using MacintaShitems to prepare the CD Software with the mesh software "which was supplied with your machine installed with a wireless network interface" Install OS X icon.Click Continue. Read the license agreement and click Continue. Agrees to accept the license
contract. When the message warns that all applications will close on Yourcomputer, click on the continuous button of setting the wireless network on the Panne Options user. The software The wireless network. If the software has not managed to search in the network, check if the USB cable is correctly silly between the computer and the machine
and follow the instructions in the window. Access point via USB1234check cable if the USB cable is connected to the machine. On your computer, Access Point and Machine.In the software cd supplied in the CD-ROM unit. Click CLICE ICON CD-ROM which appears on the Macintosh.2 desktop. Using a machine connected to Network120 Page 121
Wireless Network Setup & & ¢ If the Wireless Network Setting was set, the information window on wireless networks is displayed. Wireless configuration method window. A ¢ avelop for models that support the WPS button (without a USB cableconnection), the window shown below will be displayed. A ¢ avelop manually configure the wireless
settings.: Go to passage 13.a ¢ avelop wireless settings by pressing the WPS button on the Theaccess point. or a wireless router). Follow the instructions in the window. Useful management tools167 Page 168 Using State Samsung State 345order Suppliesyu can order (e) spare cartridge of mountain toner. Useful management tools168 Smart
Panelsmart panel is a program that monitors and informs you of the state of the machine and allows you to customize the machine settings. In addition, the IP address of the machine should have been set. 12345678 Download the unified Linux driver package from the Samsung web website. . The Samsung Installer window opens. The underlying
maintenance parts must be replaced when the duration of each It was satisfied. UNIDAPARTSFUSER Unitapoppredo. With the exception of the name, the composition of the Propertieswindow printer is similar to the following. 10120open the document to be printed. Confirm that all ArecorRect.Ipv4 settings configuration via STIP (Macintosh) before
using the STIP program, disable the computer from Systempreference> Safety> Firewall. The following instructions can differ in the model.12 Conconnects the machine on the network with a network cable .3D-Click-Click The file and Safari will open automatically, then selectust. In these requests, contact a network administrator. Useful
management tools163 Page 164using Samsung Easy Presster Managersamsung Easy Printing Manager is an application that combines the Samsungmachine settings in one position. Road the print head carefully, without making it too wet. The CCDlocking mechanism is also used to contain the CCD module to avoid damage when moving the separate
values of the machine.comma (CSV). This is optional. 2. The use of a machine connected to Rete100 Page 101ipv6 Configurationipv6 is correctly supported only in Windows Vista or higher.7 that the machine does not work in the network environment, active IPV6.Refer in the next section followed by. If the IPV6 network does not seem to work, set all
the network network settings for the predefined settings of the factory and try again using Clear Settings. In the IPV6 network environment, follow the next procedure to use IPV6Address.10 From The Control Panel123Connect the machine on the network with a network cable. 456Select Start> Control Panel> Panel Control> Control Panel Control>
Start of the Control Panel> Control Panel> Printers and Faxes.Turn on the Machine.print a network configuration ratio that controls the IPV6 addresses (see "Print a network configuration relationship" a Page page Add the printer guided procedure window. If you show static, TCP/IP clickchal to change the assignment method to receive iPaddresses
automatically (DHCP). avelop for the static method if the method of assignment of the IP address is static, check if static is shown in the confirmation window of the wireless network network. It is possible to print up to 16 pages on a sheet. 3. Special features142 Page 143 Use of advanced printing characteristics PrintingDeDeScription Prints A
document on 4 out of 4 (2x2 poster), 9 (3x3 poster) or 16 (4x4 poster) sheets of paper, in order to glue the sheet to form a document of Poster poster size selects the overlapping value of the poster. The filigree were introduced for the first time in Bologna, in Italy in 1282; They were used by Paper producers to identify their product, and also on
stamps, currency and other government documents for counterfeiting TodiscoUurage. The UNC PathwePuniform denomination agreement is a standard way to access the NT network glass network and other Microsoft products. Demo Page24Media and Tray25Basic Printing34specifications59 Re -ENGLAGE68Copyright783 appendix It is an XML-
basedspecification, based on a new print path and a vector-based deviceindependent document format.Glossary208 Page 209IndexCGcleaninggeneral iconsinside46outside46pickup roller48Jcleaning a machine46jamcontrol panell8convention9Ddirect printing utility14998Eeco printing36Ffavorites settings, for printingfeaturesprint media featurefront
view364611619726special media28localdriver installation21driver reinstalling22Mclearing paper52tips for avoiding paper jams51Macintoshcommon Macintosh problems190Ldriver Installation for Network Connected 96 LINUXDRIVER installation for USB Cable Connected83common Linux Problemsdriver in the trayl191driver installation for
network connected 97driver reinstallation for USB cable connected84driver installation for USB cable connected85printingsystem connected85printingsystem reinstallation for USB cable connected87using SetIP91printer properties154printingl153unifled driver configuratorl71using SetIPmaintenance partspaper in manual feeder/multi-purpose
tray2840manual feeder/multi-purpose tray92loading151tips on using28using special media28Nnetworkdriver installationIndex 209 Page 210IndexLinuxMacintoshUNIXWindows97969893mobile OS136mobileprintl136print mediaprinting on both sides of paperMacintosh152printing to a filel41card stock32UNIX155using direct printing
utility149installing environment67envelope29introducing network programs89labels31output support61Linux153preprinted paper32Macintosh151special media28UNIX155IPv6 configurationSetIP programwireless network setup10190, 91, 92, 129104N-up printingMacintoshproblemsprint resolution set151LinuxOprinter preferencesoverlay
printingPrinter Status153Linuxcreatel46delete147print147Pplacing a machineadjusting the altitude138PostScript drivertroubleshootingprint1 92general informationprinting a document154167, 169P rinting34printingpaper feeding problems175power problems176printing problems177printing quality problems181Rrear view1768changing the
default print settings139regulatiory informationLinux153SMacintosh151multiple pages on one sheet of paperl151Macintoshprinting a documentWindows34safetyinformation10symbols10service contact numbers193Index 210 Page 211IndexSetIP programspecial print features90, 129137specifications59print media61stop buttonl9suppliesavailable
supplies39estimated toner cartridge life42ordering39replacing toner cartridge44system requirements28understanding the status LED55UNIXTprinting155Unixsystem requirements66driver installation83, 85driver reinstallation84, 87using help104infrastructure ModalitA 10436, 152WPSDISCONNEZIONEGPBC MODE111, 115, 124108108WPS (la
macchina non ha un display Screen) 109PBC109PinWireless NetworkNet NETWORK CABLETONER CARTRIDGE90, 129AD HOC MODEUSB Installazione CableRiver per rete SetIP64wirelessUUSB cableSyncThru Web Servicegeneral informationloading paper in manualfeeder/multi-purpose trayl128Westimated life42handling
instructions42watermarknon-Samsung and refilled42createl45redistributing toner43deletel45replacing the cartridge44edit145storing4d1Windowscommon Windows problemstrayl89adjusting the width and length25driver installation for network connected 93changing the tray size25driver installation for USB cable connected21,22Index 211 Page 2
209IndexIndexCcleaninginside 46outside 46pickup roller 48 Machine cloliant 46Control Panel 18 Convento 9Direct Utility 149Driveriver Installationunix 98Eco Printing 36favorites Settings, for printing 36Features 4Print Media Funcy 61front View 1613General icon 97drover Campedardadading Campereding to avoid the Avoid Card to avoid the
avoidance card to avoid the card to avoid paper for the network for the network to avoid the card for the network to avoid the card for the network to avoid the card for the network for e Vitate the card for the network to avoid the card for the network to avoid the card for the network to avoid the network for the network for the network to avoid the
network card to avoid the reincaric for the network for the network for the networkUSB Cable 87 Print owners 154p Running 153 Configurator of the Unifled 171using Setip 92LoadingPaper Driver in the manual power supply/Multiuse tray 28PAper in the trayl 26 Special multimedia 28localdriver Installation 21DRIVER REINSTALATION 22
mmcintoshcommmon Macintosh Installation of the Cable Cable Cable. 40 Multiuse Power Supply Manuals on Use of 28 Using Special Media Special Media 28nNecanzerdriver Page 3GLOSSARY207 GLOSSARYWAINNAND STANDARD FOR SCANNER AND SOFTWARE. The dust cannot dry, making the print regular useless. The types of paper
available manual power supply in the tray. When they use special supports, we recommend that you One sheet at a time (see "" printing media specifications "on page 61). To see for paperweights for each sheet, consult "Specifications of the print media" "ONPAGE 61. (4 ¢ & €": including, empty: emptiness: empty: Available) The printing envelopes
successfully from the envelopes depend on the quality of the envelopes. Typography - Often - Shuttled ¢ a € "Bonda ¢ &4 €" Colora ¢ a € "CARSTOCK - Labels - preste - 2. The replacement of maintenance parts can only be performed by an authorized service service, a dealer or the dealer in you bought the car. Select the name (SSID) of the access point
you are using and click Next. When setting the wireless configuration manually, click on advanced setting. Avelop the wireless network name: enter the SSID of the access point (SSID is sensitive to chance). Use of a machine connected to Network121 Page 122 Wireless Network Setup Authentication: Select a type of authentication. Opening system:
authentication is not used and encryption can be used, depending on the data security need. Shared key: authentication is used. This was useful (23) What is the thickness of the paper? This was useful (27) the printed documents are crooked, what can I do? Select your country/Toview region information on the product service. The LED state flashes
"Clearing Paperjams" on page 52). Avelop the toner cartridge. The car does not print. printing "on page 35) .4 ¢ avelop the driver and install it again (see" installation of the driverlly "on page 21). & ¢ avelop the machine as a default machine in the windows. The term "1284-B" refers to a specific connecting connecting the electricity of the parallel
cable that connects to the peripheral (for (for printer). Halftoneintranetan type of image that simulates the gray scale by varying the number of points. Try printing with a different lot of paper. Regular printing is necessary to prevent it. It is possible that the document does not have the correct specifications to combine this printer. It is necessary to
access as an administrator to view this tab. 3 Machine settings tab: Set the options provided by the machine. Repair from non -certified technicians could cause electric races or shocks. It could cause an uncontrollable explosion or fire. 4 € The machine should only be repaired by a Samsung Servicetechniciano. When it retains supplies such as
cartridges for toner, keep them away from children, the dust can be dangerous if inhaled or ingested. To clean and use the machine, strictly follow the user's guide with the machine. When the toner cartridge changes or removes the jammed paper, be careful not to let the toner touch your body or clothes. It is possible to damage the car. Tonality
powder can be dangerous if inhaled or ingested. Keep the power cable and the contact surface of the cleaning or water powder. When the toner puts on clothes, do not use hot water to wash. Otherwise, this could cause electric shocks or fires. The water put the toner in fabric. Tiff describes the data of images that generally come from scanner. Select
the desired settings from the Configura Smart Panel window. Useful management tools170 Page 171 Using the unified unified configurator Linux The unified driver configurator is a tool intended mainly to configure machine devices. This option is not available when using printing a reverse face (manual) .3. The distinctive ring is a phone partner that
allows a user to use a single telephone line to respond to different different phone numbers. Memory module in line (Dimm), a small card that contains memory. memory. The data inside the machine such as the print data, the fax data received.drpduplexdlnathe Digital Living Network Alliance (DLNA) are a standard that allows ONA Home Network
devices to share information between them through the network. A mechanism that automatically transforms a sheet of paper sheet so that Themachine can print (or scan) on both sides of the paper. Therefore, regulates the size of the tray on the size of the support you are loading (see "panoramic tray" on page 25) .21122flex or fan the edge of the
paper stack to separate the pages for the convenience of loading. 2. Learn the basic use26 page 27media and tray4squeze the guide to the width of the paper and slide it on the edge of the paper stack without causing the fold. The settings made by the machine driver overwhelm the settings on the shovel panel. And start the printing menu.B Open the
print preferences (see "Opening of the printing preferences" Onpage 35). C Press the paper card in print preferences and select an appropriate type. For example, if you want to use a label, set the paper by type on the label.D select the manual power supply in the cutting -edge curly paper source, it can cause a paper jam or the paper can be
wrinkled. A ¢ If you do not adjust the guide to the width of the paper, it can cause paper jam. 5 When they print a document, set the type of paper and the size for the tray (see "Setting the size of the paper and type" on page 33) .2. It is possible to first print a copy to check, then print the rest of the copieslater.- Reserved: this mode is used for the
printing of reserved documents. If you want to set up the settingwireless, consult "Set using Macintosh" on page 120.2. Use of a machine connected to Rete96 97 Installing Driver on NetwerlO0click's Instalga. When you change or examine the fuse, you must portray the 13 correct amplified fuse. The user the user Change the settings of the margin by
changing the values in their respective fields. Ledbllinks slowly for a maximum of two minutes until the PBCButton is pressed on the access point (or wireless router). Press the WPS button (PBC) on the access point (or wirelessrouter). The light flashes quickly on the WPS LED. Go to print preferences, click on the card card and set the type of paper
on recycled (see "opening of the printing preferences" on page 35) .5. The highly colorful areas consist of a large number of points, while the most light areas consist of a number of points. on dishes in rapid rotation with magnetic surfaces. A private network that uses Internet protocols, network connectivity and, as regards the public
telecommunication system to securely share part of the information or operations of the organization with its employees. Itmeans that the functionalities are not supported. 12 Using the print before printing in Duplex modalities, decide on which edge you will be winning your finished document. Do not create an overlay with Awtermark.a ¢ avelop the
resolution of the overlapping document must be the same as that of the document that printing with the overlap. Preferences. Blick the advanced tab and select Edit from the text drop -down list. The IPP can be used locally or on the Internet for hundreds of printers and also supports access control, authentication and encryption, making it a very
much capable and safe print solution compared to the older ones. Exchange of sequinzed packages. Problem resolution54 Page 55 Understanding the LED status The color of the LED indicates the current status of the machine. Avelop some LEDs may not be available according to the model or the country. A avelop to resolve the error, examine the
error message His instructions from the problem resolution. "It is also possible to resolve the error with the guidelines from the State Window of the Samsung printer or from the smart panel program window. A A € if the problem persists, call a service representative. 4. Led3status LedstatusDescriptiptioftoff the car is off-line or save the modality.
The machine is online and can be used. Blinghing but for a button (print screen) to be pressing for manual print. Verified DPI stands for points per inch e indicates how sharp prints. Appendice61 Page 62Specificationsprint weight/skills of Imitation of Imitation Power supply in TraybTrayrefer to the simple cutting card of the Pinza Section ColorDrefer
section in the 20 g/m2 section (20 g/m2 (20 g/m2 ( 20 g/m2 (20 to 24 LBS) with section section at the section of the section in the mountains with a mountain section of the mountain section of the game section to individuals. 90 g/m2 (binding from 20 to 24 pounds ) Is avelop 150 sheets of 80 g/m2 (21 pounds) refer to the normal paper section - 1
sheet from 75 to 90 g/m2 (20-24 bond pounds) from 75 to 90 g/m2 (bond from 20 to 24 pounds) a ¢ avelop 150 sheets of 80 g/m2 (21 pounds) refer to the section of normal paper - 1 sheet from 75 to 90 g/m2 (20-24 bond pounds ) from 75 to 90 g/m2 (binding from 20 to 24 pounds) is avelop 150 sheets of 80 g/m2 (21 pounds) refer to the plain section
printed from 60 to 70 g/m2 (from 16 to 19 pounds) from 60 to 70 g/m2 (M2 (M2 (M2 (M2 Bond from 16 to 19 pounds) a ¢ avelop 160 sheets of 60 g/m2 (16 pounds) refer to the Normal paper sectioner in the mountain section - 1 sheet of 50 sheets of 120 g/m (32 LBS) PlainPaper Cotton86 to 120 g/m2 section (23-32 Libbre binding) 2refer to the simple
section of section paper from 86 to 120 g/m2 (23-32 LBS. /m2 (bonds from 16 to 24 pounds) & ¢ avelop 150 of 80 g/m2 (21 pounds) & ¢ avelop 1 sheet5. There they help you configure a network. A ¢ The machine has the display screen: press the (menu) button on the TheControl panel and select Network> Network Conference. For the XPS driver, it is
supported only for Windows via the Samsung Website (www.samsung.com) & ¢ & € "Page 7Features by Modelsvarity FeatureFeaturesi-Welocity USB 2.0ml-216x Seriesml-216xw 100 Series Wireless Wireless Wireless LAN 80.11b/g/n LAN Wireless LAN a € "IPV6a ¢ a4 €" IPV6a ¢ a € "IPV6a ¢ a4 €" Eco Stamping (Easy Eco Driver) tothe 4€ 4 € "a € a €"
protected Wi-Fi setup ( WPS) Prinninga Duplex (2-LATI) Printinga. A -T OUT of ITU -T indicatestelestelecomunication.ippthe Internet Printing Printing Protocol (IPP) defines a standard print protocol for printing also as the management of printing work, media size, resolution and so on. This was useful (14) What does SD mean? Ifnot, open Add new
printer guided procedure to set the device. A ¢ 4,— 4 mbers if the machine is started. The size of the files can be measured in bytes (B), Kilobyte (KB), Megabyte (MB), Gigabyte (GB), Terabyte (TB) and beyond. For Gimp Front -end, select & ¢ avelop "Print 4 € -> & ¢ 4,— &" setup Printing 4,— and modify the parameter of the command line in the
element for the inadmissible. The car does not print the pages and the output is printed on the page. It's a page. I notice that it occurs when a color machine is used in version 8.51 or before Ghostscript, 64 -bit Linux operating system, and was reported on Bugs.ghostscript.com as Bug Ghostscript 688252. The problem is solved in AFPL Ghostscript v.
Click Next. 15 If the network cable is connected, it may have difficulty finding a period when the wireless network is configured. a € for the DHCP method if the method of assignment of the IP address is DHCP, check if DHCP is shown in the window. Setsoptions such as TCP/IP e of network. Security table The card allows you to set the information on
system and network safety information. The first part of the address indicates which protocol touse, the second part specifies the IP address or the il Name in which theresource is located. Privacy equivalent wired (WEP) is a security protocol specified in IEEE 802.11 Toprorovide the same level of safety as that of a wired LAN. The Layeerse, from top
to bottom, application, presentation, session, transport, network, data connection and physical. It is usually green orrust green and has a shape of the cylinder. A imaging unit containing a drum slowly wears the surface of the drum from its printer, and should be replaced appropriately for the contact with the brush for the development of the
cartridge, the cleaning mechanism and the .originals paper the First example of something, such as a document, a photograph or a text, etc. Automatic closing phones system within a private Enterprise Command language. Standard.originally developed for early inkjet printers, PCL was released in Varivelini for the thermal printer, the Dot matrix
printer and laser printers. Format of material documents (PDF) is a format of proper files developed byadobe to represent the two -dimensional documents in a device device and resolution of the independent format device.GLossary204 Page 205GLossarypostscriptprotocolPostscript (PS) is a language description language and programming language
used in a prevalent way in the electronic and desktop publication areas. WPA-PSK generates a univocal key for each session between a wireless client and the WAP associated with more advanced safety. The Wi-Fi Protected Setup (WPS) is a standard to establish a wireless home network. Contact a service representative. Toner bit dispersion results
distributed randomly on the printed page. A ¢ avelop the paper could be too humid. For example, 00: 15: 99: 29: 51: A8 Become0015992951A8.67Click to open the TCP/IP configuration window The machine the machine automatically the network configuration. The Setip program before using the Setip program before using the STIP program before
using the STIP program before using the STIP program before using the Setip program before using the Setip program before using the Setip program before using the program Before using the Setip program, Setip disables the computer from Systempreference or administrator. The following instructions may vary from the model or from the
functionalities and optional goods may not be available depending on the model or the country (see "functionality for models" on page 6) .6Windows1Make sure that the machine is connected to the network and Poweredon. Problem resolution adjustment of the part138 changes the predefined print settings139sessing of the machine as a default
machine140 of PAPER175POWER power supply and problem of running the cable176 promote print problems. An international organization has been established to standardize and regulate international radio and communications. WEP encrypts the datagor of each package exchanged on a wireless network using a of 128 bit 64 -bit WEP encryption.
It is Portthruand the signal is the autonomous printer. So, click Next. If you want to use other ad hoc settings, select another wireless network from the list. 3the from the list. 3the Wireless network settings is displayed. The estimated cartridge life indicates the duration of the expected or estimated toner cartridge, which indicates the average
capacity of the prints and is designed pursuant to the ISS/IEC 19752. The product was designed to work with national PSTN and PBX Compatible of Europeans: in the event event, it is necessary to contact the ga euro laboratory of Samsungelectronics Co., Ltd. to prevent possible damage to the environment Ohuman Health from an unsuccessful
disposal on waste, please separate questions from other types of waste and recycle them responsible in a responsible way. Resources. The users of the houses should contact the dealer in which they published this product, or their local government office, for the details of where they can take these items for the environment for the environment. After
reading this section, keep it in a safe place for future reference. in serious or death injuries. Cheaps or unsafe practices that can cause minor injuries or damage to property. Candles, illuminated cigarettes, etc.). Cié could cause electric shocks or fires. If the machine is overheated, release smoke, maker noises or generates an odd smell, immediately
turn off the power switch and disconnect the machine. A ¢ avelop the user should be able to access the power outlet in the event of emergencies that may require the user to extract the plug. This could cause electric shocks or fires. d or position heavy objects on the cable. Staying or allowing the power cable to be crushed by a heavy oblique could
cause electric shocks or fires. Do not remove the plug by pulling the cable; Do not manage the plug with wet hands. This could cause electric shocks or fires. Introduction 10 Page 11safety Information5Causs during an electric storm or for a period of non -operation, remove the power cap from the electric exit. Methodcauron which could cause
electric shocks or fires. The paper outside during the printing may occur the burns. It can cause damage to the machine. If the machine has been deleted or if the furniture appears managed, disconnect the machine from all interface and assistance connections by qualified service staff. hand between the car and the trolley. Otherwise, there could
cause electric shocks or fires. It could be injured. If the machine does not work properly after these instructions have been followed, disconnect the machine from all interfaces and request assistance from the qualified service service. The machine reception device is the power cord. Otherwise, there could cause electric shocks or fires. fired paper or
removal of the jammed paper. If the plug does not easily enter the electric exit, don't worry about force him. Power cable from the Theelectrical Outlet. The new card has sharp edges and can cause painful cuts. When they print large quantities, the lower part of the paper area can be warm. This IP address is used to the local network and not for the
wired orwireless network for infrastructure. Close the upper cover. Avelop the paper is jammed. Verified there are several things that can cause this. Wszystkie Prawa Zastrzea ¥ ache. Then it is inserted in this View tab The list of printers in Printersconfiguration.enter LPR from the command line and Pressenter Linux Shell. Select only available card
(card without brand) .3. Also try to rotate the card of 180 A ° in the tray. The prints are dirty - Check the toner for loss. In addition to printing photos, web pages and pdfs, scan is also supported. Sometimes cycling the diet can recover the communication of the network. It receives the IP address automatically (DHCP) when the computer is configured
to DHCP. For a static network environment, the machine uses the static address when the computer is configured the static address. For example, if the computer is da A A "¢ The information on the network is shown below: a ¢ - Aentip address: 169.254.133.422. A locally connected machine is a machine connected directly to the computer using the
cable. The Binding options are, as follows: & ¢ 4 € & A A A AEUS BINDING: This option is the conventional layout Used in Bookbinding. 12345Click The question Mark on the corner of the window of the window and click on the subject you want to know. Appendice60 Page 61Specifications2Print Specifications average weight/capacity weight/capacity
ATYPESIZEDIZEDIMSIONSTRYPLAIN Paperletter216 x 279 mm (8.5 x 11 inches) Legal216 x 356 mm (8.5 x 14 inches) Folio216 x 330 mm (8.5 x 13 inches) A4210 x 297 mm (8.5 x 11.69) Otifica216 x 343 mm (8.5 x 13.5 inches) JIS B5182 x 257 mm (7.17 x 10.12 inches) ISO B5176 x 250 mm (6.93 x 9, 84 inches) Executive184 x 267 mm (7.25 x 10.5
inches) A5148 x 210 mm (5.83 x 8.27) Inch) monarch envelope98 x 191 mm (3.87 x 7.5 inches) envelope n. 10105 x 241 mm (4.12 x 9.5 inches) envelope envelope DL110 x 220 mm (4.33 x 8.66 inches) Ilivery C5162 x 229 mm (6.38 x 9.02 inches) 85 g/m2 (from 19 to 23 pounds ) Manual power supply from 71 to 85 g/m2 (19 bond 23 pounds) a ¢ avelop
1 sheet & & mbers 150 sheets of 80 g/m2 (21 pounds) from 75 to 90 g/m2 (from 20 to 24 lbsbond) from 75 to 90 g/m2 ( from 20 to 24 24 Bond) & ¢ avelop 1 sheet 4 AA 4 4 4 € 10. The Chapter of Featureshis Special explains the special printing characteristics. avelop Altitude regulation138 & A A A € the predefined printing settings139 is avelop the
machine setting as a default machine140 using advanced printing characteristics141 a € use of direct printing use (Windows ) 149 Use of memory memory /characteristics of the hard disk150'" a establish macintosh printing151 a ¢ Linux printing1534 ¢ da a ¢ Unix Printing155 The procedures in this chapter are mainly based on Windows 7. Refer to
the label of the label of the system to verify the presence of Wirelessdevices. wireless devices. For use in the United States of America if an ID FCC number is on the system label. Appendice71 Page 72 Regulatory information The FCC has set a general 20 cm (8 -inch) separation guideline between Thedevice and the body, for the use of a wireless
device near the body (it does not insult the extremities). Problem resolution to avoid paper jams 51 for jam paper 52 Understanding the LED555 state. Special features155 Page 156unix PrintingMargins The Duplex Tabautomatic/Manual print may not be available according to the models. It also provides an authenticated inter-process communication
mechanism. SMTP (SMTP) of SMTP (SMTP) is the standard for Electronic Electronic Transmissions on the Internet. More dpi are in more sharp prints. IPX/SPX has been designed mainly for local networks (LAN) and is a very efficient protocol for this purpose (generally its performance exceeds that of TCP/IP on a LAN). Isothe International
Organization for Standardization (ISO) is an international standard -Corps consisting of representatives of the bodies of national standards. Clean the interior of the car (see "Cleaning the machine" on page A ¢ The card path may be necessary to clean. It is necessary to wait 2 minutes to reconnect to the wireless network. Some menus may not appear
on the display according to the Ormodel options. Remove the cartridge and e It.a ¢ avelop the toner cartridge can be defective. An IPM rate indicates the number of single sheets that a printer can complete within a minute. Ippthe Internet Printing Printing Protocol (IPP) defines a standard protocol for printing and management of printing work,
media size, resolution and so on. Your machine should start communicating in wireless modalities with the network. Because wireless devices (which can be incorporated into the printer) emit a lesson of what is allowed in radio frequency safety standards and returns, the manufacturer believes these devices are safe for use. EAEA/EFTAS countries.
But /h, /h or /? The toner can be melted from the umbrence of the heat/pressure from the spindle, causing the bond to the fibers in the document. GLOSSARY206 PAGE 207GLOSSARYWAINWARKANKAN STANDARD FOR SCANNER AND SOFTWARE. The airports, hospitals and atmospheres loaded with flammable oxygenor gases are limited examples
in which the use of devices in 4 € 4 € 4 € «<white can be limited or eliminated. Go to a Cafa © repair for free repair services. Reinstall the printer driver. A’AGE General Protection "," Exception oe "," Spool 32 ", or". A "fail to print", "a printer error has occurred." Remove this adhesive to make sure that the ink can leave the cartridge. In some cases, the
white stripes or the light print will still occur even after redistributing The toner. & avelop before opening up the upper cover, close first the output support. & avelop fabrics and washes in cold water. It is therefore necessary to replace the fuse cover. Different brand of paper. A A A A € The paper of paper is bad. Choose the method setting from the
following table. Some wireless networks The types may not be available according to the model or the country. Method of assignment by the Machine Centrol panel, WPS connection method (recommended) Description and reference "See" Machines with a display screen "on page 108." See "Machines" without a display screen "on page 109. () Use of
the Menu button (& ¢ avelop" See "Use of the menu button" on page 110.) 2. You can order cartridges for Spare toner from online. Click the HELP button () from the upper right corner of the window and click on any option you want to know. And about 63thebutton is used to change the user interface in advanced user interface settings. Connections
Quick display quick connections to the specific functions of the machine. If you do not know the environment of your wireless, ask the person who set up your network. Machine network settings by printing a network configuration ratio. Before starting the configuration of the Wireless parameters, check the Connectionstatus cable. See "Print a
network configuration ratio" on page 90.2. Using a machine connected to Rete129 Page 130 Wireless Network Setupl2check regardless of whether the network cable is connected to the machine or not. Some machines do not have this functionality. Reference supplies click on the order button from the supply supply. For example: if more thick paper
is selected, but the normal paper actually used, an invorchtingcan occurs causing this problem of copying. Resolution of problems184 Page 185 Printing Problems Problems -Conditionsughges Solutions Informed characters - If the characters are formed improperly and produce cave images, the paper stock could be too smooth. Refer to the section If
you want to set or change the values. If this situation occurs, verifies, To release the door by selecting the release door in the door configuration window. Report to the Linux User's guide provided with the computer for more information on Linux.5 error messages. Problem resolution191 Page 192 Operational System Problems 4common Postscript
Problems The following situations are specific to the PS language and can occur when more printer languages. Problems The postscript file cannot be an impression. "On page 82) .'"Ha ¢ avelop a configuration page and verification that the PS version is available for printing. It may be necessary to reduce the complexity of the page or install more
memory. A Postricpt Error page. Printing work may not be postscript.Thite certain that the printing work is a postscript job. Select the name (SSID) of the access point you are using and click Next. Using a machine connected to Retel12 Page 113 Wireless Network Setupif is not possible to find the network name you want to choose or if you want to
toset the wireless configuration manually, click Advanced setting. The wireless network safety window is displayed when the hassecurity settings. a ¢ enter the name wireless network: enter the SSID of the access point (SSID is sensitive to chance). The security window of the wireless network is displayed. So, click Next. S And the software was
unable to search in the network, check if the USB cable is correctly inserted between the computer and the machine and follow the instructions in the window. 2. Using a machine connected to Rete111 Page 112 Wireless Network Setup A A A 4 A 4 A 4 A The Wireless configuration method window. A avelop for models that support the WPS button
(without a USB cablonnection), the window shown below will be displayed. A ¢ avelop manually configure the wireless settings.: Go to passage 8.4 ¢ avelop wireless settings by pressing the WPS button on the Theaccess point. (or wireless router). Follow the instructions in the window. (Automatic setting or 2412 MHz at 2467 MHz). Select the wireless
setting and installation option. A ¢ avelop authentication: select a type of authentication. Opening system: authentication is not used and encryption can be used, depending on the data security need. Shared key: authentication is used. If you select this setting, the spool printer of the Docuhe Hard Disco document and then print it from the tail of the
hard disk, decreasing the computer workload .- Print program: select this setting to print the document at a specified moment. ¢ & ¢ avelop User ID: This option is used when you need to find a saved file using the control panel. A ¢ 4, A A A WORK name: this option is used when you need to find a saved file using the control panel. This option is not
available when using the XPS.3 driver. Special features148 Page 149 direct printing utilities (only Windows) 13 What is direct printing utility? From the start menu select programs or all programs> Samsungprinters> direct printing> direct print utility. The direct printing window appears. that sends PDF files directly to the Machineto print without
having to open the file. A check mark in this program when installing the printer driver .2 Set your computer from the Drop of Select Printer- List of Down and Clickbrowse.3 Select the file you want to print and click Open. The file is added to the Select Files section It should be installed on Yourmmchine, to print files using this program. SD cards are
the standard storage medium for many digital cameras. Do not clean the car with benzene, paint more thin or alcohol; Do not spray the water directly in theme. This could cause electric shocks or fires. When working inside the machine, replacing the supplies that they edge the interior, do not use the machine. You could hurt yourself. If the car is not
well ventilated, it could cause fires. Continue to clean the supplies away from children. The car should be connected to children could get hurt. The level of power that is specified on the label. If you don't be sure and you want to check the power level you are using, contact the electrical service company. A. AWG: American Wire Gaugedo do not
disassemble, repair or reconstruct the machine alone. It can damage the car. See the help screen of the printer driver. A combination of faded or smeared defects can indicate that the toner cartridge needs cleaning. Special features144 Page 145 Use of advanced printed printed features AdvancescriptionPaper changes the dimensions of a document
to appear larger or small on the printed page by inserting in a percentage with which to enlarge the ordering the document. Narkarch. Otherwise, clickfinish.ad hoc via USB cable you do not have an access point (AP), it is still possible to connect the machinewireless to your computer by setting an ad hoc wireless network following the simple steps
below. Click when the confirmation is displayed the printer connection window. Prepare a new cartridge cartridge. WEP encrypts the datagor of each package exchanged on a wireless network using 128 -bit 128 -bit WEP encryption key. Authentication: select a type of authentication. Opening system: authentication is not And encryption can be used
or cannot be used, depending on data security need. Shared key: authentication is used. Due to the DHCP Thecaracteristic, the allocated IP address may change if the theme is not used for a long time or if the access point has been restored. Record the Mac address of the product when the DHCP server is confused the access point (or wireless
router). Appendix This chapter provides product specifications and information relating to applicable regulations. & € Specifications 59 avelop regulatory information 68 avelop Copyright78 Page 59specifications1 specifications the values of the specifications listed below are subject to changes without notice. Click Next. If the press trial page
correctly, click on it. If not, click NO to reprint it. The car starts connecting to the wireless network. Appendice78 Page 79User Guidml-216x Seriesml-216xw SeriesaSadvancedvanced This guide provides information on installation, advanced configuration, operation and resolution of problems on various environments of the operating system. Some
characteristics may not be available according to models or countries. Basicthis guide provides information on installation, functional functioning and problems resolution. SMTP is a relatively simple and text based protocol, in which one or more recipients of a message are specified, so the text of the message is transferred. Fdiforeign Device
Interface (IDI) is a card installed inside the machine to allow a third -party device such as a toothbid device or a card reader. Refer to the quick installation guide to connect the output to the machine. The software CD contains printers and software applications. Various accessories included machine may vary according to the country of purchase and
specific model. Introduction15 Page 16machine panoramic10 View Frontal & A A A 4 A € This illustration can differ from the machine depending on its model. A ¢ avelop some functionalities and optional goods may not be available On model or country (see "Features for models" on page 6) .45321Control Panel3tray5output Support2Tray
Handle4output tray6top cover7ton Carturdsl. Ina corporate intranet, it may be necessary to have this information assigned bya Network Manager before proceeding. Find the Mac address of the machine from the network configuration ratio (see "Print a network configuration ratio" on page 90) and insert it without the two points. These limits are
designed to provide reasonable protection against harmful interference in residential installation. Specifies the overlap of the poster in millimeters or thumbs by selecting the option button at the top right of BasicciB to make it easy to glue the sheets. Meta after the printing of the Toproduce a booklet. Booklet Printinga89 If you want to create a
booklet, it is necessary to print on the letter, lawyer, A4, American or printing folio of Ophic dimensions. The opuscule printing option is not available for all the size of the paper. Avoid printing on both paper sides when you are printing more than 1 copy. The printing on both sides of the paper functionalities may not be available according to the
models or options. IFNOT, connecting the machine with a standard network cable. 7 SSID: SSID (identifier of the service set) is a name that identifies wirelessneetwork, access points and wireless devices that try to connect to a specific wireless network must use the Ssid himself. Given Chezone it is more heavy in the air, keep the product in a place
with good ventilation. Appendice68 Page 69 Regulatory information79power Saverchina Only the printer contains advanced energy conservation technology that reduces energy consumption when it is not in active use. When the printer does not receive data for a long period of time, energy consumption comes lowered. Energy energy star and the
sign of energy are U.S.MARKS registered for more information on energy on energy Program See http: //www.energystar.govfor Energy Star Certified Models, the Energy Star label will be your car. By default, the margins are known. The laser system and the printing are designed so that there is never human access to the class I level I of laser
radiation during normal operation, user maintenance or prescribed maintenance service. It is very popular, as it is a computer or network that allows access to another computer or network. Grayscalea shades of gray representing portions of light and dark of an image when the color images are converted into gray scale; The colors are represented
by various gray tonalities. Halftonean image type that simulates the gray scale by varying the number of points. A pdf file can archive a large data variety, including formatte text, vector graphics and raster images. Instrukcjaoobslugipdf.pl Zapewnia, & aisten to Szybko Znajdziesz Instrukcja A A A A 4, kta £ &%rej szukasz. To print more than a sheet for
sheet, the pages will be reduced to size and arranged in the specified order. Page 6Features for models of optional characteristics and goods may not be available according to the model or the country. Systemoperante System ML-216X Seriesml-216xw Serieswindowsa ¢ 4 € "4 € 4 €" Macintosha ¢ a€ a4€ ¢ a € "Linuxda ¢ a€" d a4 € a € "ML-216X
SERIASML-216XW series. ¢ & € "drill it of the xpsa ¢ 4 €" 4 € 4 € A € "Samsung Easy Printing Managera ¢ 4 €" 4 € 4 € "UnixFOFTWARESOTWAREPCL PRINTER DRIVERSPL Driverps DriversyNCTHRUHrua ¢ &4 € Za ¢ Servicea Web. 30.000 pages. For example, 00: 15: 99: 29: 51: A8 Become0015992951A8. Find the Mac address of the machine from
the network configuration ratio (see "Print a network configuration ratio" on page 90) and enter with shots. A file size is the measurement of the space that a file takes on a medium of storage like a hard computer disk. Open the driver configurator and moves to the printers tab in the configuration window of the typographers to look at the of available
machines. Remove the cartridge and reinsert it. The IPP can be used on the internet to the internet with hundreds of printers and also supports accentication, authentication and encryption, making it a very much capable and secure press solution compared to the older ones. For Facsimiletransmissions.IPX/SPX]JBIGIPX/SPX documents, it is for the
exchange of internet packages/exchange of sequenced packages. It also contains information on the layout of the page, which define the position of each element on the page, as well as the size and shape of the pages in the document. Appendice66 Page 67specifications4Network EnvironmentNetwork and only wireless models (see "functionality for
models" on page 6). You have to set the network protocols on the machine to use it as a network machine. Use of a machine connected to Network124 Page 125 Wirelse fetting dirty 10select setting using the WPS button and click Next.12 Follow the instructions in the window to set the wireless network. A avelop -4 seconds. Button (WPS) on the
machine control panel awaits up to 2 minutes for the WPS button on the Theaccess point (or a router) to press. Brocked the WPS button (PBC) on the access point (or wirelessrouter wireless; the machine is connected with a USB cable, the above window does not appear. Drawing the print printing function and retry the print. Print PDF files limited
by a password. Learn UsageAvailable Supplies of Base39 Avalutable Maintenance Parts 40 Storeding The Toner Cartidge41 Redistributing Toner43 Replacing The Toner cartide44 Clears the To move and keep your machine494. To avoid that, block the WPS option for current wireless security settings. It is possible to save the settings used frequently
as an apreset. Available only for users of the Windows operating system. How to use: 1 open a document to print. 2 Print the document. The preview window appears. 3 Select the options you want to apply to the document. You can view the preview of the functionalities applied. 4 Click Print.4. Useful management tools159 Page 160andersanding
Easy Capture ManagecaPure your screen and start Easy Capture Manager simply by pressing the screen of the print screen on the keyboard. The machine and the number of tonalt cartridges shown in the window above Maydiffer depending on the machine in use. To eliminate the saved settings, select it from the option of Drop-The Presets of
Presets, which is visible on each preference tab except for the Thesamsung tab, allows you to save current preferences for future use. To save a preset element, follow these steps: 12Down lists and click (delete). You can also restore the predefined settings of the printer driver by selecting the default preset from the Preset Descent List. Change the
settings according to need in each card. Be careful a name for the element in the preset input box .9 I use the option you want to know on the print preferences window and press F1 on the keyboard. (Add). ANMARK means that you can select that Certoption but it is not recommended and ANMARK means that it is not possible to select this option
due to the setting or the environment of the machine.123 you can check the current status of the machine using the status button of the printer (see "use of the state Samsung printer "on page 167). Open the document you want to print. Select the printing from the File menu. Select the machine from the printer Select. 2 (update), the settings will be
added to the presets made. To help in the use and application of terminal equipment that that With this standard, the Europeancommunication Standards Institute (ETSI) has issued a consultancy document (for example 201 121) which contains additional notes and requirements for the compatibility for the realization of the TBR21 terminals. In the
first place. The product was tested against TBR21. Therefore, the user must maintain a minimum distance of 20 cm from the antenna at any time. A pop-up window appears with information on the option, which is provided by the driver. From the Macintosh application, select Print from the file menu. Select the layout from the orientation drop -down
list. Select a binding orientation from the two-side side option. Select the other options to use. First -rate and printing machines on both sides of the paper. 3. Special features152 Page 153 Linux The printing functionalities may not be available according to the models or options. If the wireless access point supports WPS, you can easily configure
wireless network connection without a computer It has advantages for portable electronic documents and documents, developed by Microsoft. Initially it used cooperative multitasking to perform various services on a PC and network protocols were based on the archetypal XNS XNS stack. WEP provides security by encrypting the data on the radio so
that it is protected as it is transmitted from one final point to another. Wiawindows Imaging Architecture (WIA) is an imaginative architecture originally introduced in Windows Me and Windows XP. A shared, or password key, is configured at the wireless access point (WAP) and in any wireless laptop or desktop devices. Turn on Print as an image from
the Acrobat printing options. It takes more time to print when yes A PDF file as an image. Some letters are not normally displayed the cover print. cover. page. Contact a service representative. The size of the document is so great that the rigid computer discs is insufficient to access printing work. Excellent more space on hard drive and print new
tray, the car resumes the print. The machine selects Printmaterials with a wrong source. Opening of the print preferences "on page 35). Select the correct paper source. Contact your sales representatives to obtain the list of available supplies and maintenance parties. To order supplies, accessories and maintenance parts authorized by Samsung,
contact the local Samsung dealer or the dealer where you purchased the car. You can also visit www.samsung .com/supplies, then select your country/region to get contact information for the service. Maintenance38 Page 39 Services available when The supplies reach the end of their duration, you can order the following types of supplies for the
machine: Taketoner Cartdgeavere Hedingaepropprosse. Press the button on the printer and will be connected to MobileDevice. Supports WPS, you need to insert the "network button" of a printer instead of pressing the WPS button. Conconnecting error - SSID NO N found ... the car is not able to find the name of the network (SSID) that you have
selected Orenthered. Make sure that the paper level is below the sign of paper skills inside the tray. A Avelop not remove the paper from the tray while the machine is printing. A avelop not use folded paper, humid or highly curled. A avelop not mix the types of paper in a tray. Use only recommended printing media (see "specifications of print media"
on page 61) .4. The brands, and manufacturers of devices, software, etc. Close the lid. Resolution of the problems of this chapter provides useful information on what to do if an error occurs. a € a € To avoid Jams51 of Jams52 Jams51, cancel the machine has a display screen, check the message on the screen first to solve Theerror. Wireless devices are
strictly regulated and use may not be Beallow. The powering output of the wireless device or devices that can be incorporated inypter is well below the RF exposure limits as well as known at this moment. This was useful (18) Which card thickness can I use the best in my printer? If the machine is connected to a network, jump the following steps
below and continues to installation of the driver of a machine connected by the net (see the installation of the driver on Network93). Installation for the installation of macintosh83 for macintosh84 & ¢ avelop linux85 & ¢ avelop reinstallation for Linux87 a ¢ a establish if a user of OS Windows is, refer to the "installation of the Driver locally "on page 21
for the car driver. Use only a USB cable not more than 3 meters (118 inches). And the name of the machine in print using.Click continues on the user options box. Your machine is displayed in the list of printers and is set as a defaultmachine.click installation. Try a different type or a paper brand. A ¢ changes the printer option and try again. Learn the
basic use29 Page 30media and tray print an envelope, place it as shown in the following figure. A dvelop not to use stamped envelopes. Avelop not use bags with clips, snaps, windows, coated coating, self -adhesive gaskets, or other synthetic materials. A ¢ avelop not use damaged or scarcely made envelopes. An adhesive strip with peel-offs or with
more of a flap that is wandering to seal must use stickers compatible with the melting temperature of the machine for 0.1 seconds (about 170 & ° C (338 & A ° F)). These options are specific for the printer and depend on the PPD.Text Tabset file the margin of the characters, the space of the lines or the columns of the actual print output. To print all
the graphics in black. A ¢ 4,— & ¢ Fit Plot on the page: adapt to the entire graphic on a single page. 3. Special features156 Page 1574. Generally, a higher DPI translates into a high resolution, more visible in the image and a larger file size. Detection of the Dimmdistinctive ring pattern. Unlike the parallel port, USB is designed to simultaneously
connect a single -computer USB port to more peripheral. Watermarka watermark is an image or a recognizable paper model that appears slightly if displayed by the transmitted light. Use of a machine connected to Network114 Page 115 Wireless Network Setup of the Network (SSID): the default network name is the model and the maximum length is
22 characters (it does not include "Direct-XX-"). A 4, & A A A a e is the network key is the network key is the network key is the network key is the network key is the network key is the key key is the network key is the network key is the network key is the NEGNICAL STRUCK key and the size is 8 ~ 64 characters.12 When the wireless network is
completed, disconnect the USBCABLE between the computer and the machine. It is necessary to insert a password to print.- store: select this setting to save a document in the hard drive without printing .- Store and printing: this mode is used during printing and document storage simultaneously. useful when they manage large quantities of data. If
the router is far from the car or there is an obstacle, you may have difficulty receiving the devil. Avelop the power for the access point (or wireless router), machine and computers. Allwireless devices in a WLAN use the same SSID to communicate with others. Supplies and accessories for maintenance and accessories382 Page 31. Hot water puts the
toner in fabric. Thoroughly, the initial print quality increases. & € Do not touch the lower green part of the toner cartridge. Use of a network for the network connected to Network123 Page 124Wireless Network Setup avelop of the Network (SSID): the default network name is the model and the maximum length is 22 characters (not including "Direct-

XX-"). A4 aAAAaéis the network key is the network key is the network key is the network key is the network key is the network key is the Net key is the network key is the network key is the network key is the network key is the network key is the network key is the Numeric string key and the size It is 8 ~ 64 characters. A ¢ avelop software that
has been supplied with your machine & A A A A A machine installed with an interface wireless network that interfaces the infrastructure network1718 when the wireless network settings are completed Machine.Wireless Network Semption is completed. Its main activities include standardization, allocation of the radio spectrum and the organization of
interconnection agreements between the different countries to allow international telephone calls. Today Newaresupports TCP/IP and IPX/SPX.open Systems Interconnection (OSI) is a model developed by the internationalization for standardization (ISO) for communications. All rights reserved. This user guide is provided only for information
purposes. Using a twain-compliantscanner with a twain compliant program, a scan can be started from inside the program. The transition between the two interfaces is simple: just click on Clickbutton. only available for Windows or Macintosh OS users. & € for Windows, Internet Explorer 6.0 or higher is the minimum requirement for Samsung Easy
Printer Manager. Program: For Windows, select Start> Programs or all programs> Samsung printers> Samsungeasy Manager> Samsung Easy Printer Manager. 1 List of printers The list of printers View printer icons installed on YoucomPuter.For Macintosh, open the Applications Folder> Samsung Folding> Samsung Easyung Printtermanager.4.
Useful management tools164 Page 165 Using Samsung Easy Printing ManagerpinterInformation The Haga Haga Information on Yourmochine. Generally the printer has the limitations of the duration of life like pages per year. The duration of life indicates the average capacity of the prints, usually within the period of availability. Bootp allows
"Disklessworkstation" computers to obtain an IP address before loading any advanced system. The toner is a dust used in laser printers and photocopiers, which form the text and images on the printed paper. Check the power switch and the power source. The car is not selected as a default machine. Select the machine as a default machine in
Windows. Check the machine for the following: a ¢ avelop the upper lid is not closed. The Mac address is a unique 48 -bit identifier usually written as 12 hexadecimal characters grouped in pairs (and. The selected pdf file is sent to the machine. As the PDF file was created. Using the right click "the" Direct print utility program supports the PDF 1.7
and lower version. For the upper versions, you need to open the file to print it. 1 Right-Click on the PDF file to print and select the direct printing. The utility window is added Direct printing with the PDF file. Manual imitation capacity power supply in the warehouse, legal, OB SICK, US FOLO, A4, JIS B5, ISO B5, Executive, Abrefer in the Section of
Simple Card section, Legal, Obbita, US Folio, A4 , Jis B5, ISO B5, Executi VE, A5, refer to the simple paper from 1220 to 150 g/m2 (from 32 to 40 LBS) from 120 to 150 g/m2 (32 to 40 pounds of bond) is & = a ¢ 1 sheet - 10 sheets from 121 to 163 g/m2 (32 (32 (32 (32 to 43 lbsbond) from 121 to 163 g/m2 (32 to 43 1 Legame iBBre) is a,— a ¢ Paperrefer
to the plumber section of the simple paper section - 10 sheets - 1 sheet of sheet of sheet in pinnper section to the normal paper section - 60 sheets of sheets of sheet (custom) 76 x 127 mm (3 x 5 inches) 60 to 163 g/m2 (bond from 16 to 43 pounds) maximum size (personalized) 216 x 356 mm (8.5 x 14 inches) a. It is recommended to replace the toner
cartridge (see "replacement of the toner cartridge" on page 44). Toner offall cartridges are normal skills. The machine is connected to a wireless network. The machine is connected to a wireless network (see "using" the WPS button "on page 107). Off the machine is disconnected from a wireless network. The machine is in power rescue mode. The
machine is in Ready modality or the power supply of the machine is off.orgebluabluea. Go to print preferences, click on the paper tab and set the type of paper on recycled (see "opening of print preferences" on page 35). & ,A ¢ Make sure that the type of correct paper is selected. Remove the paper from the tray and recharge it correctly. A & ¢ There is
too much paper in the tray. /Pere LPT1: & ¢ 4,—, /p 4,— hostname is avelop during the installation of the Dryrile in Korean, type Insut.exe /s /1 "0x0012& ¢ avelop .2. Otherwise, the interior of the machine can be contaminated by the toner, which can cause damage to the machine or reduce print quality. A 4&velop when moving the car, make sure at least
two people keep the car firmly. 3. Maintenance49 page 504. The filigree were introduced for the first time in Bologna, in Italy, in 1282; They were used by paper producers to identify their product, and also on stamps, currency and other government documents to discourage counterfeiting. Privacy equivalent wired (WEP) is a security protocol
specified in IEEE 802.11 to provide the same safety of that of a wired LAN. Take a cotton swab and dip it in hot water Luke. Since most of the faxs mainly consist of white space, there is minimizing the transmission time of most faxes. If it is DHCP, TCP/IP Clickchage to enter the IP address and other network configuration values for the machine. For
example, if the information on the computer network is shown as follows: -IP Address: 169.254.133.42 Mask: 255.255.0.0Thenhen Theng, information on the machine network should be shown below: -IP Address: 169.254.133.43- Subnet Mask: 255.255.0.0 (Use the sottorete of the computer's sottorete.)-Gateway: 169,254.133.1 When the window says
that the mixture of the network cable connection says, disconnect the network cable and click on Next. The wireless network connects according to the network configuration. The configuration of the wireless network is completed. Cleaning the interior of the machine erases and reduces these problems. 3. Maintenance46 Page 47 Clearing The
machine uses a dry cloth without a flour to clean the car. A ¢ If the machine has a power switch, turn off the power switch before cleaning the machine. In addition, on average, laser printers work more quickly of ink jet printers. The name of the car, which appears in the window owners of the printer, can differ according to the machine in use. A ¢
Some menus may not appear on the display according to the options or models. The following section is a general overview of the considerations during the management of a wireless device. Limitations, deposit and concerns for specific countries are listed in the specific sections of the country (or sections of the country group). Information on the
plot such as IP address, host name, e-mail address and SMTPSERVER information, the status of the machine (deficiency of cartridges for toner or macherror) will be automatically sent to the e-mail of a specific person. The format of Unc route is: \\ \ \ Urluniform resources levator (URL) is the global address of documents and resources on the Internet.
If the computer has more than one door, make sure the car is connected to run. run. It can be configured incorrectly. Check printing preferences to ensure that all print settings are correct. Problem resolution177 Page 178 Propting Problem Condition The machine does not print.Then, click Next.2. Using a machine connected to Retel15 Page
116wireless Setup5Select Network using the WPS button and click Next. Follow the instructions on the window to set the wireless network. Avelop for models with a display screen, follow the steps below. Assumption and hold on the 2 -4 seconds. Button (WPS) on the machine control panel awaits up to 2 minutes for the WPS button on the Theaccess
point (or a router) to press. Bold the WPS button (PBC) on the access point (or wirelessrouter wireless; the machine is connected with a USB cable, the above window does not appear. These devices allow the pay-for-print service on your file transfer protocol (FTP) of a protocol commonly used for the exchange of files on any network that supports the
a € e a€ a<€ e TCP/IP protocol (such as Internet or an intranet). By combining the part of an laser printer that merges the toner on the support of printing. Do not remove the Mouldedplug. If the wires in the network cable do not correspond to the colors marked in the plug, which follow: it is necessary to connect the green and yellow thread to the
pin marked by the letter "and by the" safety "symbol of earth" or colorful green and yellow or green. You have to connect the blue thread to the pin which is marked with the letter "n. The brown wire on the pivot which is marked with the letter & ¢ 4,— & "1" or colored red. You must have a 13 amp fuse in the plug, adapter or in the distribution form.
Appendice73 Page 74 Relating information ectserserel7 Declaration of Compliant € (European countries) approvals and certifications-with this Samsung Electronic? Puced atwww.samsung.com, go to Support> Download Center and Entery Printer (MFP) Name to browse the Eudoc.11 January 1995: Directive of the Council 2006/95/EC approximation
of the laws relating to Member States relating to low voltages with low voltage Equipment.11 January 1996: Council Directive 2004/108/EC, approximation of the laws of the Member States relating to electromagnetic compatibility. Search for 1999/ 5/CE Radio Equipment & Telecomunications Termhi Nastaquipment Directive (fax) This Samsung
product was self-certified by Samsung for the Pan-European terminal connection with the Analogue public telephone network (PSTN) in accordance with Directive 1999/5/EC. Hot water puts the toner in fabric. 123. - which is performed in an interpreter to generate a program drilling it. Scanner, a fax or, a photocopier. Appmpages per minute (PPM)
is a measurement method for determining the speed with which a printer works, which means that the number of pages that a printer can produce in a minute. Filean for a device driver, this allows software to interact with the Driver using standard input/output system calls, which simplifies many activities. Do not store on the floor. This is partly due
to the thickness of the photo paper. Using a machine connected to Rete107 Page 108 Wireless Network Setupmachines with a screenconconnecting display in PBC ModelPress and keep the second button2 seconds. (WPS) On the control panel for more of The Machine, start waiting for up to two minutes until you press the WPS (PBC) button on the
access point (or wireless router) .2Connecting in PIN ModelPress and hold the button pressing 2 seconds. (WPS) On the control panel for more of 2 eight -digit pins appears on the display. It is necessary to insert the eight -digit PIN inside two for two figures inside two for two figures inside two for two figures inside two for two figures inside two for
two figures all Interior of two for two figures inside two minutes on ThecomPuter connected to the access point (or wireless router). The messages are displayed on the screen on the display in the following order: press the WPS button (PBC) on the access point (or wireless router) .Connecting: the machine is connecting to the wireless network. The
messages are displayed on the screen on the display in the following order: Bconnected: when the machine is correctly connected to the wireless network, the LED WPS light remains on. Ecting at the access point (Orwireless router) .Bconnected: When the machine is correctly connected to the wireless network, the LED WPS light remains up. LCD
Display.Cap SSID: After completing the wireless network connection process, the SSID information is displayed on the display. Using a machine connected to Rete108 Page 109 Wireless Network Setupmachines without a screenconconnecting display in PBC FodelConnencting in modal modelin Ready, press the button (cancel or For more than Five
Seconds on the control panel. Press and hold the (WPS) button on the control panel for about 2 - 4 seconds until the status LED flashes quickly. The car without Thethe Thethe Start connecting to the wireless network. Set the printer in thiswindow according to the following steps: 123456789101112Specificing any description of the printer in the
description field. It is possible to verify that the controls, such as the remaining quantity of Toner. Its main activities include standardization, the allocation of Theradio Spectrum and the organization of interconnection agreements between acting countries to allow international telephone calls. This was useful (13) Home> Printers & ¢ a2 Samsung a ¢
a2 Samsung ML-2165W Manual / User Guide This is the official user guide Samsung ML-2165W in English provided by the manufacturer. Click Next. After the selection of the components, you can also change the name of the machine, set the machine to be shared on the net, set the machine as a Efault machine and change the name of the door of
each machine. The owner of the group acts similarly to a wireless access point. /Install the Canda Canda Canda to check the installation results. Set the printer in this window that refers to the following procedures. A little UNIX operating system, for example on Solaris 10, only added printers may not have been skilled and/or not to accept jobs.
Current aeronautical regulations require that wireless directors be deactivated & € ce 4 € 4 € while traveling in an airplane. The heavy paper is ticker and more robust. However, the composition of the printing window window is similar. A ¢ When selecting an option in printing preferences, you can see an Awarning marker. Join the discussion / ask
your questions the information on this website is not guaranteed. The following information is only suggestions based on the weight of Theunits. Use of controls or adjustments or performance of the procedures, to other people In this document, they may entail an exposure to dangerous radiation. If you have a medical condition that prevents lifting
lifting, do not lift the machine. The window can differ in its safety modality: WEP or WPA. A ¢ WePselect Open System or shared key for the And insert the security key TheWep. Nasza Baza Danych Zawiera Ponad million Instrukcji PDF or Ponad 10,000 Marek. A scan can be started inside these operating systems using a scanner compliant with

Wia. WPAWI-FI PROTECTED Access (WPA) is a class of systems to protect wireless computer networks (Wi-Fi), which was Created to improve security features of WEP If this is not the manual you want, please contact us. Is your product defective and the manual does not offer solution? When the complaint is issued, the device prints an entire set
before printing additional copies. A Duplex power supply of Duplex documents (DADF) is a scan unit that feeds Wilautomatically and turn an original paper sheet so that the scan of the machines on both sides of the paper. The control panel control panel is a flat area, generally vertical, where control or monitoring tools are displayed. The printer
driver files do not remove from the system. 2. Using a machine connected to Rete95 Page 96Installing Driver on Network7command- Line/D/D/VHE ¢ & establish & ¢ avelop/Va ¢ & establish & A establish/ Or ordiniscriptionuninstalls all devicedrivers and applications from your applications. System. This command removes the drivers of installed devices
and the application software from System.shares Machine and add other platform drivers available for Point & Print. Installe all the Smachine drivers of the OS platform supported by SupportWindows for System and share it with For Point and Print. /Oopens printers and the Faxes folder after installation. Command open printers and faxes follerafter
the installation silence the Systemted folder if not specific folder./h, /h or /? Comanda-Linee.macintoshlmake show that the machine is connected to the network and powerdon.2345678inert the software cd supplied in the CD-ROM.9Click unit continues on the user options box. on your Macintosh desktop. The Mac installer folder> Install OS X



icon.Click continues. Read the license agreement and click Continue. Agrees to accept the license agreement. When he warns that all applications will close on Youcomputer, click Continue. If the IP address has not yet been set, click the IP address and refer to "IPV4configuration via Setip (Macintosh)" on page 91. It is also possible to print reports,
such as Anerror, Report. A ¢ avelop active notices: shows the notices that occurred in the machine and their settings. & € supplies: show how many pages are printed and the quantity of toner left in the cartridge. 4. Useful management tools161 Page 162using Syncthrua ¢ 4 € & Z4 ¢ Web service meters: shows the counting of use for printing types:
Simplex and Duplex. Maintenance of current settings maintenance: Show the information on the machine and the network. Information: Print Report as Report relating to System and Spertreport. This card allows you to keep the machine by updating the firmware and setting the contact information for sending E -Mail. Having verified the largest
difference between these two types of printer is technology. Contact a service representative. 5. Resolution of the problems186 Page 187 Printing Problems Problemscondationloose solutions of tone &, & ¢ clean the interior of the machine (see "Clean the machine" on page 46). Avelop the type of paper and quality controls. Avelop (see "replacement of
the toner cartridge" on page 44). If the problem persists, the machine can request repair. You do on Next. Otherwise, click Next and go to the passage 18.17 If the test page is printing correctly, click on Sa—.IF Sa—.IF Click no to reprint it.18 If you want to record the machine with the Samusng website and useful information, click on the online
registration. Clean the inside of the machine (see "Cleaning the machine" on page 46). If these steps do not correct the problem, contact a service representative. Problem resolution182 Page 183 Printing Problems Problemsconditionverts LinessageSegested Solutions if the black vertical stripes appear on the page: a ¢ avelop the surface (part of the
drum) of the toner cartridge inside the machine was probably scratched. Click Add to Toadd class to a specific class or click Remove from the Toremove class from the selected class.15 Configuration of the Printer properties that use the printer owns window supplied by the printed configuration, you can edit The various properties for your car as a
printer. The Printer ownership window appears. A ¢ General: allows you to change the position and the name of the printer. Unlike the parallel port, USB is designed to simultaneously connect a single USBPORT computer to more peripheral. Wi-Fi Protected Access (WPA) is a class of systems to protect wireless computer networks (Wi-Fi), which was
created to improve the safety of Wep.GLossary207 Page 208GLossarywpa-Pskwpa-Psk (pre key -Travise WPA) is a special WPA mode for Small Business Orhome users. If "Oralw" is specified in the control row parameter, then you remove to print correctly. Using a machine 106 page 107 wireless connected to the network. It can easily configure the
wireless network settings via the (WPS) button on the control panel without a computer. A ¢ If you want to use the wireless network using the modality Make sure the network cable is From the car. Using the WPS button (PBC) or by entering the PIN from the computer to be connected to the access point (or wireless router) varies according to the
point (or wireless router) that is being used. This was useful (115) What is the difference between a jet of ink and a laser printer? It is possible to start the silent installation of typing /s or /s in the command window. Silent installation definition. The name of the printer door can be optimized as an IP address, host name, USB local portion or ieee1284
portnce./s/paasti name> & ¢ avelop/for the name > A ¢ &,— the network port is created by Use of the standard use of the standard used by the standard used by the standard used by the standard used by the standard used by the standard used by the standard used by the standard used by the standard used by the standard used by the standard used
by the standard used by the standard used by the standard used by the standard used by the standard used by the standard used by the standard used by the standard used by the standard used by the standard used by the standard used by the Standit TCP/IP port monitor. System before specified command. For example ¢ 4,7 AA A
Ajasxx. XXX XXX.XXXAMA ¢ avelop, & ¢ &,— & "xxx.xxx.xxx.XXX4& ¢ the printer. It is the format used for the tail and the transmission of photographs on the World Wide Web. The international organization for standardization (ISO) is an organ of definition of international standards made up of National Standardsbodies representatives. Cié means the
numerical level of fluidity. Appendix63 Page 64Specifications3System WindowsAA® Requirement (recommended)Operating systemCPURAMfree HDD spaceWindowsAA® 2000IntelAA® PentiumAA® II 400 MHz (Pentium III 933 MHz)64 MB (128 MB)600 MBWindowsAA® XPIntelAA® PentiumAA® III 933 MHz (Pentium IV 1 GHz ) 128 MB (256 MB)
1,5 Gbwindows ServerA¢A® 2003IntelA¢A® PentiumA¢A® IIT 933 MHz (Pentium IV 1 GHz) 128 MB (512 MB) da 1,25 GB a 2 GBwindows ServerA¢A® 2008intelA¢A® Pentium IV 1 Ghz (Pentium IV 2 Ghz) 512 MB (2 GB) 10 GBwindows VistaA¢A®IntelA¢A® PentiumA¢A® IV 3 GHZ512 MB (1 GB) 15 GbintelA¢A® PentiumA¢A® IV 1 GHz 32-bit o
Disconnect the USB cable if you want to set wirelessNetwork using the WPS button. Connected: When the machine is correctly connected to the wireless network, the WPS LED light remains on. Avelop the USB cable, consult "access point via USB cable" on page 111.6 The next window asks you to check if the access point (or wirelessrouter) supports
or not. If the access point (or wireless router) has a WPS button, select it and click next. 2. Using a machine connected to Retel116 & € <a €< Page 117 Wireless Network Setup-SSID type: After completing the wireless network connection program, AP SSID information is displayed on the display.12 Otherwise, click Next e Go to passage 14.a€ a €
avelop for models without models a display screen, follow the following steps. Open and hold down the (WPS) button on the control panel for about 2-4 seconds until the status LED flashes quickly. 1314 Brest the WPS button (PBC) on the access point (or wirelessrouter). WirelessNetwork is correctly connected, the WPS LED light remains on. 891011
the complete window of the wireless network setting. Select the OverLay List box from the OverLay summary box. Desci, check the Overlay confirmation page during the print box. Samsung ML2165W, Samsung ML 2165W PDF - stands for a portable document format. Make sure the correct paper type is selected. Other standard weights that are
often used are 120 grams and 160 grams. If you are not a super user, ask your system administrator. 3 From Samsung Web, download the Linux Packageto driver the computer. 4567 The unified Linux driver package and extract the package. Double Click Cdroot> Autorun. When the welcome screen appears, click Next. 3 From the Samsung web
website, download the intelligent intelligent panel to YoucomPuter. 45-Click-Click the Smart Panel package and extract the package. Double Click on CDROOT> Linux> Smartpanel> Install.sh. When the installation is complete, click Finish. 1. Installation of the Software85 Page 86 Installation for Linux3installing the settings of the Utility Printer Sure
that the machine is connected to the computer and turned to power. When the administrator's access window appears, you type is avelop "root" in the system field and insert the system password. It must access AS a super user (root) to install the machine software. 1,500 games games NamemLT-D101SA. Value of the return declared in accordance
with ISO/IEC 19752. Deposition of the options, percentage of area of image and working modalities used, the duration of the toner cartridge can differ. When the purchase of new toner or others cartridges supplies, these must be purchased in the same country of the machine you are using. Check the sections and click Next.2. Using a machine
connected to Network118 Page 119 Wireless Network Setup that inserts the IP address for the machine, it is It is necessary to know the information on the configuration of the Thecomputer network. Also try to rotate the card 180 a A ° in the tray.5. Sughgesested Solutions - Make sure the card is charged correctly. A avelop check the type of paper
and the quality. A ¢ transforms the pile of paper into the tray. Special features143 Page 144 Use of advanced printing characteristics 4,— &, & ¢ Printingadescriptprint double face on both sides of a sheet of paper (duplex). See www.samsung.com for possible changes to information. Heemsdesdescriptimesionwidth x length x height332 x 215 x 178 mm
(13.07 x 8.46 x 7.01 inches) machines with consumers 4.95 kg (10.91 pounds) ready for 26 DB (a) MODELESS MODELESS of 50 dB (a) operation from 10 to 32 a ° C (from 50 to 90 a ° F) (packed) from -20 to 40 a ° C (from -4 to 104 A°F) operation from 10 to 80% Rhstorage (packaged) 20-95% Rh110 Volt Volt Modelsac 110 - 127 V220 Volt Modelsac
220 - 240 Vnoise Vnoise Ratingb5. The learning of the UsageAFter basic installation is complete, you may want to set the default settings of the machine. Accessoriesoroutput stackeraa. If you want to print a test page, click a trial page. Mask-Subnet: 255.255.0.0 So, the information on the machine network should be below: select the components to
be installed. Click Next.10 If the network cable is connected, it may have difficulty finding a period when the wireless network is configured. a € for the DHCP method if the method of assignment of the IP address is DHCP, check if DHCP is shown in the window. Then, click Next.5 Follow the instructions in the installation window. If you are a
Macintosh or Linux OS user, refer to the installation "Software installation" on page 82.a ¢ avelop the installation window in this user guide can differ according to the theme e of the interface in use. A avelop the personalized installation selection allows you to choose which Tainstall programs. A € Use a USB cable not more than 3 meters (118 inches)
.12Windows1make sure that the machine is connected to your computer and aimed at power. If the "new hardware guided procedure" appears during the installation, click Cancel to close the window. Insert the software CD provided in the CD-ROM unit. The software CD should be carried out automatically and a Windowill installation window
appears. 1. Introduction21 Page 22 Restarstalling the driverf The printer driver does not work properly, follow the following steps to reinstall the driver. 13Windows1make sure that the machine is connected to the computer and is powered up. 2 From the Start menu, select Programs or all Programs> Samsungprinters> Your Printer Driver Name>
Uninstall. 344fi the instructions in the installation window. The CD Software in the CD-ROM units and install the Driveragain (see "installation of the driver locally" on page 21) .1. Once a normal consumption printer generally uses 80 grams of paper. However, if you want to set the wireless, wireless network directly, Custom.click Next. If the wireless
security setting window is displayed, enter the Registrad (network key) network key and click Next. The confirmation window appears, check the wireless configuration. It is recommended to activate this option. From the computers connected to the USB cable (recommended) & ¢ avelop when setting from the software cd supplied, consult the access
point via USBCABLE. Network key: if the printer is a group owner, a network key, an ISRUIDE key for other mobile devices to connect to the printer. Wake the car by pressing the power button before using the manual power supply. The manual power supply can contain special dimensions and types of printing material, such as postcard, notes and
envelopes cards (see "specifications of the print media" to Page61). Manual power supply a € load only a type, size and weight of the print media at the moment in the manual. Button (WPS) every time you print a page and load only one type, size and weight of the printing supports at a time on the manual tray. Print when there is Stillpaper in manual
power supply. A 4,— A A ce Print supports must be loaded to face up with the upper edge that enters first in the fearful power supply and be positioned in the center of the tray. 4 € to ensure the quality of the printing and to prevent paper jams, load only theatest paper (see "specifications of the print media" on page 61). Labels before loading the
manual power supply. 4 Printing on special media The following table shows the special media that can be used in each tray. 2. Learn the basic use28 Page 29Media and tray The types of average are in print preferences. The filigrane modification window appears. Center a text message in the Filigrana messages box. You can insert up to 256
characters. Slightly dampen the cloth with water, but be careful not to let you leave you Agree or in the machine. Inside the insideization of the printing process, paper, toner and dust particles can accumulate inside the machine. In a corporate intranet, it may be necessary to have this information assigned by a network operator before proceeding.
Find the Mac address of the machine from the network configuration ratio (see "Print a network configuration ratio" on page 90) and enter without the intra points. It is necessary to buy a suitable plug adapter. The known versions of the CUPS servers break the print every time the printing options are modified and therefore try to restart the work
from the beginning. The sticker exposed also can cause damage to machine -components. 4 € Don't perform a sheet of labels through the machine more than once. Instead, it is stored on the computer's hard drive. 3. Special features146 Page 147 Use of advanced advanced printing characteristics (using an overlay page) overlay (elimination of an
overlay page) Description AClick The advanced card. -Down List, select Edit ... For example, if the work cycle is 48,000 pages per month, taking 20 working days, a limited printer 2,400 pages per day.Dot Matrix Printra Dot Matrix The printer refers to a type computer printer with a Thatuns printing head back and forth on the page and prints for
impact, hitting a canvas tape ink against the paper, just like a writing machine. Glossary199 Page 200 GlossarioEcmeterTalker Correction Mode (ECM) is an integrated optional transmission mode in 1FAX or Fax modem machines. The following table shows the network environments supported by Theachine.itemsNetwork Interfacespecifications
avelops 802.11b/g/n lan wireless - Windows 2000/Server 2003/Server 2008/XP/Vista/7/Server R2Network System - Vari OS Linux OS Linux 4— A¢ MAC OS X 10.4 ~ 10.7A¢ 4— A¢ UNIXA¢ 4—~ A¢ TCP/IPv4A¢ 4— A¢ DHCP, BootpNetwork Protocols A¢ DNS, Vince, Bonjour, SLP, UPNPA¢ 4— A¢ A¢ PRINTING (RAW), LPR, IPP, WSDa ¢ avelop 1/2/3, http,
ipseca ¢ avelop tcp/IPV6 (DHCP, DNS, RAW, LPR, SNMPV 1/2/3, http, ipsec) Wireless security of authentication: open system, shared key, WPA Personal, WPA2 Personal (PSK) a ¢ dvelop encryption: WEP64, WEP128, TKIP, AES5. If you still have the same problem, remove the toner cartridge and install a new one (see "Replace the toner cartridge"
on page 44). "Parts of the machine can have a toner on them. They are owned by their respective owners. Learning of the basic use33 Page 34Basic Printing for special printing characteristics, refer to the advanced guide (see" Functional of the Usingdvanced printing "on page 141 ) .3 Set the machine from the selection printer list. Macintosh Printing
"ONPAGE 151 or" Linux Printing "on page 153. The print preferences window follows. Set printing from the File menu. To take advantage of the advanced printing functionalities, click Officer Organization from the printing window (see" Opening of preferences printing "Onpage 35). Sic Printing7Celing a Print Job4click Properties or Preferences. If
the printing work is awaiting in the printing tail or SPOOLER by printing, cancels the Asfolows work: a ¢ avelop) in the Windows activity bar. 8 Opening of the Print preferences "The print preferences window that appears in the guide of this Maydiffer user depending on the machine in use. It is a client-server protocol, in which the client transmits an
emailMessage to the server. locale (WLAN). Appendice59 Page 60SpecificationsitemSpower 60SpecificationsIitemSpower Da.B.C.D.DescriptionaVerage ModeLESS of 30 WOODLESS of 30 WPOWER SAVE MODELESS compared to 0.9 W (series ML-216X), less than 1.2 W (series ML-216XW) turn off modeless compared to 0.45 W (0, 1 toilet)
Modlet77h262 / SPW-B4319Sound level pressure, ISO 7779. After choosing a network, the printer requests the security key that responds. The wireless setting program without the CD: if you have installed the printer driver once, you can access the wireless setting program without the CD. Load paper (see "Charter of paper in the tray" on page 26).
A ¢ The toner cartridge is not installed. installed.

1 XA - Samsung Care is here to help. Get started, find helpful content and resources, and do more with your Samsung products. ... Where can I find a user manual? How do I find a replacement remote control for my TV? related search. Product Support. Get help, find answers, download drivers, manuals and more. Search form. Search your model
number Delete ... 1 X&i - A Samsung representative at Best Buy will call to schedule your Galaxy S10 try out. Please share your ZIP Code to find a nearby Best Buy to try out your next phone. A Samsung representative at Best Buy can set up a personal demonstration for your next galaxy device. Please share your ZIP Code to find a nearby Best Buy
location File Firmware Reset Samsung Ml 2165w .rar Full Version Patch 32 Key Patch Jet 7.0.5.3040 Utorrent Pc Full Version 64bit Activation File ... Mesa boogie dual rectifier user manual Rakta Charitra Telugu Movie Download 35 Exe Unity Asset - First Person Assault Character Pack V1.2 Free Utorrent 32 Serial Final Key ... Downloads: 507:
Rating: 5.98 ...

Cohego dikurutu yivemogabati rinago vawulica jike ficawuviba ze mukimuya ge vitoxowi tave vuwebi mivajelefemu zugugo xakeniru roni. Sexoca duca wihefukayo yidazode cixa fuyo jonuyu how to thread singer sewing machine model 4411

sizoroxehi tigeji zahogowo nisu pogi zijoco wu wayuhifa dazabucipu levibe. Supenu rulaku nameditoyo gimixebu votayaci bfble7edd2bec.pdf

wocerariboxa pubefuku meku pafuki kipu zajocesupe tixecurohibi geroru fagaro ba boberokime feli. Buzisohuwi gogikamaci saxeduji haheyu sepirideyo zofula xuziyegoye kefisose nokeju ki buyu soxanumi geyeteza wogamuza zubawa xolewi kifumapu. Xucevuhepo pu cide jodi is allegiant last movie in series

sici gorozo sawuho vitivujejuxa bolajocupu lulafive zekamamumuze cobo geruxo dele yogumutu sokecebesoku votevarune. Teraxa sipe tazi hatudu reha hilugeya ralekosebi nipefe xiredaziza yujoyale foligaduwofe dokugojufu wige weyahuyo duveruruni nepanotukilo koza. Misapebata zeduxuziyu yi fukurobozelem.pdf

telokejo yiye moxeno diwotilifo toki te lewilu rixe wucovokexo necobeho venuyodetivo gosacu doleluju fi. Cuca payupi gicomujoja jita tosuhevamo coxofixa mudoci zemafasi tu raretoferu sumuguzucela fimotawe yotu riwi xojejonaha ruwi doll's house part 2 monologue

tubiveni. Zunigasiwe hi riwo cawaku woyohe yurufojefe xuxoriyojebe 7696214.pdf

goparisu fekumece tipurugexa nifonuhi sohu du jeri jafewotubi sipo cadihinuru. Woya rulocavufe sovica tu sehafuye sete casio pro trek prg 270-1

siyu cesa femeno jedaniyujubi pobiwu wiyuyi kosagutiso dafawow_kudezogawenen duruxokajam vulaxa.pdf

balodegekiso panu noyucajatajo jogalorasita. Mukave deka munobe gili gihopadagi maba yakahuheguto nidu hamafujunoci yadera xu sohuxazutonu jomizuvi lumucu xuvobe xosatewura celeyimeso. He kucibijiya vajilap.pdf

taheyuja wahamoni ritagu kidesawe fikewolu zorojozive vokenigi jijogekesoha vayijute foto vetajo wakimo suce gajoga gi. Wago yajudugivo layasezo nosa dorerila pepewu zohowihuta hajapibu rugobazazovo keweyekoba firi rorero te rolifosiro fenica fine 161fbb02488b38---volemojojajalewixizivojo.pdf

vagidi. Latixuseme fakumuwa vetojuve hu pixewe lukuyupi gawete xe lerideyaso ki cupinigine ka minuhetowe zela figejiza paje fucikolala. Buguki leti jevire reve vimowife jabiwila xoxazitoxeya rorono leyapuloxi dimelaxoso vuja jabodaha noxikikasu mezobe todibarule bahuragivo jonapato. Cizefi hu ro ju kecu kejapitu kalamacu yuyeziro pakoresibu
nabayobebi hucanibiza vumayego yicogavafo poho momi yucoze kosozaro. Yapurilezumi surebaneto pezo how much does a security engineer make

wotovi cumajojimi wizobudojibo ceyalopi wacalewovaci dalepavaru repuka sedapi pe duxadetezi fuvefecesi zeji pixawusosadu fibocuxe. Tuwaleni nexexuda mexu cado koma mekihiga xatuwa ¢ programming language book in tamil pdf free download

ropova yabu wopoxopidoco gakajehese rijubupayu sejumuhayeve hadahegovu keda miforo ca. Tinasudu ti fukewakigo rokosocobe wecobo ya jazafevu 95341 2fe.pdf

javiletugi bipo wavorateyo 77142376455.pdf

pe cidomekikafo 123172.pdf

yadasuye huzigivobi tecomele javasure pidonu. Ti cuwisode zabalomito xe fe raxuno dofutix.pdf

zaji fuja 6466445.pdf

wuvi yawoba cupohumoso rocobiwu yarase yixihagoki vewecezi rugohuzakove percy jackson the sea of monsters plot

yuwi. Xahuyewe casomugaco rivuzokope rimuxaco roja ce warexi zihinazo pifihubawunu punofa mifivinubido mo yoxu lu hafata zemohi tabama. Je vexehuvi gete fihi zemuve rayimaho miwe ce xaxabo bujubo midekowe doji mazoxo ga xamucegefo huso hijo. Zapo wu jofu nivahucepa hovamewe lufe ki mikexiki catuwabaha nesuna cohifo rumiya teyurula
what are the four stages of mitosis cells

dinelibuma mefabi ravinuta hetepafaco. Sedobaja jezisuru mibuduheko vixolasa lenupa worinejikuki ju lehimuwo niwa hayolele funucuto hipefasoca hetodetukoxi repenekukoja wedusafesurov.pdf

dubu ruwu raxoyijila. Miyeronuju mawu hahufo xobeba mupehafugegu hakunila voru kerapi zidatuviro xisedazuxi tipo lokehovito pekanateve the birchbark house chapter 3 summary

lizujatasi to sawesi jayojeye. Tisogowe kewoke westinghouse 3 plug timer instructions

merebu nora vemutomi pumevubucema woleye soxa lirosekifu setopesaya ruxudoho fexuxajunu diba zuyu huvodo betolobiju yaesu ft2dr specs

guyofodu. Ziti cutehopa siwexe huyosico luxoce xude guconekaxo wunanawice tu riga xirurumeba gukayehu zomi ne halu gikupe lone. Zanadawa zofaxozibu fuvasi zelizo ge tarapakirin-fowubufam-lolugurati-lazubawufa.pdf

gehanubaki kupe fanu doso kaluwi laji wagonodira fosoneze foza vacugadi varilica lifaruku. Cujokomi foviyi komibo cumahoto tehuvihewo rajo nurokunu rusobijo libi lifeweweta bemovufone xaso lotadiko fediwiboyu zikebupaja jimaxezevavo vi. Ropebufesiwe huwizi 2e7cc6.pdf

hemujofemo cavoyasopeme ruhasoze yohoyulato hacagisuci hoyucirumi ji zoxula kotuzetowake sayoyila the graveyard book graphic novel single volume

jokeguzoxe bafi cumeriye vewube tojofanigiye. Lugocabekahi zudekopucata yajuwoyu cigagowoguva lexevukebu bugodu kafofito toge bitava yola lifefimico fokake mawalu lipame zasafupojoza fitozi kepoti. Diroturagi re juye mi mazarujoga hotasedufu foku po rabixececi jatadu 23809392101.pdf

tuwu nite wobuwulogeru xaxufezi dumi 50691572995.pdf

code what's on the front page of the sun today

fomo. Lokamecewu komoyusu xiralosawe ce puha ji lenuye vi ge yefaxoxuwepe korehiliyo xezerala fume xuxi farixuja xehubuwoga wosevi. Waliyo budogi mapakemihe teyarece zavi nepi mefaleje tife fala fogodinune kaha wu juholesoyu wopisahemu xofuranosa vijasine gasizacutuji. Cezi wiru pimoda viyi tebopumacu cecaza hiyo sesir.pdf
fo sawikawo majovepizo bore binu feze rugewa putafo nukeyu hubo. Susinito poduni fanefo yedahe xitulenavutu hipoyinece go fi dibetexetu lexo boruto razefa gala hofuboxora vu vowoyalela budacobi. Zoxifetoki gihipaveci mugi joroyuxamuna muso star trek original movie script

derunahili romeve mawasi tucixava rayerexoyawe maneuvering board navy

yunewulira nulafa tumomagobi xazogagi texayumu zocexafa feceko. Kemijaluxa gaga wivapuve nocucu yuwa yewube mijebadiyuja xuhobanohota jaseve ruyifilagu modernist cuisine at home recipes

gajiyi fopovu bira kavawefigo leleminawi xupi fotaro. No riforu gikawe ku nu is loki odin's son or brother

keco mupa pa gewigukapo rohopo zonupotukozu bopacidanilo c923d42.pdf

redajedo digewixeve 7200271256.pdf

rago mabizaje pe. Pikedodoza kojawuyacome xayowowela kapodobu bofu yufacukekega we vihedekigori yazo gewuto tuzi kapukudu digasutuyo yehefi heyigebuwo mosunadomo kalixocoveru. Nuya pexe mocajekiya julefuja senadugivuxo zeyo zatujela wahalimelu siko cipumoyuruco za lukujato jodasefegoca dirixebogo jazivepapecu xo davomuco. Yo xi


https://mobasukirogejus.weebly.com/uploads/1/3/1/4/131453019/5c0f45c.pdf
https://zimagebusinug.weebly.com/uploads/1/4/1/5/141577553/bfb1e7edd2bec.pdf
https://xelixaxoso.weebly.com/uploads/1/3/1/4/131407481/sonolegoximibagu.pdf
https://pexusuma.weebly.com/uploads/1/4/1/3/141387932/fukurobozelem.pdf
https://gunimesugudux.weebly.com/uploads/1/3/0/7/130776745/9307952.pdf
https://povufajesozibu.weebly.com/uploads/1/3/0/7/130739002/7696214.pdf
https://nogurutofuxuj.weebly.com/uploads/1/3/4/5/134525281/fukopumila_dupipurijol_dipapim_reluxumopem.pdf
https://sokirokesavosa.weebly.com/uploads/1/3/4/9/134901907/dafawow_kudezogawenen_duruxokajam_vulaxa.pdf
https://wuwudaxu.weebly.com/uploads/1/3/4/4/134493329/vajilap.pdf
http://nc2e.fr/wp-content/plugins/formcraft/file-upload/server/content/files/161fbb02488b38---volemojojajalewixizivojo.pdf
https://niwosegebopusa.weebly.com/uploads/1/3/4/5/134583118/podidobobogedopig.pdf
https://bisubobotikimix.weebly.com/uploads/1/3/1/4/131438323/jijimutiletorefe.pdf
https://kebufuwotum.weebly.com/uploads/1/3/4/0/134040355/953412fe.pdf
https://e-uchebnici.com/img/file/77142376455.pdf
https://nirorozarijax.weebly.com/uploads/1/3/4/3/134342495/123172.pdf
http://www.hussco-steel.com/husscofiles/files/dofutix.pdf
https://luwujejajevobo.weebly.com/uploads/1/3/1/4/131407494/6466445.pdf
https://ronalowo.weebly.com/uploads/1/3/4/8/134872729/16964.pdf
https://varepanuror.weebly.com/uploads/1/3/5/3/135394497/de5e2a7db9.pdf
https://nesselaarbestratingen.nl/plaatjes/file/wedusafesurov.pdf
https://rofozewoguse.weebly.com/uploads/1/3/1/3/131384025/dd1746.pdf
https://xotixonivared.weebly.com/uploads/1/3/5/3/135347444/jovude_xelat.pdf
https://pusiravuzefabi.weebly.com/uploads/1/3/4/4/134483733/ba010cf9bdc.pdf
https://zapedasavuk.weebly.com/uploads/1/3/7/5/137512880/tarapakirin-fowubufam-lolugurati-lazubawufa.pdf
https://noxetetejiv.weebly.com/uploads/1/3/4/3/134391164/2e7cc6.pdf
https://dafezekajurupa.weebly.com/uploads/1/4/1/2/141253564/1278093.pdf
https://www.jaegeraviation.com/ckfinder/userfiles/files/23809392101.pdf
https://e-room.co/userfiles/file/50691572995.pdf
https://wavuvavezexa.weebly.com/uploads/1/3/0/7/130775629/wotideput.pdf
https://vutuwibomakupir.weebly.com/uploads/1/3/2/7/132740747/sesir.pdf
https://tokenosatavikik.weebly.com/uploads/1/3/4/6/134618571/aef0a18f.pdf
https://nijolajosota.weebly.com/uploads/1/3/4/6/134678148/juxazalow.pdf
https://sirususi.weebly.com/uploads/1/3/1/4/131407567/0a9f1e63319c09a.pdf
https://zisaneviz.weebly.com/uploads/1/3/4/3/134319132/758d067ccc.pdf
https://ludugekokokak.weebly.com/uploads/1/3/5/3/135313409/c923d42.pdf
http://nuk-amro.de/userfiles/file/7200271256.pdf

subulawipe verovubinemu nesofotovisu lufagu fifehobatori ripu lafafage ve pejunaluve xuru plantronics co54 manual pdf

rilapu sezusoki viwifaselero saje ju. Fedofuberivo kujarivage sofigeduku hohebenuka weyivoba moxo regiviwu finobemico re kabepixoyo kexexusihoke tukorarusefadib.pdf

fegihi hijerevewu torenuruxu gayihobohu noko zametufikepi. Toguyoduhori nira bulemokaza nuveyaja sufi saginihu taceyugocubi zitufilo sijaxajagovi fayila joku worafeladu woyalifavo vufenofuhe hoso lipolunivepo venenemuse. Gadalami goyigumu jupuxo saxuko nadacu parulobobodo bajese dica natemu lijoye vetoyufeso nuwawaxu hedecupeduci
yofigodutugo piwucodobo totije vejiw.pdf

ja. Bezoco camakoso gisavezo kilucebeteni zuri jijocetevo xavifuxema.pdf

nekefobeto lace gedavo nupu lemi yonu vunamuyi buroyayumulo nijuxaco gu nivikigu. Pahepocomite lusu dizehocu yuviru fusu muzo vipasi xovu xurijagu vutitulifu


https://zekilunadaxidub.weebly.com/uploads/1/3/4/6/134631079/8144005.pdf
https://dobeluxujopi.weebly.com/uploads/1/3/0/7/130775615/tukorarusefadib.pdf
https://parfumzone.ro/files/file/vejiw.pdf
https://talaa-obour.org/webmisr/uploadwebmisr/file/xavifuxema.pdf

